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Preface

Audience for This Guide
Welcome to Release 11i of the Oracle Process Manufacturing Product Development 
User’s Guide.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle Process Manufacturing

If you have never used Oracle Process Manufacturing, Oracle suggests you 
attend one or more of the Oracle Process Manufacturing training classes 
available through Oracle University.

■ The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This guide contains the information you need to understand and use Product 
Development.

■ Chapter 1, Understanding Product Development, describes the fundamentals 
of Product Development. It presents the basic processes required to develop a 
new product, and it introduces a basic understanding of navigation, 
workbenches, the status approval workflow, adding and editing status codes, 
and version control.

■ Chapter 2, Setting Up, describes setup requirements in other applications. It 
presents the setup of responsibilities and menu access, and optional setup of 
formula classes, operation classes, and routing classes. The chapter also 
explains the setup of activities, laboratories, technical parameters, technical 
parameter sequences, technical classes, and technical subclasses.

■ Chapter 3, Formulas, includes a basic understanding of formula setup, how to 
enter item technical data, and how to use the laboratory spreadsheet. It shows 
how to find a formula. The chapter also presents setting up formula 
xi



information including how to use formula phantoms. Methods available to 
scale formulas are discussed. In addition to entering formula details, the 
chapter provides information on how to define and maintain formulas at the 
header and line levels, including methods for displaying summaries of 
products, byproducts, and ingredients. Procedures for running and interpreting 
the Indented Bill of Materials Report and formula inquiry are provided. The 
complete process of analyzing a formula, displaying formula analysis results, 
and overriding default explosion rules are given.

■ Chapter 4, Operations, presents information on how to maintain operations, 
activities, and resources. It shows how to find an operation. The chapter also 
presents summaries of operations and operation headers to give an overview of 
operations created. The process to enter operation activity details and 
activity-resource details is explained with information on how to display 
activity lines and how to edit a summary of resource lines.

■ Chapter 5, Routings, presents information on how to define, maintain, and find 
routings. It shows how to find a routing. A summary of routings and routing 
headers delivers an overview of routings created. The process to enter routing 
details and display the routing step line summary is explained. Procedures to 
edit routing step lines and to enter routing step dependencies are given. The 
chapter also presents information on how to display and edit theoretical process 
loss, and how to search for and replace routings. Features available for the 
routing designer are presented.

■ Chapter 6, Recipes, presents information on how to define and maintain 
recipes. It shows how to find a recipe. A summary of recipes and recipe headers 
delivers an overview of recipes created. A basic understanding of step quantity 
calculations is provided with a procedure to enter recipe details and recipe 
organization details. The process to enter and edit validity rules and to interpret 
recipe step and material association delivers a basic understanding of recipe 
use. Features available for the recipe designer are presented, including the entry 
and editing of information on the process instruction sheet.

■ Chapter 7, Tools, presents information on how to perform a search and replace 
of components in operations, routings, formulas, or recipes.

■ Appendix A, Product Development Navigator Paths, describes how to navigate 
to each window.

■ Appendix B, Product Development Profile Options, describes profile options.

■ Appendix C, Product Development Status Codes, describes status codes.
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■ Appendix D, Product Development ERES, describes eRecord and eSignature 
features.

■ A Glossary provides definitions of terms that are used in this guide.

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Other Information Sources
You can choose from many sources of information, including online 
documentation, training, and support services, to increase your knowledge and 
understanding of Oracle Process Manufacturing.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). 

■ Online Help - The new features section in the HTML help describes new 
features in 11i. This information is updated for each new release of Oracle 
Process Manufacturing. The new features section also includes information 
about any features that were not yet available when this guide was printed. For 
example, if your administrator has installed software from a mini-packs an 
upgrade, this document describes the new features. Online help patches are 
available on OracleMetaLink.

■ 11i Features Matrix - This document lists new features available by patch and 
identifies any associated new documentation. The new features matrix 
document is available on OracleMetaLink.
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■ Readme File - Refer to the readme file for patches that you have installed to 
learn about new documentation or documentation patches that you can 
download.

Related User’s Guides
Oracle Process Manufacturing shares business and setup information with other 
Oracle Applications products. Therefore, you may want to refer to other user’s 
guides when you set up and use Oracle Process Manufacturing.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Guides Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Process 
Manufacturing (and any other Oracle Applications products). This guide also 
includes information on setting user profiles, as well as running and reviewing 
reports and concurrent processes.

You can access this user’s guide online by choosing ”Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Oracle Process Manufacturing Documentation

Accounting Setup User’s Guide
The OPM Accounting Setup application is where users set up global accounting 
attributes about the way financial data will be collected by OPM. These attributes 
include such things as account keys, financial calendars, and account segments. 
Since OPM is closely integrated with Oracle General Ledger (GL), much of the 
attributes are defined in the Oracle GL instead of OPM, and therefore, the windows 
are display only within OPM. The Oracle Process Manufacturing Accounting Setup 
User’s Guide describes how to setup and use this application.
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Cost Management User’s Guide
The OPM Cost Management application is used by cost accountants to capture and 
review the manufacturing costs incurred in their process manufacturing businesses. 
The Oracle Process Manufacturing Cost Management User’s Guide describes how to 
setup and use this application.

Manufacturing Accounting Controller User’s Guide
The Manufacturing Accounting Controller application is where users define the 
impact of manufacturing events on financials. For example, event RCPT (Inventory 
Receipts) results in a debit to inventory, a credit to accrued accounts payable, a 
debit or a credit to purchase price variance, etc. These impacts are predefined in the 
Manufacturing Accounting Controller application so users may begin using OPM to 
collect financial data out-of-the-box, however, they may also be adjusted per your 
business needs. The Oracle Process Manufacturing Manufacturing Accounting 
Controller User’s Guide describes how to setup and use this application.

Oracle Financials Integration User’s Guide
Since OPM is closely integrated with Oracle General Ledger, financial data that is 
collected about the manufacturing processes must be transferred to the Oracle 
Financials applications. The OPM Oracle Financials Integration application is where 
users define how that data is transferred. For example, users define whether data is 
transferred real time or batched and transferred at intervals. The Oracle Process 
Manufacturing Oracle Financials Integration User’s Guide describes how to setup and 
use this application.

Inventory Management User’s Guide
The OPM Inventory Management application is where data about the items 
purchased for, consumed during, and created as a result of the manufacturing 
process are tracked. The Oracle Process Manufacturing Inventory Management User’s 
Guide includes information to help you effectively work with the Oracle Process 
Manufacturing Inventory application.

Physical Inventory User’s Guide
Performing physical inventory count is the most accurate way to get an accounting 
of all material quantities purchased, manufactured, and sold, and update your 
onhand quantities accordingly. The OPM Physical Inventory application automates 
and enables the physical inventory process. The Oracle Process Manufacturing 
Physical Inventory User’s Guide describes how to setup and use this application.
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Order Fulfillment User’s Guide
The OPM Order Fulfillment application automates sales order entry to reduce order 
cycle time. Order Fulfillment enables order entry personnel to inform customers of 
scheduled delivery dates and pricing. The Oracle Process Manufacturing Order 
Fulfillment User’s Guide describes how to setup and use this application.

Purchase Management User’s Guide
OPM Purchase Management and Oracle Purchasing combine to provide an 
integrated solution for Process Manufacturing. Purchase orders are entered in 
Oracle Purchasing and received in OPM. Then, the receipts entered in OPM are sent 
to Oracle Purchasing. The Oracle Process Manufacturing Purchase Management User’s 
Guide describes how to setup and use this integrated solution.

Using Oracle Order Management with Process Inventory Guide
Oracle Process Manufacturing and Oracle Order Management combine to provide 
an integrated solution for process manufacturers. The manufacturing process is 
tracked and handled within Oracle Process Manufacturing, while sales orders are 
taken and tracked in Oracle Order Management. Process attributes, such as dual 
UOM and lot control, are enabled depending on the inventory organization for the 
item on the sales order. Order Management accepts orders entered through Oracle 
Customer Relationship Management (CRM). Within CRM, orders can originate 
from TeleSales, Sales Online, and iStore, and are booked in Order Management, 
making the CRM suite of products available to Process customers, through Order 
Management. The Oracle Order Management User’s Guide and Using Oracle Order 
Management with Process Inventory Guide describes how to setup and use this 
integrated solution.

Process Execution User’s Guide
The OPM Process Execution application lets you track firm planned orders and 
production batches from incoming materials through finished goods. Seamlessly   
integrated to the Product Development application, Process Execution lets you 
convert firm planned orders to single or multiple production batches, allocate   
ingredients, record actual ingredient usage, and then complete and close 
production batches. Production inquiries and preformatted reports help you 
optimize   inventory costs while maintaining a high level of customer satisfaction 
with on-time delivery of high quality products. The OPM Process Execution User’s 
Guide presents overviews of the tasks and responsibilities for the Production 
Supervisor and the Production Operator. It provides prerequisite setup in other 
xvi



applications, and details the windows, features, and functionality of the OPM 
Process Execution application.

Integration with Advanced Planning and Scheduling User’s Guide
Oracle Process Manufacturing and Oracle Advanced Planning and Scheduling 
(APS) combine to provide an integrated solution for process manufacturers that can 
help increase planning efficiency. The integration provides for constraint-based 
planning, performance management, materials management by exception, mixed 
mode manufacturing that enables you to choose the best method to produce each of 
your products, and combine all of these methods within the same plant/company. 
The Oracle Process Manufacturing Integration with Advanced Planning and Scheduling 
User’s Guide describes how to setup and use this application.

MPS/MRP and Forecasting User’s Guide
The Oracle Process Manufacturing Material Requirements Planning (MRP) 
application provides long-term "views" of material demands and projected supply 
actions to satisfy those demands. The Master Production Scheduling (MPS) 
application lets you shorten that view to a much narrower and immediate time 
horizon, and see the immediate effects of demand and supply actions. The Oracle 
Process Manufacturing MPS/MRP and Forecasting User’s Guide describes how to setup 
and use this application.

Capacity Planning User’s Guide
The OPM Capacity Planning User's Guide describes the setup required to use OPM 
with the Oracle Applications Advanced Supply Chain Planning solutions. In 
addition, Resource setup, used by the OPM Production Execution and New Product 
Development applications, is also described.

Using Oracle Process Manufacturing with Oracle Manufacturing Scheduling
Oracle Process Manufacturing integrates with Oracle Manufacturing Scheduling to 
manage and utilize resources and materials. Through the Process Manufacturing 
application, you set up manufacturing, inventory, procurement and sales order 
data. Through the Manufacturing Scheduling application, you can optimize the 
schedule based on resource and component constraints and user predefined 
priorities. Using different optimization objectives, you can tailor Manufacturing 
Scheduling to meet your needs.

Using Oracle Manufacturing Scheduling helps you improve productivity and 
efficiency on your shop floor. By optimally scheduling shop floor jobs, and being 
able to quickly react to unplanned constraints, you can lower manufacturing costs, 
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increase resource utilization and efficiency, and increase customer satisfaction 
through improved on-time delivery. The Using Oracle Process Manufacturing with 
Oracle Manufacturing Scheduling User’s Guide describes how to setup and use this 
integrated solution.

Product Development User’s Guide
The Oracle Process Manufacturing Product Development application provides 
features to manage formula and laboratory work within the process manufacturing 
operation. It lets you manage multiple laboratory organizations and support 
varying product lines throughout the organization. You can characterize and 
simulate the technical properties of ingredients and their effects on formulas. You 
can optimize formulations before beginning expensive laboratory test batches. 
Product Development coordinates each development function and enables a rapid, 
enterprise-wide implementation of new products in your plants. The Oracle Process 
Manufacturing Product Development User’s Guide describes how to setup and use this 
application.

Quality Management User’s Guide
The Oracle Process Manufacturing Quality Management application provides 
features to test material sampled from inventory, production, or receipts from 
external suppliers. The application lets you enter specifications and control their use 
throughout the enterprise. Customized workflows and electronic record keeping 
automate plans for sampling, testing, and result processing. You can compare 
specifications to assist in regrading items, and match customer specifications. 
Aggregate test results and print statistical assessments on quality certificates. 
Several preformatted reports and inquiries help manage quality testing and 
reporting. The Oracle Process Manufacturing Quality Management User’s Guide 
describes how to set up and use this application. 

Implementation Guide
The Oracle Process Manufacturing Implementation Guide offers information on setup. 
That is, those tasks you must complete following the initial installation of the Oracle 
Process Manufacturing software. Any tasks that must be completed in order to use 
the system out-of-the-box are included in this manual.

System Administration User’s Guide
Much of the System Administration duties are performed at the Oracle 
Applications level, and are therefore described in the Oracle Applications System 
Administrator's Guide. The Oracle Process Manufacturing System Administration User’s 
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Guide provides information on the few tasks that are specific to OPM. It offers 
information on performing OPM file purge and archive, and maintaining such 
things as responsibilities, units of measure, and organizations.

API User’s Guides
Public Application Programming Interfaces (APIs) are available for use with 
different areas of the Oracle Process Manufacturing application. APIs make it 
possible to pass information into and out of the application, bypassing the user 
interface. Use of these APIs is documented in individual manuals such as the Oracle 
Process Manufacturing Inventory API User’s Guide, Oracle Process Manufacturing 
Process Execution API User’s Guide, Oracle Process Manufacturing Product Development 
Formula API User's Guide, Oracle Process Manufacturing Product Development Recipe 
API User's Guide, Oracle Process Manufacturing Quality Management API User's Guide, 
and the Oracle Process Manufacturing Cost Management API User's Guide. Additional 
API User’s Guides are periodically added as additional public APIs are made 
available.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.
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Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 
10.7 (NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 
11i. You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.
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Other Implementation Documentation

Oracle Applications Product Update Notes
Use this guide as a reference for upgrading an installation of Oracle Applications. It 
provides a history of the changes to individual Oracle Applications products 
between Release 11.0 and Release 11i. It includes new features, enhancements, and 
changes made to database objects, profile options, and seed data for this interval.

Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in more 
than one currency, use this manual before implementing Oracle Process 
Manufacturing. This manual details additional steps and setup considerations for 
implementing Oracle Process Manufacturing with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and use Oracle Process Manufacturing with 
Oracle Applications' Multiple Organization support feature, so you can define and 
support different organization structures when running a single installation of 
Oracle Process Manufacturing.

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes. You also 
use this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Process Manufacturing implementation team, as well as for users 
responsible for the ongoing maintenance of Oracle Applications product data. This 
manual also provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
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applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on OracleMetaLink.

Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes API’s and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes API’s and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
This manual describes all Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master 
Oracle Process Manufacturing and reach full productivity quickly. These courses 
are organized into functional learning paths, so you take only those courses 
appropriate to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by 
Oracle University at any one of our many Education Centers, you can arrange for 
our trainers to teach at your facility, or you can use Oracle Learning Network 
(OLN), Oracle University's online education utility. In addition, Oracle training 
professionals can tailor standard courses or develop custom courses to meet your 
needs. For example, you may want to use your organization structure, terminology, 
and data as examples in a customized training session delivered at your own 
facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Process Manufacturing 
working for you. This team includes your Technical Representative, Account 
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Manager, and Oracle’s large staff of consultants and support specialists with 
expertise in your business area, managing an Oracle8i server, and your hardware 
and software environment.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.
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Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.

Your Feedback
Thank you for using Oracle Process Manufacturing and this user’s guide.

Oracle values your comments and feedback. At the beginning of this guide is a 
Reader’s Comment Form you can use to explain what you like or dislike about 
Oracle Process Manufacturing or this user’s guide. Mail your comments to the 
following address or call us directly at (650) 506-7000. 

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
U.S.A.

Or, send electronic mail to appsdoc_us@oracle.com.
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Understanding Product Develop
1

Understanding Product Development

This topic provides the fundamentals of Product Development. It presents the basic 
tasks, responsibilities, and process flow required to develop a product. You are 
given a basic understanding of navigation, workbenches, the status approval 
workflow, and version control. You are shown how to add and edit status codes.

The following topics are covered:

■ About This Guide

■ About Product Development

■ Tasks and Responsibilities

■ Process Flow

■ Understanding Navigation

■ Understanding Workbenches

■ Understanding the Status Approval Workflow

■ Adding and Editing Status Codes

■ Understanding Version Control
ment 1-1



About This Guide
About This Guide
The purpose of this guide is to provide reference information for end-level users of 
the OPM Product Development application. It presents:

■ Overviews of all the processes that comprise the Product Development 
application, and how these were developed from a detailed analysis of the tasks 
and responsibilities.

■ Overviews of navigation, workbenches, status approval workflow, and version 
control.

■ Prerequisite setup in the OPM System Administration, OPM Inventory Control, 
and OPM Cost Management applications.

■ Setup required in the Product Development application for: responsibilities and 
menu access, formula classes, operation classes, routing classes, activities, 
resources, plant resources, laboratories, technical parameters, technical 
parameter sequences, and technical class and subclass category sets.

■ Procedures for formula management, including: entering item technical data, 
using the spreadsheet, setting up formula information, using formula 
phantoms, defining and maintaining formulas, using formula summaries, 
entering formula details and editing formula lines, performing an ingredient 
where used inquiry, running an Indented Bill of Materials Report, using 
formula inquiry, interpreting a formula inquiry, analyzing a formula, displaying 
formula analysis results, finding a formula analysis, and overriding default 
explosion rules. Procedures are also provided for using the Routing Designer.

■ Procedures for operation management, including: defining and maintaining 
operations, defining and maintaining activities, defining and maintaining 
resources, finding an operation, displaying operations summaries, entering 
operation activity details, entering activity resource details, displaying 
operation activity lines, and, editing resource lines.

■ Procedures for routing management, including: defining and maintaining 
routings, finding a routing, using routing summaries, entering routing details, 
displaying routing step line summaries, editing routing step lines, entering 
routing step dependencies and, displaying and editing theoretical process loss.

■ Procedures for recipe management, including: defining and maintaining 
recipes, finding a recipe, displaying recipe summaries, understanding step 
quantity calculations, entering recipe details, entering recipe organization 
details, entering multi-record validity rules, editing validity rules, and 
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About This Guide
displaying the recipe step and material association. Procedures are also 
provided for using the Recipe Designer.

■ Procedures for mass search and replace, including: understanding search and 
replace, mass search and replace security, performing a search and replace, and 
using the Replace Results window.

Depending on your system security profile, it is possible that you do not have 
access to all of the windows and functions described in this guide. If you do not see 
a menu option described, and you need to access it, contact your system 
administrator.
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About Product Development
About Product Development
Reducing time to market is one of the most important objectives in developing a 
successful product. Research shows that one of the strongest drivers for on time 
product delivery is the use of a cross-functional, dedicated, and accountable team. 
To be successful, the team needs a strong leader and top management support. 
Oracle Process Manufacturing Product Development delivers a seamless, 
development environment that helps your team:

■ Reduce time to market by using a solid framework that manages recipes from 
concept through production.

■ Expand the enterprise by strengthening relationships with vendors and 
customers.

■ Share project information and collaborate globally using the Internet.

■ Manage quality processes proactively.

■ Streamline production efficiencies.

Product Development enhances product consistency and reduces the costs 
associated with creating and modifying formulas by letting you adapt quickly to 
different research and development environments. You are able to manage many 
laboratory organizations and support varying product lines throughout the 
organization. You can characterize and simulate the technical properties of 
ingredients and their effects on formulas. You can optimize formulations before 
beginning expensive laboratory test batches. Product Development coordinates 
each development function and enables a rapid, enterprise-wide implementation of 
new products in your plants.

By managing a recipe from its inception through production you have the ability to 
reduce the overall product development life cycle time. Recipes account not only for 
ingredient usage, but also for quality characteristics of those ingredients, costing 
implications of any alternate materials or processes, specific requirements of 
customers, corporate manufacturing standards, and regulatory compliance issues. 
Product Development combines the previous Laboratory and Formula Management 
applications into a single, integrated, secure formulation environment. Formulators 
and Process Engineers are able to collaborate in the development and maintenance 
of new and existing products using a workbench. The workbench is a job specific 
role that enables rapid definition and easier maintenance of recipe components. 
Workbenches increase formula usage flexibility to streamline the overall production 
process.
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Tasks and Responsibilities
Tasks and Responsibilities
One of the most challenging aspects of Product Development is effective 
information transfer. Each job role must collaborate at various points throughout 
the product development cycle.

The following is representative of the work breakdown structure required to 
develop a new product. It lists most of the key tasks and the job titles responsible 
for those tasks:

■ Define product requirements.

■ Product Development Manager

■ Marketing Manager

■ Customer

■ Search for or copy a formula.

■ Formulator

■ Define ingredient parameters.

■ Formulator

■ Prototype the formula.

■ Formulator

■ Determine production feasibility of the prototype formula.

■ Formulator

■ Purchasing

■ Determine formula reproducibility using laboratory scale batches.

■ Formulator

■ Tester

■ Determine formula stability.

■ Formulator

■ Packaging Engineer

■ Evaluate quality control specifications.

■ Formulator

■ Tester
Understanding Product Development 1-5



Tasks and Responsibilities
■ Create a routing.

■ Packaging Engineer

■ Process Engineer

■ Run pilot plant batches.

■ Process Engineer

■ Select the optimal recipe.

■ Marketing Manager

■ Customer

■ Obtain field approvals.

■ Plant Manager

■ Process Engineer

■ Assign effective date use.

■ Formulator

■ Process Engineer
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Process Flow
Process Flow
The Product Development application provides a seamless integration of the work 
breakdown structure outlined in the Tasks and Responsibilities topic. The Product 
Development process flow consists of the following steps in each of the applications 
listed. Prerequisite Setup is required before the remaining steps are completed. 
Formula Setup and Creation, Laboratory Setup, and Routing Setup and Creation 
can be performed in parallel. Recipe Creation ties all the preceding activities 
together.

Prerequisite Setup
Prerequisite setup must be completed for each of the following applications:

■ OPM System Administration

■ Set up required profile options as described in Oracle Process Manufacturing 
Implementation Guide, Oracle Inventory User’s Guide, and Oracle Workflow. 
Required.

■ Set up Responsibilities for Formulator, Process Engineer, Product 
Development Security Manager, and Product Development Security Profile 
Manager. Required.

■ Set up Version Control. Required.

■ Set up the Status Approval Workflow. Optional.

■ Set up Mass Search and Replace security.

■ OPM Inventory Control

■ Set up items, item attributes, unit of measure conversions, and item lot and 
sublot conversions. Required.

■ OPM Cost Management

■ Set up cost analysis codes and the cost calendar. Required.

Formula Setup and Creation
Formula setup and creation is performed in:

■ Formulator

■ Set up formula classes. Optional.

■ Create new formulas. Required.
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Process Flow
Laboratory Setup
Laboratory setup is performed in:

■ Formulator

■ Set up laboratories. Optional.

■ Set up technical parameters. Optional.

■ Set up technical parameter sequences. Optional.

Routing Setup and Creation
Routing setup and creation is performed in:

■ Process Engineer

■ Set up operation classes. Optional.

■ Set up routing classes. Optional.

■ Set up resources. Required if setting up operations.

■ Set up plant resources. Required if setting up operations.

■ Set up activities. Required if setting up operations.

■ Create new operations. Required if setting up routings.

■ Create new routings. Required if using routings in recipes.

Recipe Creation
Recipe creation is performed in:

■ Formulator

■ Create new recipes. Required.
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Process Flow
The following depicts the previously described process flow:
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Understanding Navigation
Understanding Navigation
The following information is a summary of more detailed discussions found in the 
Oracle Applications User’s Guide.

Navigating the Product Development Application:
In addition to the standard menu and toolbar, a navigator tree provides a 
hierarchical display of the objects in a treelike framework.

Node and Leaf
The higher level nodes in the navigator tree include forms and database objects. All 
other nodes, and the objects they contain, are indented to indicate that they belong 
to these higher level nodes. The terminal node is a leaf. The Product Development 
application uses Data Organizer tabs to group various objects such as recipes, 
formulas, routing and operations. Refer to Identifying Nodes and Tabs on the 
Navigator for specific nodes and tabs that are used in the Product Development 
application.

Menu and Toolbar
Menu and toolbar components let you access all globally available functions.

Data Organizer
The Data Organizer groups objects on separate tabs. Each has a unique icon and its 
own tree hierarchy.

Summary Views
Summary views provide the highest level of business information and display 
information. When you select any container on the Data Organizer navigator tree, 
the summary view can also list the contents of the container in a multirecord block.

Detail Views
Detail views let you display and edit information.

See: Oracle Applications User’s Guide for more information on navigation.

◗◗ To navigate the Product Development application:
The following is a typical flow through the Product Development application Data 
Organizer navigator tree:
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Understanding Navigation
1. Open the appropriate Formulator or Process Engineer workbench. These are 
assigned by the System Administrator.

2. Click the region that contains the object type of interest. For example, the 
Process Engineer workbench includes these tabs:

■ Recipe

■ Formula

■ Routing

■ Operation

3. Select the appropriate View By field. This field presents records sorted and 
grouped by the selection you make. View By fields include:

■ Recipe, Formula, Routing, or Operation

■ Status

■ Owner

■ Class

4. Use one of the following methods to find the appropriate object:

■ Expand or collapse entries in the hierarchical Data Organizer tree.

■ Perform a Find operation from the View menu, choose the appropriate 
object from the results, and optionally, save the object in a Personal or 
Public folder. Optionally, use the right mouse click feature to perform a 
Find operation.

5. Use one of the following methods to show selected object Details:

■ Select the object in the Summary view, and click Details.

■ Select the top node of an expanded object on the navigator tree, and choose 
New from the File menu.

■ Select the top node of an expanded object on the navigator tree, and right 
mouse click. Select New from the right mouse click menu.

6. Double-click an expanded node in the Data Organizer until you reach the 
terminal or leaf object. When you click this object, it opens.

7. Perform actions on the selected object. Navigate from the Detail views to other 
related items of interest.
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Understanding Navigation
8. Use the right mouse click menu to copy objects from the navigator tree nodes 
and paste them into your Personal Shortcuts. You can retrieve these objects 
without the need to find them by methods previously described.
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Understanding Navigation
Identifying Nodes and Tabs on the Navigator Tree:
The following discussion and graphic identify and explain each of the nodes and 
tabs displayed on the navigator tree.

■ 1 is a Routing node. It identifies a Routing on the Navigator.

■ 2 is a Routing tab. Select it to display all Routing available to your 
Responsibility.

■ 3 is an Operation node. It identifies an Operation on the Navigator.

■ 4 is an Operation tab. Select it to display all Operations available to your 
Responsibility

■ 5 is an Activity node. It identifies an Activity on the Navigator.

■ 6 is a Resource node. It identifies a Resource on the Navigator.

■ 7 is a Formula node. It identifies a Formula on the Navigator.

■ 8 is a Formula tab. Select it to display all Formulas available to your 
Responsibility.

■ 9 is a Product node. It identifies a Product on the Navigator.

■ 10 is a By-Product node. It identifies a By-Product on the Navigator.

■ 11 is an Ingredient node. It identifies an Ingredient on the Navigator.

■ 12 is a Recipe node. It identifies a Recipe on the Navigator.

■ 13 is a Recipe tab. Select it to view all Recipes available to your Responsibility.

■ 14 is an Owner node. It identifies an Owner on the Navigator.

■ 15 is a Class node. It identifies a Class on the Navigator.

■ 16 is a Status node. It identifies a Status on the Navigator.
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Understanding Workbenches
The workbench provides you with a complete product, production, technical and 
cost profiling tool that enables you to model a new product and help you meet 
initial product specifications rapidly.

One of the major benefits of using a workbench is that you are able to perform what 
if analyses to facilitate the overall formulation process.

The workbench concept is different from previous approaches used to develop 
products by process manufacturers. Since new products are developed in the 
laboratory, the list of ingredients and products are recorded in the laboratory 
formula. Once the development is complete, production and cost formulas are 
required to manufacture and assign a cost to the product. With the Formulator 
Workbench, laboratory and production formulas are differentiated by a change in 
Status. Changing the status of an experimental formula for use by production, 
costing, or a Material Safety Data Sheet (MSDS) replaces the previous Formula 
upload and download functions with a new business process.

By coupling the workbench capability to a Status Approval Workflow, the entire 
process of initiating and monitoring the development of a new product is 
simplified.

◗◗ To display the Process Engineer Workbench:
1. Navigate to the Product Development Workbench.

2. Expand Routings to view a summary of routings available to your 
responsibility. Expand Operations, Formulas and Recipes available to your 
responsibility as appropriate.

3. Expand Personal Shortcuts to view a summary of all of the personal shortcuts 
available to your responsibility.

4. Expand Public Shortcuts to view a summary of all public shortcuts available to 
your responsibility.

◗◗ To display the Formulator Workbench:
1. Navigate to the Formulator Workbench.

2. Expand Formulas to view a summary of formulas available to your 
responsibility. Expand Recipes, Routings, and Operations available to your 
responsibility as appropriate.
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Understanding Workbenches
3. Expand Personal Shortcuts to view a summary of all personal shortcuts 
available to your responsibility.

4. Expand Public Shortcuts to view a summary of all public shortcuts available to 
your responsibility.

See Also
Oracle Applications User’s Guide
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Understanding the Status Approval Workflow
When the Status Approval Workflow is activated, recipes, formulas, routings, 
operations, and validity rules require a series of approvals that result in reassigning 
their statuses through a predefined approval process. Laboratory Approval is 
optional in this workflow.

Individual tasks are included in each topic to show you how to manage the 
approval workflow process.

Understanding Workflow Processes
Oracle Workflow lets you automate and continuously improve business processes 
by routing information according to a set of business rules. You transmit this 
information to individuals both inside and outside your enterprise as needed.

Setting Up Approvers
The Status Approval Workflow routes information to an approver. An approver is 
an individual or a group. Any individual associated with that approver is able to act 
on the notification. Each notification includes a message associated with all the 
information an individual must make a decision. Some possible responses are also 
included. The Status Approval Workflow interprets each response and moves on to 
the next workflow activity.

Setting Up Workflow Processes
In order for a workflow to operate properly, set up the Oracle Workflow application 
as described in the Oracle Workflow Guide.

A workflow process starts when an application calls a set of Oracle Workflow 
Engine Application Program Interfaces (APIs). The workflow itself is depicted as a 
process diagram containing icons that represent activities. The process contains 
several workflow steps that include approvers, activities, and decision trees that are 
needed to complete the workflow.

Delivering Electronic Notifications
Oracle Workflow enables you to let people receive notifications of items awaiting 
their attention through electronic mail by using a web browser, or on a Notification 
Summary window in Oracle Applications.
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Setting Up the Status Approval Workflow
Set up the Status Approval Workflow in the OPM System Administration 
application. Contact your System Administrator if you are not sure that this is set 
up.

Your OPM System Administrator must set up the following windows:

■ Workflow Process Activation to define the approval processes that use the 
generic workflow process configuration framework. This window enables or 
disables the approval process in the database instance.

■ Workflow Process Configuration Framework to define the configuration 
parameters for each approval process. These configuration parameters 
customize the approval process. For example, if a configuration parameter is 
specified as organization, the approval process for an organization could be 
enabled or disabled.

■ Workflow Activity Approval Configuration Framework to define the 
configuration parameters for each approval process activity. These 
configuration parameters customize the behavior of an activity. For example, if 
the configuration parameter is specified as organization, the approval process 
activity behavior could be customized for an organization.

■ Workflow Process Configuration to customize the approval process behavior 
at a customer site. Approval can be required based on a business process 
requirement. This window lets you enable or disable the approval process 
based on parameters that you defined in the Approval Process Configuration 
Framework.

■ Workflow Activity Configuration to customize the approval process activities 
behavior based on configuration parameters defined in the Approval Process 
Activity Configuration Workflow. Enable or disable an activity and define an 
approver if the activity requires approval.

If the workflow does not start, the Workflow Activation window can be set to 
Deactivate. Contact your OPM System Administrator to determine if this window 
and all appropriate triggers have been set properly.

See: Oracle Process Manufacturing System Administration User’s Guide for more 
information.

Note: Product Development Workflows do not function if seed 
data is changed.
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Enabling the Status Approval Workflow
Enable the Status Approval Workflow by setting it up in the System Administration 
application. Once it is set up and operating, the workflow is activated by changing 
the Status of a recipe, formula, routing, operation, or validity rule from NEW to any 
of the other available status.

Adding and Editing Status Codes to the Status Approval Workflow
If you modify or delete any of the predefined status codes that are supplied with 
this application, the Status Approval Workflow does not run as described in this 
documentation. You have the capability to add or edit status codes as described in 
the Adding and Editing Status Codes topic.

Understanding the Status Approval Workflow
When a recipe, or validity rule is created, the workflow runs as follows:

1. Upon creation, by default, the Status for a recipe, formula, routing, operation, 
or validity rule is assigned the Status NEW.

2. If you choose Change Status from the Actions menu and then select Approved 
for Laboratory Use, the workflow changes Status to Request Approval for 
Laboratory Use. Once approved, Status changes to Approved for Laboratory 
Use.

3. If you choose Change Status from the Actions menu and then select Approved 
for General Use, the workflow changes Status to Request Approval for 
General Use. Once approved, Status changes to Approved for General Use.

4. You have the option to assign the Status Obsolete or Archived.

5. An Approved for Laboratory Use status can be assigned these statuses:

■ On Hold

■ Obsolete or Archived

6. An Approved for General Use status can be assigned these statuses:

■ On Hold

■ Frozen

■ Obsolete or Archived

7. A Pending Approval for Laboratory status or a Pending Approval for General 
Use status can be assigned these statuses:

■ Obsolete
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■ Archived

8. Formulas, routings, operations, recipes, or validity rules that:

■ Fail the approval of Pending Approval for Laboratory Use Status are 
assigned the Status Revise for Laboratory Use.

■ Fail the approval of Request Approval for General Use Status are assigned 
the Status Revise for General Use.
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Understanding the Status Approval Workflow
The following graphic depicts the previously described Status Approval Workflow:
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Disabling the Status Approval Workflow
The System Administrator must disable the Status Approval Workflow. If the 
workflow is disabled, you can still change the Status of a recipe, formula, routing, 
operation, or validity rule. However, the Status change does not initiate the Status 
Approval Workflow.

See Also
Oracle Process Manufacturing System Administration User’s Guide
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Adding and Editing Status Codes
You are able to add to or edit the predefined status codes listed in Appendix C of 
this user’s guide. Modification or deletion of the predefined status codes that are 
supplied with the application may result in the Status Approval Workflow not 
running as described in this documentation.

Do not delete predefined status codes since this could result in unexpected behavior 
of the application.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Read the Understanding the Status Approval Workflow topic.

◗◗ To add a new status code:
1. Navigate to the Status Codes window.

2. Choose New from the File menu. A new row appears for the new Status Code 
you want to add.

3. Enter a new Status Code number. The number you enter is sorted into 
ascending order with the other status codes when you save and reopen the 
Status Codes window.

Codes entered between any two predefined codes, such as 101 to 199, or 201 to 
299 are included in the workflow associated with the predefined status code 
with the same first digit. For example, if you enter the code 110, it becomes part 
of the workflow associated to Code 100. If you enter a code number 699, it 
becomes part of the workflow associated to Code 600. Predefined status codes 
are shown in a table at the end of this task. Required.

4. Enter a brief explanation of the new Status Code in the Description field. 
Required.

5. Enter the information that you want to display on the Status field for the Status 
Code in the Meaning field. Required.

6. The Enable Version check box determines whether the status code entered is 
set up for version control. Any modification made to an operation, routing, 
formula, or recipe while it is set to the status entered in the Meaning field 
initiates or bypasses activation of a new version depending on the selection you 
make here, and the value entered for the appropriate version control profile 
option.
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■ Select the check box if you want the status code to enable version control 
when a modification is made to an operation, routing, formula, or recipe. 
The appropriate version control profile option must be set to Yes or 
Optional.

■ Clear the check box if you want the status code to bypass version control 
when a modification is made to an operation, routing, formula, or recipe.

7. Save the window.

8. Click Details to enter Status Details as described in the Entering Status Details 
topic.

The following are the required predefined status codes:

Code Meaning Description Version Enabled

100 New Formulation stage. Can make 
changes at any time, assuming 
security access.

Yes

200 Request Approval for 
Laboratory Use

Submitted for approval of use in 
Laboratory runs.

No

300 Revise for Laboratory Approval has failed and rework is 
required

No

400 Approved for 
Laboratory Use

Can be used in Laboratory batches 
and cost rollups for Laboratory

Yes

500 Request Approval for 
General Use

Submitted for final approval No

600 Revise for General 
Use

Approval has failed and rework is 
required

Yes

700 Approved for 
General Use

Can be used for production batches, 
cost rollups

Yes

800 On Hold Object cannot be used until status is 
changed

No

900 Frozen Prevents further changes to object 
and any dependent data. Object can 
still be used.

No

1000 Obsolete/Archived Object can no longer be used unless 
status is changed.

No
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◗◗ To edit an existing status code:
1. Navigate to the Status Codes window.

2. Edit the following fields as required:

■ Description, to change the explanation of the status code. 

■ Meaning, to change the information displayed on the Status field in the 
application.

3. The Enable Version check box determines whether the status code entered is 
set up for version control. Any modification made to an operation, routing, 
formula, or recipe while it is set to the status entered in the Meaning field 
initiates or bypasses activation of a new version depending on the selection you 
make here, and the value entered for the appropriate version control profile 
option.

■ Select the check box if you want the Status Code to enable version control 
when a modification is made to an operation, routing, formula, or recipe. 
The appropriate version control profile option must be set to Yes or 
Optional.

■ Clear the check box if you want the Status Code to bypass version control 
when a modification is made to an operation, routing, formula, or recipe.

4. Click Details. The Status Details window displays.

5. Edit the following fields as required:

■ Target Status, to change the code that appears as the destination status on 
the Change Status window.

■ Rework Status, to change the destination for the listed status code when it 
is not accepted and must be reworked.

■ Pending Status, to change the destination of the listed status code when it 
enters the approval workflow, and is pending approval.

Required.

6. Edit the Workflow Indicator by selecting:

■ Enable or Disable Workflow to indicate that the fields listed in the row 
enable or disable the workflow.

■ Workflow Approval to indicate that the fields listed in the row require 
workflow approval.
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■ No Workflow Approval to indicate that the fields listed in the row do not 
require workflow approval.

Required.

7. Click OK.

8. Save the window.

Entering Status Details
The Status Details window enables you to enter a target status for a new status 
code. You can optionally enter rework status, pending status, and assign a 
workflow indicator.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

◗◗ To enter status details:
1. Enter a Target Status for the new Status Code. This is the code that appears as 

the destination status on the Change Status window. You have the ability to 
enter several Target Status destinations for each Status Code. They must be 
entered on separate lines. Required.

2. Optionally, enter a Rework Status for the new Status Code. The Rework Status 
code defines the destination for the listed Status Code when it is not accepted 
and must be reworked.

3. Optionally, enter a Pending Status for the new Status Code. The Pending Status 
code defines a destination of the listed Status Code when it enters the approval 
workflow and is pending approval.

4. Select one of the following as Workflow Indicator:

■ Enable or Disable Workflow to indicate that the fields listed in the row 
enable or disable the workflow.

■ Workflow Approval to indicate that the fields listed in the row require 
workflow approval.

■ No Workflow Approval to indicate that the fields listed in the row do not 
require workflow approval.

Required.

5. Click OK.
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6. Save the window.

Finding a Status Code
The Find Status Codes window lets you find a status code by code number, 
description, version enabled, or mark for purge status.

◗◗ To find a status code:
1. Navigate to the Find Status Codes window.

2. Enter one or more of the following fields to narrow your search:

■ Status Code, to find a specific code number.

■ Description, to find a specific status code description.

■ The Version Enabled check box determines whether the status code entered 
is set up for version control. Any modification made to an operation, 
routing, formula, recipe, or validity rule while it is set to the status entered 
in the Meaning field initiates or bypasses activation of a new version 
depending on the selection you make here, and the value entered for the 
appropriate version control profile option.

– Select the check box if you want to find the status codes that enable version 
control when a modification is made to an operation, routing, formula, 
recipe, or validity rule. The appropriate version control profile option must 
be set to Yes or Optional.

– Clear the check box if you do not want to find the status codes that bypass 
version control when a modification is made to an operation, routing, 
formula, recipe, or validity rule.

■ The Mark For Deletion list box lets you find status codes with the status:

– Yes indicating the status code has been marked for purge

– No indicating that the status code has been undeleted.

3. Click Find to display the results of your query.

4. Click the down arrow to display all status codes that were found.

5. Optionally, click New to enter a new status code. The Status Codes window 
displays.
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Understanding Version Control
Some businesses require version control to generate an audit trail. By monitoring 
version changes you define rules for modifying recipes, formulas, routings, 
operations, and quality specifications. The Product Development Version Control 
function lets you determine if an existing version can be modified, or if a new 
version must be created. Product Development lets you:

■ Force the creation of new versions so that transaction sources stay intact.

■ Deliver a combination of forced version creation and no version control.

■ Provide no version control.

These decisions are made at the organization level with proper assignment of User 
Responsibilities. Status must be Approved for General Use for Version Control to be 
active. All other statuses do not require that a new version be created each time a 
change is made.

Version Control does not validate the Formula, Routing, or Version fields on a 
recipe header. These fields cannot be changed once a recipe is saved. A new recipe 
must be created in order to change these fields, whether or not Version Control is 
used. Version Control does not take the Status field into account when determining 
whether a new version should be created. This is also true for Mark for Purge and 
Undelete functions.

How Does Version Control Work?
Profile options for Version Control are:

■ GMD: Recipe Version Control

■ GMD: Formula Version Control

■ GMD: Routing Version Control

■ GMD: Operation Version Control

Each profile option is set to one of the following profile values:

■ Y means Yes, indicating that Version Control is activated and any change made 
requires a new version.

■ N means No, indicating that Version Control is not activated and any change 
can be made to the existing version.

■ O means Optional, indicating that Version Control is optional. You are asked if 
you want to create a new version if any change is made to the existing version.
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You can set Version Control to any appropriate level of activation. In practice, it is a 
good idea to set Version Control profile options initially to O. You are notified each 
time you attempt to save changes. The setting of these options is totally a matter of 
your individual business requirements.

See: Oracle Process Manufacturing Implementation Guide for more specific details on 
setting these profile options.

Setting Up Version Control at the Organization and Responsibility Level
You must be associated with valid organizations in order to create transactions and 
perform certain functions in Product Development. You must be linked to 
appropriate Responsibilities in order to access specific workbenches. If new 
Responsibilities are implemented as described in the following example, you can 
achieve Version Control by association to an organization through a link to a 
specific Responsibility within the organization. Here is an example of how to set up 
Version Control:

Users are defined as:
ABC for Formulator ABC

JKL for Formulator JKL

XYZ for Formulator XYZ

Organizations are:
OA for Oracle Applications 

OPM for Oracle Process Manufacturing Company, consisting of:

PLT1 for Plant1

PLT2 for Plant2

PLT3 for Plant3

Responsibilities are:
Formulator for PLT1

Formulator for PLT2

Formulator for PLT3

User-Organization Associations are:
ABC for PLT1
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JKL for PLT1

XYZ for PLT1

User-Responsibility Associations are:
ABC for Formulator PLT1

JKL for Formulator PLT2

XYZ for Formulator PLT3

Profile Settings are:
GMD: Formula Version Control is set to Y for the Responsibility of Formulator 
PLT1

At logon, User ABC is presented with a list of Responsibilities for Formulator PLT1. 
Menus and windows associated with the Formulator Responsibility are accessible 
to User ABC, and they are configurable. Specific windows and functions can be 
enabled or disabled within Menus and Responsibilities. Since the user organization 
association for User ABC is limited to PLT1, and the Formula Version Control 
profile option is enabled for this Responsibility, any modifications made to a 
formula during the session for User ABC requires a new version of a formula for 
PLT1.

If User ABC were to change to a Responsibility where Version Control was set to N, 
modifications to a formula in that session would not require a new formula version 
to be created.

If User ABC were to change to a Responsibility where Version Control was set to O, 
modifications to a formula in that session would notify User ABC that Version 
Control was optional. Prior to saving a change, User ABC is asked whether or not to 
change the existing formula version.
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Setting Up

This topic provides the setup requirements in other applications, and setup required 
in Product Development. You must set up responsibilities and menu access. 
Depending on your individual requirements you set up formula classes, operation 
classes, routing classes, activities, resources, plant resources, laboratories, technical 
parameters, technical parameter sequences, and technical class and subclass 
category sets.

The following topics provide the information required to set up Product 
Development:

■ Setting Up in Other Applications

■ Setting Up Responsibilities and Menu Access

■ Setting Up Formula Classes

■ Setting Up Operation Classes

■ Setting Up Routing Classes

■ Setting Up Activities

■ Setting Up Laboratories

■ Setting Up Technical Parameters

■ Setting Up Technical Parameter Sequences

■ Setting Up Technical Classes and Subclasses
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Setting Up in Other Applications
Set up these prerequisites prior to running the Product Development application:

Setting Up Profile Options in OPM System Administration
In the System Administration Responsibility, set up the following profile options:

■ GMD: Automatic Generation Of Step Dependency Attributes

■ GMD: Automatic Step Number Generation

■ GMD: Byproduct Active

■ GMD: Default Consumption/Yield Type

■ GMD: Default Dependency Type

■ GMD: Default Lab Organization

■ GMD: Default Step Release Type

■ GMD: Density

■ GMD: Designer Category Set

■ GMD: Designer Display New Item Window

■ GMD: Display Step Qty In Routing Graph

■ GMD: Display Transfer Pct In Routing Graph

■ GMD: Display Transfer Qty In Routing Graph

■ GMD: Effective Maximum Date

■ GMD: Effective Minimum Date

■ GMD: Enforce Step Dependency

■ GMD: Exact Specification Match

■ GMD: Formula Version Control

■ GMD: Operation Version Control

■ GMD: Process Instruction Paragraph

■ GMD: Recipe Version Control

■ GMD: Routing Version Control

■ GMD: Scrap Factor Type
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■ GMD: Technical Parameter Category Set

■ GMD: UOM Mass Type

■ GMD: UOM Volume Type

■ GMD: User Name for ALL

■ GMD: Workflow Timeout (in Days)

■ GMD: Yield Type

Set up the following:

■ Units of Measure

■ Units of Measure Classes

■ Units of Measure Conversion

Use a common predefined unit of measure for the step quantity and charges 
calculation process. This approach provides better performance. Conversions must 
be defined for individual items between the item unit of measure and the common 
unit of measure. This eliminates the requirement to set up item conversions 
between the item unit of measure and the associated operation unit of measure.

Setting Up the GMD: Process Instruction Paragraph Profile Option
Many windows in OPM applications let you associate text with any record of the 
edited document. For example, you can attach text to a specific ingredient line in a 
formula. In the Recipe Designer, paragraphs are structures that are used to store and 
categorize text. The standard application has the General Text paragraph as the one 
default paragraph stored for each database table.

In order to provide the Recipe Designer with a means to distinguish between 
Process Instructions and other text types that are stored, your System Administrator 
needs to define a paragraph code for process instructions. Text that is displayed in 
the Process Instruction Sheet of the Recipe Designer is the text defined for the 
paragraph code specified by the GMD: Process Instruction Paragraph profile 
option.

◗◗ To define a paragraph code for process instructions:
1. Create a new paragraph code with a Sub Code, sub-paragraph code, equal to 

zero for the following tables:

■ FM_MATL_DTL, the Formula Material detail table

■ FM_ROUT_DTL, the Routing Detail table 
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■ GMD_RECIPE_ROUTING_STEPS, the Recipe Routing Steps table

■ GMD_RECIPE_STEP_MATERIALS, the Operation Step and Material 
Association table

2. Specify the paragraph code defined in step 1 as the value for the new GMD: 
Process Instruction Paragraph profile option. The Recipe Designer reads the 
GMD: Process Instruction Paragraph profile option to determine the paragraph 
code used to retrieve and store process instructions.

Refer to the Oracle Process Manufacturing Implementation Guide and the Oracle Process 
Manufacturing System Administrator User’s Guide for additional information.

See Also
Oracle Workflow

Setting Up OPM Inventory Control
In the OPM Inventory Control application, set up the following:

■ Items and item attributes for every raw material, intermediate, and end item.

■ Unit of measure conversions for each item, between the item's primary 
inventory unit of measure and the unit of measure you use in the formulas, if 
different. This is entered on the Item/Lot Sublot Conversions window.

Unit of measure types, units of measure, unit of measure conversions, and specific 
conversions such as item lot and sublot conversions are synchronized with 
corresponding Oracle Process Manufacturing Financials data.

See Also
Oracle Process Manufacturing Inventory Management User‘s Guide

Oracle Inventory User’s Guide

Setting Up Cost Management
In the Cost Management application, set up the following:

■ Cost analysis codes

■ Cost calendar

See Also
Oracle Process Manufacturing Cost Management User’s Guide
2-4 Oracle Process Manufacturing Product Development User’s Guide



Setting Up in Other Applications
Setting Up Process Planning
In the OPM Capacity Planning application, set up the following:

■ Resources

■ Plant Resources

See Also
Oracle Process Manufacturing Capacity Planning User’s Guide

Setting Up Oracle Applications System Administrator
The Recipe Designer uses a Thin Client Framework, or TCF technology. Two profile 
options are set up during the implementation:

■ TCF:HOST

■ TCF:PORT

Refer to the "Profile Options in Oracle Application Object Library" topic in the 
Oracle Applications System Administrator’s Guide for a detailed discussion of these 
profile options.

Setting Up Security Profiles
Depending on your security profile, some of the information on certain windows 
may not be available to you. Contact your Product Development Security Manager 
or Product Development Security Profile Manager if you require access to this 
information.
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Setting Up Responsibilities and Menu Access
Set up Workbench Responsibilities for each user. The following are menu and 
submenu selections available to each listed Workbench Responsibility:

■ Formulator

■ Formulator Workbench

■ Formulas

■ Recipes

■ Mass Search and Replace

■ Spreadsheet

■ Inventory Items

■ Indented Formulas

■ Formula Inquiry

■ Technical Data: Technical Parameters

■ Technical Data: Technical Parameter Sequences

■ Technical Data: Item Technical Data

■ Formula Analysis: Parameters

■ Formula Analysis: Analysis

■ Setup: Formula Class

■ Setup: Status Codes

■ Process Engineer

■ Engineering Workbench

■ Routings

■ Operations

■ Recipes

■ Mass Search and Replace

■ Setup: Routing Classes

■ Setup: Operation Classes

■ Setup: Activities
2-6 Oracle Process Manufacturing Product Development User’s Guide



Setting Up Responsibilities and Menu Access
■ Setup: Generic Resources

■ Setup: Plant Resources

■ Setup: Alternate Resources

■ Setup: Status Codes

■ Product Development Security Manager

■ Product Development Security Profile Manager
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Setting Up Formula Classes
Formula Classes group formulas with similar characteristics and requirements for 
reporting purposes. For example, use a formula class to classify all formulas for 
ACRYLIC paints, or to classify all formulas for ORGANIC paints. Food seasoning 
formulas could be grouped under a SEASONINGS class. You specify the formula 
class on the Formula Details window. Defining formula classes is optional.

Prerequisites
❏ Analyze all formulas for common properties that are used to classify them.

◗◗ To set up formula classification codes:
1. Navigate to the Formula Classes window.

2. Enter the Class code that identifies formulas with similar characteristics or 
requirements. Required.

3. Enter a brief Description of the classification you are adding. Required.

4. Save the window.
2-8 Oracle Process Manufacturing Product Development User’s Guide



Setting Up Operation Classes
Setting Up Operation Classes
Group operations with similar characteristics and requirements for reporting 
purposes. For example, you could set up classes for MIXING, HEATING, DRYING, 
or GRINDING. Defining operation classes is optional.

Prerequisites
❏ Analyze all operations for common properties that are used to classify them.

◗◗ To set up operation classification codes:
1. Navigate to the Operation Classes window.

2. Enter the Class code that identifies operations with similar characteristics or 
requirements. Required.

3. Enter a brief Description of the classification you are adding. Required.

4. Save the window.
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Setting Up Routing Classes
Routings are sequenced sets of operations that must be performed in order to 
complete a production batch. It is useful to set up routing classes to group routings 
with similar characteristics and requirements for reporting purposes. Defining 
routing classes is optional. The UOM in the routing class window is required if the 
theoretical process loss is defined for the routing class.

Prerequisites
❏ Analyze all routings for common properties that are used to classify them.

◗◗ To set up routing classification codes:
1. Navigate to the Routing Classes window.

2. Enter the Class code that identifies routings with similar characteristics or 
requirements. Required.

3. Enter a Routing Class Description for the Class code entered. Required.

4. Enter the UOM for the Class code.

5. Click Theoretical Process Loss to display the Theoretical Process Loss window. 
Theoretical Process Loss is discussed in the Routings topic.

6. Save the window.

See Also
Routings
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Setting Up Activities
Activities are actions performed during production. For example, mixing and 
cooling are activities. Activities are usually set up so that they divide a 
manufacturing process into logical breakpoints. By analyzing and refining the 
granularity of activities, businesses can improve their work methods and reduce 
time to manufacture so that activities performed in operations are completed in the 
shortest possible time with the least effort to deliver the appropriate level of quality.

Cost analysis codes are assigned to activities so that proper cost calculations can be 
performed.

Prerequisites
❏ Set up cost analysis codes.

◗◗ To set up activities:
1. Navigate to the Activities window.

2. Enter an Activity Code for the name of the activity. Activities are the 
components that make up an operation. Required.

3. Enter a brief Description of the activity. Required.

4. Enter the cost Analysis Code. This code is set up in Cost Management 
application. Required.

5. Save the window.

See Also
Oracle Process Manufacturing Cost Management User’s Guide
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Setting Up Laboratory Organizations
After meeting the prerequisites for setup in other applications, define laboratory 
organizations. Laboratories are used to group technical parameters.

Most organizations manufacture a variety of similar products that are often 
grouped into product lines or families. The same technical parameters are likely to 
be relevant to the products within a product family and to the ingredients used to 
manufacture those products. For example, viscosity is likely to be relevant to all 
lubricants, while opacity or contrast ratio is likely to be relevant to all paints.

When you set up an organization as a laboratory, verify that you select Laboratory 
as the Plant type on the Organizations window in the System Administration 
application. This laboratory organization defaults into the Organization field on 
each window where you can enter Technical Parameters. A laboratory organization 
is required for local technical parameters and for generation of a density technical 
parameter. Set the laboratory organization to the GMD: Default Lab Organization 
profile option. In addition, set the GMD: UOM Mass Type and the GMD: UOM 
Volume Type profile options for converting density in the spreadsheet calculations. 
Density is defined as Mass/Volume.

Although production batches can be generated from a plant or a lab, you can view 
local technical parameters that are linked from a lab to a production batch produced 
in a plant.

See Also
Oracle Process Manufacturing Implementation Guide

Oracle Process Manufacturing System Administration User’s Guide
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Setting Up Technical Parameters
Technical parameters are those characteristics of items that you want to measure 
and calculate. There are several types of technical parameters. For example, a 
gravimetric technical parameter for percent solids by weight (w/w) is Weight%. 
Technical Parameters can function as expressions, numeric ranges, list values, 
character values, or link to quality tests. Technical parameters can be linked to a 
specific lab organization, or can be global in nature.

For each type of technical parameter, specify certain constraints on the data that can 
be entered for that parameter, such as the minimum and maximum values.

When using global technical parameters across multiple labs, technical parameters 
must be independent of the lab organization. To create a global technical parameter, 
do not enter an organization. The organization field displays the default 
organization defined in the profile GMD: Default Lab Organization.

Prerequisites
❏ Define a laboratory organization.

❏ Determine the hierarchy of technical parameters to be set up. For example, 
density, gram percent, gram molecular weight, formula weight, and osmolality. 
These must be developed so that they can be sequenced in a hierarchy that can 
be rolled up to the product level.

◗◗ To use expressions in technical parameters:
The following functions are supported for defining expressions, and the 
mathematical operators to use:

■ Addition (+)

■ Subtraction (-)

■ Multiplication (*)

■ Division (/)

■ Exponentiation (^)

■ Square Root (SQRT)

■ Common Logarithm (LOG)

■ Natural Logarithm (LN)
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For example, if you are defining a technical parameter that is calculated by 
multiplying two other technical parameters, PARM1 and PARM2, enter the 
following:

PARM1*PARM2

To take the square root of PARM1, enter the following:

SQRT(PARM1)
You cannot put spaces (blanks) in the name of a technical parameter that you use in 
an expression. For example, (PARM 1) * (PARM 2) cannot be calculated because 
there is an extra space before and after the * operator.

◗◗ To use fixed expressions in technical parameters:
Certain technical parameters are fixed expressions that can be summed up for all 
ingredients in a formula. This is called a formula rollup.

The following technical parameter types are available:

■ Weight Percent is calculated as the quantity Sigma ti multiplied by wi minus the 
quantity Sigma tj multiplied by wj divided by the quantity Sigma wi minus the 
quantity Sigma wj.

■ Volume Percent is calculated as the quantity Sigma ti multiplied by vi minus the 
quantity Sigma tj multiplied by vj divided by the quantity Sigma vi minus the 
quantity Sigma vj.

■ Specific Gravity is calculated as the quantity Sigma ti multiplied by vi minus the 
quantity Sigma tj multiplied by vj divided by the quantity Sigma vi minus the 
quantity Sigma vj.

■ Cost is calculated as the quantity Sigma ti multiplied by Ii minus the quantity 
Sigma tj multiplied by Ij.

■ Equivalent Weight is calculated as the the quantity Sigma Ti minus the quantity 
Sigma Tj divided by the quantity Sigma Tidivided by ti minus the quantity 
Sigma Tj divided by tj.

■ Quantity per Unit is calculated as the quantity Sigma ti multiplied by Ii minus 
the quantity Sigma tj multiplied by Ij.

where:

■ Sigma is summation over "i" ingredients or "j" byproducts

■ ti is the value of the technical parameter for the "i-th" ingredient
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■ tj is the value of the technical parameter for the "j-th" byproduct

■ wi is the weight of the "i-th" ingredient in the base unit of measure for mass

■ wj is the weight of the "j-th" byproduct in the base unit of measure for mass

■ vi is the volume of the "i-th" ingredient in the base unit of measure for volume

■ vj is the volume of the "j-th" byproduct in the base unit of measure for volume

■ Ii is the quantity of the "i-th" ingredient in its primary inventory unit of measure

■ Ij is the quantity of the "j-th" byproduct in its primary inventory unit of measure

■ Ti is the quantity of the "i-th" ingredient in the units specified for the technical 
parameter

■ Tj is the quantity of the "j-th" byproduct in the units specified for the technical 
parameter

The following table displays the previously described calculations used for each of 
the listed technical parameter types.

Technical Parameter Type Calculation

Weight Percent

Volume Percent

Specific Gravity

Cost

Equivalent Weight

Quantity per Unit
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Expressions are equations you define that use mathematical operators and 
previously defined technical parameters.

For example, define a technical parameter as a percent solvent, with each ingredient 
in a formula contributing a differing portion of its weight to a product as solvent. 
Use the Technical Parameters window to set up various quantitative relationships 
between individual parameters. The application finds the weight of solvent 
contributed by each ingredient and calculates the sum of these contributions. After 
determining the total formula weight, the application expresses the ratio of percent 
solvent for each product.

Calculations such as total weight and total volume are available for use in 
expressions. When a technical parameter is used within an expression, the product 
total value of the parameter may be required rather than individual ingredient 
values. A Product Expression data type defines technical parameters that are to be 
rolled up to the product value.

Two functions, ISUM and BSUM are provided that indicate a total rollup sum to 
perform on ingredients and byproducts, respectively.

Variables QTY$ and VOL$ are used and refer to ingredient or by product weights 
and volumes. QTY$ is the ingredient or by product quantity in the standard UOM 
of the UOM class defined by the profile GMD: UOM Mass Type. VOL$ is the 
ingredient or by product quantity in the standard UOM of the UOM class defined 
by the profile GMD: UOM Volume Type. If you do not have the correct UOM 
conversions set up for your items between mass and volume, then calculations on 
the spreadsheet will not be correct.

In addition to the technical parameters that you define on the Technical Parameters 
window, OPM creates a technical parameter for density when you define a 
laboratory organization. The application uses this density technical parameter for 
conversions from mass units of measure to and from volume units of measure. It 
does not use the item specific unit of measure conversions set up on the Item 
Lot/Sublot Std Conversion window. It does, however, use the regular unit of 
measure conversions for formulas. Enter data for the DENSITY technical parameter 
for all items where you must convert mass to volume or volume to mass.

If this parameter is not set properly, spreadsheet calculations are inaccurate.

GMD: Density defines the density technical parameter.

◗◗ To set up technical parameters:
1. Navigate to the Technical Parameters window.
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2. Enter the code for the laboratory Organization where you are defining a 
technical parameter. A description of this laboratory displays. To define a local 
technical parameter, use the GMD: Default Lab Organization profile option 
value. 

3. Enter the name of the technical Parameter Name. Required.

4. Enter a Description or statement about what the technical parameter 
represents. Required.

5. If you are linking this technical parameter to a test in the Quality Management 
application, then enter the name of the Test. Otherwise, leave this field blank.

6. Select the Data Type to be associated with this technical parameter. Supply the 
required information listed in the table at the end of this task. Only specific 
gravity, equivalent weight, and expressions are not validated against the units 
entered in the Quality Control application. Quality Control units of measure are 
for notational purposes only, and are not used in calculations. Product 
Expression data type is used to define technical parameters that are to be rolled 
up to the product values.

7. Enter the Unit of measure for the technical parameter. Technical parameters for 
specific gravity and equivalent weight use the units of measure set up in the 
System Administration or Oracle Inventory applications. All other technical 
parameters use the units of measure set up on the Units window in the Quality 
Control application. With the exception of equivalent weight, this unit of 
measure is not used in any calculations.

8. For Numeric Range test data types:

■ Enter the lower limit of the Numeric Range in the first field. Enter the 
upper limit of the range in the second field. For example, an entry of 20 
through 30 represents a Numeric Range from 20 to 30.

■ Enter the number of Significant Digits to display for numeric expressions 
and calculations.

9. Save the window.

Data Type Required Information

0 - Character Enter the minimum and maximum valid character strings based 
on ASCII sort sequence and maximum length.
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1 - Numeric ■ Enter the Unit of Measure in the Unit field.

■ Enter the minimum and maximum valid values in Numeric 
Range fields.

■ Enter the number of significant digits required in the 
Significant Digits field.

2 - Validation List ■ Enter the Unit of Measure in the Unit field.

■ Enter a list of valid values in the Validation List fields.

3 - Boolean No additional definition is required. The entry is unitless.

4 - Expression ■ Enter the Unit of Measure in the Unit field.

■ Enter the mathematical expression for calculating the 
technical parameter in the Expression field.

5 - Weight Percent ■ Enter the Unit of Measure in the Unit field.

■ Enter the minimum and maximum valid values in Numeric 
Range fields.

■ Enter the number of significant digits required in the 
Significant Digits field.

6 - Volume Percent ■ Enter the Unit of Measure in the Unit field.

■ Enter the minimum and maximum valid values in Numeric 
Range fields.

■ Enter the number of significant digits required in the 
Significant Digits field.

7 - Specific Gravity ■ Enter the Unit of Measure in the Unit field.

■ Enter the minimum and maximum valid values in Numeric 
Range fields.

■ Enter the number of significant digits required in the 
Significant Digits field.

8 - Cost ■ Enter the Unit of Measure in the Unit field.

■ Enter the minimum and maximum valid values in Numeric 
Range fields.

■ Enter the number of significant digits required in the 
Significant Digits field.

Data Type Required Information
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9 - Equivalent Weight ■ Enter the Unit of Measure in the Unit field.

■ Enter the minimum and maximum valid values in Numeric 
Range fields.

■ Enter the number of significant digits required in the 
Significant Digits field.

10 - Quantity Per Unit ■ Enter the Unit of Measure in the Unit field.

■ Enter the minimum and maximum valid values in Numeric 
Range fields.

■ Enter the number of significant digits required in the 
Significant Digits field.

11 - Product Expression ■ Enter the Unit of Measure in the Unit field.

■ Enter the mathematical expression for calculating the 
technical parameter in the Expression field.

Data Type Required Information
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Setting Up Technical Parameter Sequences
After entering the technical parameters for a laboratory organization, specify the 
order displayed as the technical parameter sequences.

The Technical Parameter Sequences window establishes which technical parameters 
to use for the spreadsheet, and the order in which they display. All technical 
parameters that were defined locally for the laboratory organization are available, 
but can be deleted on an individual basis. Global technical parameters, as well as 
technical parameters grouped as item category sets, can be selected for the 
spreadsheet from this window. There are three levels of flexibility in defining 
technical parameter sequences: Organization, Organization Item, and Organization 
Item Category.

Expression type technical parameters that refer to other technical parameters must 
come after the technical parameters they reference in the sequence. For example, if 
PARM_3 is calculated by multiplying PARM_1 by PARM_2, PARM_3 must come 
after PARM_1 and PARM_2 in the technical parameter sequences. By default, the 
DENSITY technical parameter, or its equivalent is 1. Do not change this.

Prerequisites
❏ Determine if two or more technical parameters are required in a calculation. If 

they are, verify their proper order prior to sequencing them in the Technical 
Parameter Sequences window. For example, if you want to determine a 
Brix-to-Acid ratio, first enter the Brix calculation, then the Acid calculation, and 
finally, the Brix/Acid calculation.

◗◗ To set up technical parameter sequences:
1. Navigate to the Technical Parameter Sequences window.

2. Enter the code for the laboratory Organization where you are setting up the 
technical parameter sequences. The Organization Description displays.

3. Enter the Item to display technical parameters associated with that item.

4. Enter Category to display technical parameters associated with the item class. 
The Category Description displays.

Parameter Sequence
5. Enter the code for a technical Parameter associated with the laboratory 

organization entered. For example, enter GMW for gram molecular weight.

6. Global is selected when the parameter is not global.
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7. Enter a Sort number between 1 and 9999 to determine where in the list of 
technical parameters this parameter is displayed. When entering technical 
parameter data, the technical parameters are displayed in numerical order 
based on the number entered in this field.

The numbers do not have to be sequential. For example, you could enter 10, 20, 
30, and so forth to accommodate for the future addition of technical parameters.

8. When Quality Control is selected, the technical parameter is linked to a quality 
test. If Quality Control is not selected, then the technical parameter is not linked 
to a test.

9. The Description displays a brief statement about what the technical parameter 
represents, and is entered from the Test Description in the Quality Management 
application.

10. Save the window.
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Setting Up Technical Classes and Subclasses
The following procedures set up Technical Classes and Technical Subclasses for 
items. You can access the Key Flexfield Segments window from the System 
Administrator responsibility or from the Oracle Process Manufacturing Inventory 
Control application. In formula analysis, you can view results for the contribution 
of Technical Class or Technical Subclass in either weight or volume.

See: Oracle Applications User’s Guide and Oracle Applications Flexfields Guide.

Prerequisites
❏ Determine whether Technical Class and Technical Subclass key flexfields are 

already created.

◗◗ To create key flexfields for Technical Class and Technical Subclass:
1. Navigate to the Key Flexfield Segments window.

2. Choose Find... from the View menu to find all Key Flexfield Segments entered 
for the Oracle Inventory Item Categories Flexfield Title. Technical Class and 
Technical Subclass are Item Categories that belong to the Oracle Inventory 
application. The Key Flexfield Segments window displays all flexfields defined 
for the Flexfield Title of Item Categories.

3. Insert a new row to create the Technical Class and Technical Subclass definition.

4. Enter the Code as TECH_CLASS_SUB_CLASS. The Title defaults to the Code.

5. Enter the Title and Description as Technical Class & Subclass.

6. Click Segments. The Segments Summary window displays for Technical Class 
& Subclass.

7. Enter two segments with the following values, and leave the Value Set blank:

■ Technical Class, with a Window Prompt of Technical Class and a Column 
of SEGMENT1.

■ Technical Subclass, with a Window Prompt of Technical Subclass and a 
Column of SEGMENT2.

8. Save your work.

9. Click Value Set. The Value Sets window displays.

10. Enter the Value Set Name as TECHNICAL_CLASS.

11. Description displays Technical Class.
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12. Enter a Maximum Size of 8.

13. Choose Save and Proceed.

14. The TECHNICAL_SUB_CLASS Value Set Name displays.

15. Description displays Technical Subclass.

16. Enter a Maximum Size of 8.

17. Save your work.

18. The Segments Summary (Item Categories) - Technical Class & Subclass 
window displays the entries for Technical Class and Technical Subclass.

19. Find a Value Set of TECHNICAL_CLASS for Technical Class.

20. Find a Value Set of TECHNICAL_SUB_CLASS for Technical Subclass.

21. Save your work.

22. Return to the Key Flexfield Segments window to freeze the flexfield 
definitions.

23. Select Freeze Flexfield Definition. A Caution message displays to indicate that 
flexfields can be unfrozen, but that doing so can cause problems once you have 
entered data in the flexfield.

24. Click OK.

25. Click Compile to establish the flexfield structure. The following Note displays:

Compiling flexfield definition.

26. Click OK.

27. After compilation, a concurrent request is submitted to generate a flexfield 
view. The following Note displays:

The flexfield was compiled successfully. Submitted request to generate flexfield 
view...

28. Click OK.

29. Check completion of the concurrent program by viewing submitted requests.

30. Define Technical Class & Subclass values.

◗◗ To define Technical Class & Subclass values:
1. Navigate to the Segment Values window.
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2. Enter the following in the Find Key Flexfield Segments window:

■ Enter Oracle Inventory as Application.

■ Enter Item Categories as Title.

■ Enter Technical Class & Subclass as the Name of the Structure created.

3. Click Find.

4. Query Technical Class as the Independent Segment.

5. Enter an appropriate Value, Translated Value, and Description for Technical 
Class. For example, enter:

■ Binder as Value, Translated Value, and Description.

■ Solvents as Value, Translated Value, and Description.

The values entered appear as allowable values for the Technical Class LOV.

6. Select Enabled.

7. Choose Save & Proceed.

8. Query Technical Subclass as the Independent Segment.

9. Enter an appropriate Value, Translated Value, and Description for Technical 
Subclass. For example, enter:

■ Acrylic as Value, Translated Value, and Description.

■ Alkyd as Value, Translated Value, and Description.

■ Epoxy as Value, Translated Value, and Description.

■ Organic as Value, Translated Value, and Description.

The values entered appear as allowable values for the Technical Subclass LOV.

10. Select Enabled.

◗◗ To define Categories:
1. Navigate to the Codes window. The Find Categories window displays.

2. Click New.

3. Enter Technical Class & Subclass.

4. Enter each Category multisegment flexfield structure to assign meaning to each 
segment. For example, enter:
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■ Binder.Acrylic for an acrylic binder.

■ Binder.Alkyd for an alkyd binder.

■ Binder.Epoxy for an epoxy binder.

5. Enter an appropriate Value for each Segment.

6. Click OK. Return to the Categories window.

7. Enter a unique Description for each Category. For example, Binder.Acrylic 
could have the Description Binder/Acrylic.

8. Save the window.

◗◗ To define Category Sets:
1. Navigate to the Category Sets window.

2. Select the appropriate Inventory Organization.

3. Click OK.

4. Enter a unique Name and Description for the Category Set. For example, enter:

■ Technical Classification as Name.

■ Component Technical Classification as Description.

5. Enter the Flex Structure created. For example, enter Technical Class & Subclass.

6. Verify that the Category Set is controlled at the Master Level. This lets you 
assign the same Category Value in all organizations where it is assigned.

7. Enter the Default Category. For example, enter Binder.Acrylic. The default is 
used when assigning an item to the Category Set.

8. Determine if you want to Enforce a List of Valid Categories:

■ Select this check box if you want to assign items only to Categories defined 
as valid for the current Category Set. Enter each of the Valid Categories.

■ Clear this check box if you want to assign an item to any Category that has 
the same flexfield structure as the current Category Set.

9. Click Assign. The Item Assignments (OPM) Technical Classification, Master 
Level window displays.

10. Query the Item you want to assign to the Category Set.

11. Select the Category and enter the Segments.
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12. Repeat steps 9 and 10 for each additional Item you want to assign.

13. Click Accept.

◗◗ To assign Category Sets to a Process Manufacturing Class:
1. Navigate to the OPM Category Sets window.

2. Select the Category Set for the appropriate Process Manufacturing Class. Enter 
Technical Classification as Category Set.

3. Save the window.

See Also
Oracle Process Manufacturing Inventory Control User’s Guide
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Formulas

This topic shows you how to define the formulas that drive your manufacturing 
process. It includes a basic understanding of formula setup. You are shown how to 
enter item technical data and use the laboratory spreadsheet. You are introduced to 
setting up formula information including how to use formula phantoms, methods 
available to scale formulas, and to find formulas. In addition to entering formula 
details, you are shown how to define and maintain formulas at the header and line 
levels. Methods for determining where ingredients are used, the Indented Bill of 
Materials Report, and formula inquiry help you locate formula information rapidly.

The following topics provide a basic understanding of formulas:

■ Understanding Formula Setup

■ Requirements

■ Solutions

■ Entering Item Technical Data

■ Using the Spreadsheet

■ Setting Up Formula Information

■ Using Formula Phantoms

■ Scaling Formulas

■ Defining and Maintaining Formulas

■ Finding a Formula

■ Displaying the Formula Summary

■ Displaying the Formula Header Summary

■ Entering Formula Details
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■ Displaying the Formula Product Summary

■ Displaying the Formula Byproduct Summary

■ Displaying the Formula Ingredient Summary

■ Displaying a Summary of Formula Product Lines

■ Editing Formula Product Lines

■ Editing a Formula Product Line

■ Displaying a Summary of Formula Byproduct Lines

■ Editing Formula Byproduct Lines

■ Editing a Formula Byproduct Line

■ Displaying a Summary of Formula Ingredient Lines

■ Editing Formula Ingredient Lines

■ Editing a Formula Ingredient Line

■ Running the Indented Bill of Materials Report

■ Using Formula Inquiry

■ Interpreting a Formula Inquiry

■ Analyzing a Formula

■ Displaying Formula Analysis Results

■ Finding a Formula Analysis

■ Overriding Default Explosion Rules
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Understanding Formula Setup
This topic explains how to define the formulas that drive your manufacturing 
process. Formulas are lists of ingredients and products with their associated 
quantities and processing instructions. In some cases, you can refer to a formula as a 
process manufacturing bill of material. Production batches are based on formulas 
defined in Product Development. Formulas are also used for planning, managing 
costs, and scheduling.

Formulas are depicted hierarchically in the following diagram that shows the:

■ Routing composed of a series of Operations organized in Steps.

■ Operations composed of Activities containing Resources.

■ Formula composed of Ingredient, Product, and possibly Byproduct.

■ Recipe linking the Routing and Formula together with Processing Instructions.
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Requirements
Following are some requirements that customers have for formulas in Product 
Development. The answers are explained in detail in the Solutions topic.

Can multiple versions of a single product formula be managed at the 
same time?
Yes. Depending on how version control is implemented, a version number can be 
assigned to multiple versions of a single product formula.

Can the formula approval process be managed efficiently?
Yes. Use the formula Status field to manage formula approvals quickly and 
efficiently. By activating the Status Approval Workflow the application manages 
each step of the approval process with a minimal requirement for intervention.

Is there multilingual support for formulas?
Yes. Use Description and Comments fields to enter translations for each of the 
installed languages.

Can both standard and packaging formulas be created?
Yes. Use the Formula Details window to create both standard and packaging 
formulas. The window has a Packaging check box that identifies a formula as a 
packaging formula.

Can formulas from third party applications be imported into the Product 
Development application?
Yes. Use Formula APIs to create new formula headers and details from applications 
not produced by Oracle. For existing Oracle applications migration scripts are 
supplied.

Can formulas be modeled and created based on the technical properties 
of its components?
Yes. Using Computer Aided Formulation, you can model and create formulas based 
on any number of characteristics associated with ingredients. 
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Can a laboratory be set up for many product lines with different 
technical characteristics?
Yes. Use technical parameters that are specific to an organization to set up 
individual product lines with differing technical characteristics.

Is it possible to predict the characteristics of a product based on 
ingredient composition?
Yes. Use the Spreadsheet to model new formulas and predict formula composition 
based on individual components added.

Is it possible to model catalysts and starter cultures, or any other item 
that does not change batch size?
Yes. Formula ingredients can be scaled using rules that specify whether or not an 
ingredient contributes to yield.

Can Standard Operating Procedures be linked to a specific process or 
ingredient?
Yes. Complete process instructions can be linked using text insertions and 
comments at various stages of the formulation process.
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Solutions
Product Development provides solutions to help resolve issues at every stage of the 
product development process. The following represent some of the key 
performance solutions for formulas.

Manage Multiple Versions of a Single Product Formula   If Version Control is on, a change 
to any component of a formula requires a new formula to be created consisting of 
the same formula name with a different version number. This is not required for 
status changes, Mark for Purge, or Undelete operations. If Version Control is off, 
any change to a formula can be made without requiring a new version. Copy a 
formula to a new version without the need to reenter information. Version Control 
is only active when a formula is Approved for General Use. Version Control helps 
manage multiple versions of a single product formula.

Let Formula Status Indicate Formula Approval  Use the Status field in each formula to 
determine where the formula is in an approval cycle. Activate the Status Approval 
Workflow to control the approval process. Workflow presents each Approver with 
an electronic notification so that action can be taken immediately. This expedites the 
overall approval process.

Use the Description and Comments Text Fields for Multilingual Support for Formulas  Two 
descriptive text fields in the header of a formula allow entry of a formula 
Description and Comments for each of the installed languages. Text is displayed in 
the session specific language.

Use the Formula Details Window to Create Both Standard Formulas and Packaging Formulas  
The Formula Details window allows entry of the formula header and all its 
products, ingredients, and byproducts. To set up a packaging formula, enter the 
packaged item itself as product. Then enter the bulk item, packaging container, and 
package label as ingredients.

Bridge Collaborative Environments with Formula APIs  To bridge collaborative 
formulation environments, an integrated set of Applications Programming 
Interfaces (APIs) such as legacy systems, spreadsheets, or third party systems. 
These Formula APIs create, reconcile or update formulas, their components, and 
their validity rules.

Use Computer Aided Formulation to Model and Create Formulas  Process manufacturing 
industries produce products made up of chemical and physical properties that can 
be predicted using algorithms. With the correct algorithms, you can alter the 
3-6 Oracle Process Manufacturing Product Development User’s Guide



Solutions
amount of one or more raw materials and the application calculates the ultimate 
effect on the product. Alternately, by selecting target finished good properties such 
as a prescribed value for Volatile Organic Compound (VOC), or a desired cost, the 
quantities of raw materials in a formula can be altered to produce the target product 
values. The availability of modeling features in an environment that is separate 
from the working formula allows formulators to simulate changes without affecting 
current production.

Define Technical Parameters for Rapid Calculations  Product Development allows setup of 
technical parameters as quality control tests with character, numeric, list of values, 
Boolean, or weight percent formats. This can be done on an organization specific 
basis or globally across all organizations. A technical parameter can be defined as 
percent solvent with each ingredient in a formula contributing a different portion of 
its weight to the product as solvent. Product Development finds the weight of 
solvent contributed by each individual ingredient, the sum of these contributions, 
and after determining the total formula weight, it calculates the ratio of percent 
solvent for each product. The application enables technical parameters to be defined 
in the appropriate units, and allows specification of the minimum and maximum 
number of significant figures to display. After establishing a formula for laboratory 
use, and entering its technical data for all appropriate ingredients, the application 
displays technical parameters within the laboratory formula to see how to roll it up 
into a recipe. It also enables use of experimental items for evaluation or testing 
purposes, and the recording of all information and text as detailed notes or 
comments.

Simulate Formulas and Analyze Their Components  The spreadsheet calculates product 
technical parameters automatically, and enables simulation of the quantity and 
technical parameter values for all formula components. Formulators can rearrange 
and adjust quantities of the ingredients and byproducts. The spreadsheet provides 
the ability to save formula variations as possible new products. This flexibility 
enables testing of different scenarios during reformulation and provides a rapid 
evaluation of the results.

Provide Comprehensive Formula and Ingredient Scalability  Product Development delivers 
full manufacturing scalability. The amounts of material produced or used by a 
formula can be scaled using methods that fix or vary each ingredient. Scalability 
provides production cycle flexibility and virtually eliminates the need to recalculate 
ingredient amounts manually.

Deliver Complete Formula Process Instructions  Product Development enables 
formulators and process engineers to link new product formulation instructions to 
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production management for use in the manufacturing process. This eliminates the 
need to transfer information manually. It improves product quality and consistency. 
Instructions are defined in one or more languages at various levels of the 
organization to meet quality requirements. This information supports compliance to 
ISO 9000.
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Entering Item Technical Data
Once you have specified a sequence for technical parameters, you are ready to enter 
the technical parameter data. The data represent technical parameter values for 
your items.

Prerequisites
❏ Set up technical parameters.

❏ Set up technical parameter sequences.

In most cases use Weight Percent, Volume Percent, Specific Gravity, Cost, 
Equivalent Weight, and Quantity per Unit for items that are raw materials or 
byproducts.

Specifying the Set of Technical Parameters to Use
When you enter an item that is a product of one or more laboratory formulas, 
specify the appropriate formula containing the Item Technical Data. Since the item 
is a product in formulas, its technical parameter values are calculated from specific 
formulas. Calculated values can be different in each formula.

For example, suppose your company can make orange juice using either of two 
valid formulas. Each formula uses a different orange juice concentrate. If you use 
orange juice to make an orange drink, verify that the technical parameter values are 
selected for the formula you decide to use, since calculated technical parameter 
values can be different in each formula.

Entering Density for Raw Materials
The application uses the DENSITY technical parameter for unit of measure 
conversions. Enter values for this technical parameter for all your raw materials. A 
density value must be entered for items, and each lot and sublot of an item.

If you get a unit of measure conversion error on the spreadsheet, check that you 
entered density information for all of your raw materials.

Density values must be entered as a ratio between the base unit of measure for the 
mass unit of measure type and the base unit of measure for the volume unit of 
measure type.

The base unit of measure for each UOM type is the first unit of measure set up for 
that UOM type. For example, if the base unit of measure for mass is kilograms and 
the base unit of measure for volume is liters, enter the density in kilograms per liter 
rather than pounds per gallon.
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You can determine the units of measure that are the base units for mass and volume 
by entering an item specific UOM conversion between mass and volume on the 
Item Lot/Sublot Std Conversion window in the Inventory Control application. The 
units displayed beneath the word Conversion are the base units that are used for 
mass and volume.

◗◗ To enter item technical data:
Calculated values for a product are not saved to the Item Technical Data table until 
you recall the formula on the Spreadsheet window and update technical parameters 
from the Actions menu. If that product is an ingredient in other formulas, then 
values are not visible or available for use in other formulas.

If you need to enter Item Technical Data for products, be aware that if you 
recalculate those technical parameter values on the spreadsheet and update 
technical parameters from the Actions menu, the data that you entered on the Item 
Technical Data window is overwritten.

Item Technical Data associates Technical Parameters at the item, formula, lot, and 
sublot levels. Item Technical Data also associates technical parameters with batches.

◗◗ To define technical data for items:
1. Navigate to the Item Technical Data window.

2. Enter the Organization where you are defining item technical parameter data. 
The Organization Description displays. You can enter data only for the 
technical parameters associated with this organization. Required. 

3. Enter the Item code you are entering technical parameter data for. Required.

4. If you are entering technical parameter data for a specific lot, enter the Lot code.

5. If you are entering technical parameter data for a specific sublot, enter the 
Sublot code.

6. Unit of Measure displays the unit of measure for the item. You cannot edit this 
field.

7. Enter the Formula. This field only displays if the item is a product in a formula.

8. Enter the Version number of the formula. This field only displays if the item is 
a product in a formula.

9. Enter the Plant associated to the technical parameters.

10. Enter the Batch associated to the technical parameters. 
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Details
11. The name of each technical Parameter defined for the laboratory organization 

displays. You cannot edit these fields.

12. Enter the Value for each technical parameter. You cannot enter or edit this field 
if the technical parameter value is calculated by the application.

For example, you cannot enter or edit this field if the Value is an Expression or 
if it is derived from a quality test.

The value you enter must satisfy the validation parameters displayed at the 
bottom of the window if entering a numeric value. Otherwise, the value must 
be in the LOV if the Validation List method is selected as the Data Type.

13. Displays the Unit of measure for the technical parameter. Specific gravity and 
equivalent weight use the units of measure set up on the Unit of Measure 
window in the OPM System Administration application. All other technical 
parameters use the units of measure set up on the Units window in the OPM 
Quality Management application. With the exception of equivalent weight, this 
unit of measure is not used in any calculations.

14. The Quality Control check box displays:

■ If the check box is selected, then the Value for a technical parameter comes 
from an OPM Quality Management test.

■ If the check box is cleared, then the Value for a technical parameter does not 
come from an OPM Quality Management test.

15. The Data Type displays. You cannot edit this field.

16. If Calculate is selected, then the value for a technical parameter is calculated by 
the application. If Calculate is cleared, then the value for a technical parameter 
is not calculated by the application.

17. The selected technical parameter Range displays.

18. The number of Significant Digits for the Value displays.

19. Save the window.
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Using the Spreadsheet
The Spreadsheet window displays each ingredient, product, and byproduct in a 
formula with the quantity and technical parameter values for each. The spreadsheet 
lets you manage ingredients and byproducts, and the quantities and technical 
parameter values for each ingredient and byproduct. Technical parameter values for 
the product are only calculated for the first product in a formula. When working 
with a formula in the spreadsheet, you can select ingredients by item; item and lot; 
item, lot, and sublot. When selecting a specific lot or sublot, the item technical 
parameters for the selected lot and sublot are loaded into the spreadsheet.

Use the spreadsheet to display and edit formulas and the technical parameter 
values of the items in the formula, and to display the effects that changes to 
ingredient values have on the product values.

Navigating in the Laboratory Spreadsheet
The header block in the Spreadsheet window is query only. You can query for a 
formula, batch, or a saved spreadsheet using the query enter mode or through 
query find. Once the header is called, the corresponding details are populated.

In the Details region, you can add new records or delete existing records. You can 
expand the material lines to view all the associated lots and their corresponding 
values.

You can display each region with its appropriate information:

■ Products displays the Item and lot, Quantity, Unit of Measure, Grade, 
Secondary Quantity, Expiry Date, and Days Remaining for each product. 
Technical parameters are displayed to the right of each product.

■ Byproducts displays the Item, Quantity, and Unit of Measure for each 
byproduct. Technical parameters are displayed to the right of each byproduct.

You can work with item technical data for the ingredient lots by loading a batch into 
the spreadsheet. You can predict the properties of a specific batch based on the exact 
lot properties and quantities of the ingredients making up the batch.

Updating a Batch
You can work with all of the item technical parameters for the ingredient lots by 
loading a batch into the spreadsheet. If a batch has batch step associations, then the 
ingredient items display in the Details region of the spreadsheet. If there are no 
batch steps, then the ingredient items sort according to their order on the formula. 
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Like formulas, quantities can be adjusted until you are satisfied with the results. If 
you decide that the allocation and ingredient changes can be used to update the 
batch, then the Update Batch option is available for pending batches. Using Process 
Execution APIs, the spreadsheet updates the batch. If e-records and e-signatures are 
enabled for the allocations, then standard signature windows display requesting the 
user signature.

Updates are allowed for pending batches only. You can also update a batch from a 
saved spreadsheet.

◗◗ To update a batch:
1. Navigate to the Spreadsheet window.

2. Choose Update Batch from the Actions menu.

3. Update the batch.

Updating Formulas
Making changes to a formula on the spreadsheet does not change that formula as it 
is stored in the database. If you make changes to the items or the item quantities on 
the spreadsheet, and later retrieve the formula on the Formula Details window, then 
you do not see the changes you made. This is true even if you saved the 
spreadsheet. This prevents you from accidentally making permanent changes to a 
laboratory formula based on scenarios you investigate on the spreadsheet.

The intermediate formula is selected with a defined hierarchy to obtain the proper 
formula for intermediates. Spreadsheet business rules use the following hierarchy: 

■ If a technical formula is at the ingredient level, then it is used to get the 
appropriate technical parameter value.

■ If a technical formula is not at the ingredient level, but a validity rule with a 
Status of Approved for Laboratory Use is defined for the ingredient, then the 
formula entered at the validity rule is used to get the appropriate technical 
parameter value.

■ If a validity rule with a Status of Approved for General Use is defined for the 
ingredient, then it is used to get the technical parameter value. Item technical 
parameter values defined at the item level for the intermediate are used.

◗◗ To edit formulas on a spreadsheet:
1. Navigate to the Spreadsheet window. The first set of Technical Parameters 

displays.
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2. Enter the Formula code to calculate on the spreadsheet.

3. Enter the Formula Version to calculate on the spreadsheet. A Description of 
formula and version displays. The Description field allows multilingual entries.

4. The current Organization displays. You cannot edit this field.

5. The first set of technical parameters display. You can change values on the 
spreadsheet.

6. Click Recalculate to recalculate the values displayed on the spreadsheet. The 
current Organization displays. You cannot edit this field.

Details
7. The following fields are display only:

■ Type code displays for each ingredient or byproduct. You can add, change, 
or delete these values. The item values initially display. Click the + that 
precedes the rollup indicator to display the item and lot, or item, lot, and 
sublot parameter values if they exist.

■ Item/Lot displays for each ingredient or byproduct. You can add, change, or 
delete these values.

■ Quantity displays for each item. You can edit these quantities.

■ UOM for the quantity displays. You can edit the unit of measure.

■ Grade displays. You can select a grade from a list of values.

■ Description of the ingredient displays on the selected line.

■ Secondary Qty displays the quantity when the item is dual unit of measure 
controlled.

■ UOM displays the secondary unit of measure.

■ Expiry Date displays the expiration date of the item.

■ Days Remaining displays the days remaining before this item expires.

■ Age calculates the age of the lot.

■ Step of batch displays.

Columns labeled with names for each technical parameter display. The value of 
each technical parameter for each item displays.
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8. If you change the technical parameter values for ingredients, then click 
Recalculate to assess the effect on each of the listed ingredient technical 
parameters.

9. An Expression used to calculate the technical parameter value displays.

◗◗ To set the Rollup Indicator
Rollup Ind, the rollup indicator, lets you select the material lines to use for 
performing product rollup calculations. You can include or exclude a calculation, or 
expand using + to select a value from the item lot, or lot and sublot. The following 
validations are performed:

■ If the ingredient and byproduct line is selected for rollup, then all of the lot and 
sublot lines under the selected material line are not selected.

■ If a specific lot and sublot line is selected for rollup, then the material line box of 
the lot and sublot is not selected.

To disable all rollup indicators and select only those that you wish to use for the 
spreadsheet, select Clear All from the Actions menu.

◗◗ To list experimental items:
Choose List Experimental Items from the Actions menu.

Adding a Lot and Sublot
Add additional lot and sublot information to the existing lots that display on the 
spreadsheet. If you add lot or sublot information in the Add Lot/Sublot window, 
then you must first define lot or lot; sublot values in OPM Inventory and assign 
technical parameters.

1. Navigate to the Spreadsheet window and open a spreadsheet.

2. Choose Add Lot/Sublot from the Actions menu.

3. Enter a Lot code from the list of values. Required.

4. Enter a Sublot from the list of values.

5. Enter the allocation Quantity. Required.

6. Click OK.
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Adding Lot and Sublot from a Batch
When a spreadsheet is loaded from a batch, new lots can be added to the existing 
displayed lots on the spreadsheet by accessing the Add Lots option from the 
Actions menu. 

1. Navigate to the Spreadsheet window.

2. Choose Add Lot/Sublot from the Actions menu.

3. Enter a Lot code. Required.

4. Enter a Sublot code.

5. Enter a Warehouse. Required.

6. Enter a valid Location. Required only if the warehouse and item are location 
controlled.

7. Enter the Allocated Qty. Required.

8. Enter a Secondary Qty. 

9. Click OK.

Saving a Spreadsheet
Save spreadsheets that you can use for comparison purposes.

◗◗ To save a spreadsheet:
1. Choose Save Spreadsheet from the Actions menu.

2. Enter a Name for the spreadsheet to save.

3. Click OK.

Opening the Spreadsheet
You can open the data on the spreadsheet using the query find option available on 
the Spreadsheet window.

◗◗ To open a spreadsheet:
1. Select Find from the View menu.

2. Enter a Name for the spreadsheet to retrieve.

3. Click OK.
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Displaying All Parameters
Use the drill-down on the spreadsheet to view all technical parameters for a 
particular material line. You can also view the technical parameters contributing to 
the product value by clicking on the drill-down indicator. This is a query only 
window and displays all material lines and corresponding technical parameters that 
contributed to the product rollup value.

Displaying Calculation Errors
Display calculation errors for a product, ingredient, or byproduct. 

◗◗ To display calculation errors:
1. Navigate to the Spreadsheet window.

2. Choose Calculation Errors from the Actions menu.

3. Select one of the following:

■ Product to display product calculation errors.

■ Ingredient to display ingredient calculation errors.

■ By-product to display byproduct calculation errors.

4. The following fields are display only:

■ Type determines whether the error displayed is for the product, ingredient, 
or byproduct.

■ Item/Lot determines whether the technical parameter calculation error is 
for a product, ingredient, or byproduct.

■ Technical Parameter displays the code of the technical parameter where an 
error occurred.

■ Error Message determines a description for the calculation error.

■ Expression determines the location where the error occurred. A carat (^) 
points to the approximate location where the error occurred.

5. Click OK.

◗◗ To update a formula:
You can use the Update Formula command if you want the formula changes you 
make on the spreadsheet to be saved to the formula in the database.
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1. Begin with the appropriate changes displayed on the spreadsheet.

2. Choose Update Formula from the Actions menu.

3. Save the spreadsheet.

◗◗ To update technical parameters:
You can use the Update Technical Parameters command if you want the formula 
changes you make on the spreadsheet to be saved to the formula in the database.

1. Begin with the appropriate changes displayed on the spreadsheet.

2. Choose Update Technical Parameters from the Actions menu.

3. Save the spreadsheet.

◗◗ To interpret spreadsheet calculation errors:
For technical parameters that are calculated from expressions, the Spreadsheet 
displays a string of question marks (?) or asterisks (*) if the application cannot 
calculate a value.

A string of question marks indicates that a compilation error occurred For example, 
the value of a variable used in the expression could not be found, or the syntax of 
the expression is incorrect.

A string of asterisks indicates that the expression could not be calculated for 
mathematical reasons. For example, division by zero. To display additional 
information, select Calculation Errors from the Actions menu.
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Setting Up Formula Information

Setting Up Header Information
To create a new formula, enter formula header information including formula 
name, version, and product on the Formula Details window. Formula header 
information is that information that applies to the entire formula. The Formula 
Header Summary window lists all formula header information entered.

Setting Up Product and Coproduct Information
Use the Formula Product Lines window to enter each product or coproduct 
component. For example, skim milk is a coproduct in the production of cream.

Setting Up Ingredient Information
Use the Formula Ingredient Lines window to enter each ingredient component.

Setting Up Byproduct Information
If skim milk were further processed into a fat free cottage cheese product, you could 
consider the liquid whey as a byproduct. You do not plan for byproducts, but they 
must be accounted for in the formula.

If the formula produces byproducts, enter these byproducts and their respective 
quantities on the Formula Details window. Byproducts, like products and 
coproducts, are items produced by a formula. They differ from products in that you 
do not plan your production to make byproducts. For example, in the production of 
applesauce you produce apple peels. These peels are not something you plan to 
manufacture as a product. You would never schedule a batch in order to produce 
apple peels. Depending on the facility, however, these peels can have no monetary 
value and can require disposal, or they can be sold as raw material for apple cider 
vinegar. In either case, enter apple peels as a byproduct of your applesauce formula.

OPM does not calculate the cost of production of byproducts. Any items produced 
by formulas that you want to calculate costs for must be entered as products. They 
must not be entered as byproducts.

Set up the byproduct type as:

■ Rework if the material generated requires rework.

■ Sample if the material generated is used as a sample for quality inspection. 
Refer to the Oracle Process Manufacturing Quality Management User’s Guide for 
more information quality inspection.
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■ Waste if the material is a waste product.

■ Yield if the byproduct is material that is yielded for use in another process.

Adding Text to a Formula
Add text to a formula by selecting Edit Text from the Actions menu. You can do this 
at the header or line level. Text that is associated with a formula is copied to batches 
that are based on the formula if the GME: Copy Formula Text profile option is set to 
1.

See Also
Oracle Process Manufacturing System Administration User’s Guide
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Using Formula Phantoms
Phantoms are intermediate formulas that are not manufactured as products. Since 
phantoms are intermediates, they are sometimes referred to as transient 
subassemblies.

You enter phantoms as formula ingredients, and then explode them when you enter 
batch tickets. Phantom functionality is a fixed method of multibatch management. 
Once several batches are linked by a production order number and phantom type 
dependency, you can manage them as a single production event. There are two 
fundamental tasks associated with using phantoms:

■ Identify one or more ingredients in a formula as phantoms. Use the Phantom 
Type field to indicate that an item is a phantom.

■ Build a formula for each phantom. The method for building a formula that 
generates a phantom is the same method used to build a formula for a regular 
batch. However, the formula ingredient must be defined as a phantom.

There are two types of phantoms:

■ Automatic Generation type creates phantom batches automatically. When you 
use this function with automatic document numbering, the application 
automatically creates a dependent phantom batch, and then generates a 
production identification number to associate all related batches.

■ Manual Generation type requires manual intervention to create phantom 
batches. When you use manual generation, you need to explode each phantom 
ingredient by selecting the Phantom. When you release a production batch that 
has phantoms in its formula, a message displays to indicate that the phantom 
has not been exploded. This advice is given for one of two reasons:

■ It is a manual phantom that you need to explode.

■ There is some problem with the phantom.

Phantoms You Make
You use a basic bread dough for a number of kinds of bread. You do not sell it or 
keep it in inventory, however you need to track its ingredients. Your formulas for 
bread contain #BASICBREAD plus whatever other ingredients are needed to turn 
plain white bread into other kinds of bread such as rye, whole wheat, and 
pumpernickel.

In this case, you need only one version of the #BASICBREAD formula.
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Phantoms You Never Actually Make
You make a number of products that use apples. Each product has a different 
formula, but all of them use apples. And, there are many varieties of apples. Flavor, 
texture, and sugar content vary significantly among these apple varieties. Price and 
availability can vary depending on season or other factors. Therefore, you decide to 
use an intermediate called #APPLEBLEND that is made up of two or more apple 
varieties. You do not actually make #APPLEBLEND. However, you use its 
ingredients in a batch.
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Scaling Formulas
You can scale formulas up or down by input or by output:

■ If the formula input ingredients are scaled, a specific scaling factor is applied to 
all scalable ingredients. A calculated output scale factor is applied to all scalable 
outputs.

■ If the formula outputs are scaled, a factor is applied to all scalable outputs. A 
calculated input scale factor is applied to all scalable ingredients.

In order for this approach to be successful, you need to specify whether the 
quantities of each item in the formula are fixed or scalable.

Proportional scaling is the least complex scaling type since the given and calculated 
factors are applied appropriately to the scalable item inputs or outputs. In order to 
scale formulas properly, specify whether the ingredients need to be increased using 
fixed or proportional scaling.

Scale Type Definitions
The quantities of items which are fixed scale are not altered when a formula is 
scaled. For example, if a formula has a fixed scale ingredient with a quantity of 10 
kg and the formula is scaled by a factor of two, then the quantity remains fixed at 10 
kg.

Items that are proportionally scaled have their quantities changed when a formula 
is scaled up or down. With proportional scaling, the scaling is continuous in that the 
scaled quantities can contain decimals. Proportionally scaled items may or may not 
contribute to yield.

While proportional scaling makes sense for many items in process industries, it 
does not make sense for all items.

The following lists the types of formula scaling available in Product Development: 

■ Type 0 is Fixed scaling.

■ Type 1 is Proportional scaling.

■ Type 2 is Integer scaling.

The following lists the Contribute to Yield types available in Product Development:

■ Yes indicates that an ingredient contributes to yield.

■ No indicates that an ingredient does not contribute to yield.
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Understanding Scale Type Rules
The following summarizes the business rules in effect for scale types:

■ The Contribute to Yield type for ingredients can be set to Yes or No.

■ Products and byproducts cannot have an Integer scale type.

■ Ingredients are assigned a scale type of Fixed, Proportional, or Integer.

■ If an ingredient is assigned a scale type of Integer, then it must also be 
assigned a:

– Scale Multiple, to specify the multiple in which the ingredient can be used 
in a formula. For example, a Scale Multiple of 30 indicates the ingredient is 
used in quantities of 30, 60, or 90, and so forth.

– Rounding Direction, to specify whether the quantity of material must be 
rounded up to the next higher scale multiple of material, down to the next 
lowest scale multiple of material, or if the material can be rounded up or 
down. If the material can be rounded up or down, then it is rounded to the 
nearest multiple.

Fixed Scale
To scale a formula with fixed scale items, the application must convert the 
quantities of ingredients, products, and byproducts to a common unit of measure. 
The unit of measure used for this calculation is the base unit of measure specified 
by the GMD: Yield Type profile option. This is usually mass. All items in the 
formula that contribute to yield must be convertible to this unit of measure. 

If the formula contains fixed quantity ingredients that contribute to yield, then the 
scalable ingredients are scaled by an amount necessary to produce the new product 
quantity, not by the percent entered as the scale factor. If all products are set to fixed 
quantity, then no quantities in the formula are changed.

Fixed Scale With Yield Contribution The quantities of items for this scale type are 
not altered when a formula or batch step is scaled. If a formula has a fixed scale 
ingredient with a quantity of 2000 kg and the formula output is scaled by a factor of 
2, then the quantity remains fixed at 2000 kg.

These quantities are taken into account when calculating the factor to apply to the 
scalable ingredients so that the yield ratio is preserved. In the example that follows, 
the ratio is 115:120 before scaling and 230:240 after scaling the output by a factor of 
2.
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Fixed Scale Without Yield Contribution The quantities of items for this scale type 
are also not altered when a formula is scaled. This is the same as the previous 
example, however the item quantities are not considered when scaling the 
remaining ingredients. These quantities have no effect on scaling at all. For 
example, in the following, formula Ingredient C is fixed scale without yield 
contribution. If the product is scaled by a factor of 2, then the quantities after scaling 
appear as if ingredient C were not included.

See: Oracle Process Manufacturing Inventory Management User’s Guide

Item Formula Quantity Quantity After Scaling

Product A 11500 kg 23000 kg

Ingredient A, Proportional Scaling 5000 kg 11000 kg

Ingredient B, Proportional Scaling 5000 kg 11000 kg

Ingredient C, Fixed and Contributing 2000 kg 2000 kg

Item Formula Quantity Quantity After Scaling

Product A 10000 kg 20000 kg

Ingredient A, Proportional Scaling 5000 kg 10000 kg

Ingredient B, Proportional Scaling 5000 kg 10000 kg

Ingredient C, Fixed and Noncontributing 2000 kg 2000 kg
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Proportional Scale
If the formula contains proportionally scalable ingredients, then the scalable 
ingredients are increased in a direct ratio to produce the new product quantity. In 
the following example, Product A is proportionally scaled from 10000 kg to 20000 
kg.

With proportional scaling, Ingredient A and Ingredient B are multiplied by a factor 
of 2.

Examples of Single and Mixed Scale Types
The following discussion compares different scale types:

Single Type Scaling If a formula consists solely of proportionally scalable items, 
then scaling the output or the input scales everything in the same ratio. It is also 
possible to construct a formula from items that are all fixed scale. This formula is 
ineligible for scaling.

Mixed Type Scaling: Fixed and Proportional With Yield Contribution If a formula 
contains both fixed and proportionally scaled items, then the factor applied to the 
scalable quantities is not the same as the overall scaling factor. Consider a formula 
that yields 3000 kg of scalable product by converting 1000 kg of fixed scale 
Ingredient 1 and 2000 kg of scalable Ingredient 2. If the product is scaled by a factor 
of 2 to produce 6000 kg, then 5000 kg of Ingredient 2 is required, not 4000 kg. The 
factor applied to the Ingredient 2 quantity is therefore 2.5 rather than 2. If the inputs 
are scaled by a factor of 2, then the output is 5000 kg, or 2 times 2000 kg of 
Ingredient 2 plus 1000 kg of Ingredient 1. The yield of the product is scaled by a 
factor of 1.667 rather than by a factor of 2, as shown in the following:

Item Formula Quantity Quantity After Scaling

Product A 10000 kg 20000 kg

Ingredient A, Proportional Scaling 5000 kg 10000 kg

Ingredient B, Proportional Scaling 5000 kg 10000 kg

Item Formula Quantity Quantity After Scaling

Product B 3000 kg 6000 kg

Ingredient 1 Fixed and Contributing 1000 kg 1000 kg

Ingredient 2 Proportional Scaling 2000 kg 5000 kg
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Mixed Type Scaling: Proportional With Yield Contribution and Fixed Without Yield 
Contribution If the fixed quantity of an ingredient has no effect on yield, then the 
yield contribution field must indicate this. When a fixed quantity item that does not 
contribute to yield is encountered by the scaling algorithms, the item quantity is not 
scaled, and is ignored when deriving the scale factor to apply to the remaining 
items. The formula is treated as consisting only of the remaining items.

If a formula is scaled so that 2000 kg of scalable product is made by converting 2000 
kg of scalable Ingredient 1 in the presence of 1000 kg of fixed scale Ingredient 2 that 
does not contribute to the yield, then the output doubles. Scaling the inputs by a 
factor of 2 doubles the output quantity, since the fixed scale ingredient quantity is 
not to be changed. It does not matter if 100 kg of Ingredient 2 is used. The same is 
true when outputs are scaled.

Understanding Integer Scaling
Some material in process industries is picked from inventory in eaches, such as a 30 
pound bag of defoamant or a box of antistatic sheets. If an item is issued in 30 
pound bags, then it is supplied in full bags and managed on the production floor 
appropriately. If the UOM used in the formula is the bag, then you must scale in 
whole integer increments. If you want to express the ingredient in pounds, then 
integer scaling is not sufficient. You need a way to specify that the ingredient must 
only be scaled in multiples of 30 pounds.

When materials are scaled by a multiple, a scaling direction value must be specified 
so that the scaled quantity is rounded properly. Scaling by a multiple results in 
ingredients being rounded up or down to the next whole multiple specified for the 
item in the formula. It is possible that the formula ingredient is not scaled as a result 
of not meeting the criteria to round up or down. Rounding Variance is not required 
for integer scaling.

Examples of Integer Scaling
When the Integer scale type is selected, specify the Scale Multiple, Rounding 
Variance, and Rounding Direction. In the following example, Product C is scaled up 
by 60 percent.

Item Formula Quantity Quantity After Scaling

Product C 2000 kg 4000 kg

Ingredient 1 Proportional Scaling 2000 kg 4000 kg

Ingredient 2 Fixed and Noncontributing 1000 kg 1000 kg
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Simple Integer Scaling The following is a simple example of using the Integer 
scale type with directional rounding:

Ingredient 2 has a Formula Quantity of 1 pallet with the following specifications:

■ Scale Multiple = 1

■ Rounding Variance = 100 percent

■ Rounding Direction = Either

Since it is not possible to use 2.5 pallets, the Integer scale type rounds the 
requirement up to 3 pallets.

Complex Integer Scaling The following example is a more complex example of 
using the Integer scale type with directional rounding:

Ingredient 2 has a Formula Quantity of 25 kg with the following specifications:

■ Scale Multiple = 25 kg

■ Rounding Variance = 30 percent of the Formula Quantity After Scaling. This is 
0.3 of 40 kg, or up to 12 kg

■ Rounding Direction = Down

The decision is whether to use 25 kg or 50 kg of material to produce Product C, 
since Ingredient 3 is only dispensed in multiples of 25 kg. The differences between 
the required Formula Quantity and the Integer is 10 kg for the Up Rounding 
Direction, and 15 kg for the Down Rounding Direction. The Down Rounding 
Direction is calculated as follows:

Item Formula Quantity Quantity After Scaling

Product Pkg1 1000 kg 2500 kg

Ingredient 1 Proportional Scaling 1000 kg 2500 kg

Ingredient 2 Integer 1 pallet 3 pallets

Item Formula Quantity Quantity After Scaling

Product C 2000 kg 3200 kg

Ingredient 1 Proportional Scaling 2000 kg 3200 kg

Ingredient 2 Integer 25 kg 40 kg
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■ Lower Scale Multiple - Quality After Scaling

= 25 - 40

= -15 kg for the Down Rounding Direction

Take the absolute value of any negative Rounding Direction. In this case the 
lower Rounding Direction has an absolute value of 15 kg.

The acceptable Rounding Variance is up to 12 kg. The Rounding Direction is Down, 
and the calculated absolute value for the down Rounding Direction is 15 kg, 
representing 3 kg more than the acceptable Rounding Variance. It is not acceptable 
to round down to 25 kg, so 40 kg of Ingredient 3 must be used in the formula.

If the Rounding Direction were Up, then it is acceptable to use 50 kg of Ingredient 3, 
since a 10 kg difference is less than the acceptable Rounding Variance of 12 kg. The 
Up Rounding Direction is calculated as follows:

■ Upper Scale Multiple - Quantity After Scaling

= 50 - 40

= 10 kg for the Up Rounding Direction.

Limitations for Repeated Scaling of an Integer Scaled Item
Scaling issues occur when an item with an Integer scale type is scaled more than 
once during the production cycle. Repeated scaling items by the integer scale type is 
a process production issue.

See: Oracle Process Manufacturing Process Execution User’s Guide

Disabling the Scaling of a Previously Scaled Formula
This advice applies to the Formula Details window.

If you clear Scaling Allowed so that scaling is not allowed on a formula, then the 
following message displays:

Unchecking 'Scaling Allowed' for this formula will change the scale type for all 
material lines to fixed. The minimum, maximum, and standard quantities for 
any existing validity rules will be changed to the product quantity in the 
formula.

Do you wish to Continue?

If you click OK, then the associated validity rule quantities are updated and 
disabled, and all material line scale types are set to Fixed. If validity rules exist with 
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a status of Pending, Frozen, or On Hold, then the formula cannot be updated, and 
an appropriate message displays:

Validity Rules exist which require update due to the change in this formula's 
scale type. However, they can not be updated because of their current status. 
Please update VR status in order to save this record.

If you do not continue after clearing Scaling Allowed, then the formula is set back to 
allow scaling, and all material detail line scale types remain unchanged and 
enabled.

Changing the Scale Type of a Product Line to the Fixed Scale Type
This advice applies to the following windows:

■ Formula Details

■ Formula Product Lines

■ Formula Product Line Edit

If you change the Scale Type of a product line to the Fixed scale type, then the 
following message displays:

The minimum, maximum, and standard quantities of any existing validity rules 
will be changed to the product quantity in the formula. Do you wish to 
continue?

If you click OK, then the associated validity rule quantities are updated and 
disabled, and all material line scale types are set to Fixed. If validity rules exist with 
a status of Pending, Frozen, or On Hold, then the formula cannot be updated, and 
an appropriate message displays:

Validity Rules exist which require update due to the change in this formula's 
scale type. However, they can not be updated because of their current status. 
Please update VR status in order to save this record.

This advice applies to the following windows:

■ Recipe Validity Rules

■ Recipe Organization Details

When you display these windows after an associated formula header had its scaling 
set to Fixed, then all quantities are disabled. If the associated formula header 
allowed scaling, but the product line did not, then the associated validity rules for 
that product are disabled.
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If you create a new record from any of these windows, and either the associated 
formula header or product record is set to fixed scaling, then the quantities are set 
equal to the product quantity and unit of measure of the formula. Quantities are 
disabled after entry if formula header or product are set to fixed scaling.
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Defining and Maintaining Formulas
Formulas are statements of ingredient requirements. A formula can include 
processing instructions and ingredient sequencing directions. The formula can also 
specify the quantities of each item.

Creating a New Formula
Create and define new formulas on the Formula Details window. Specify formula 
header information and each of the products, ingredients, and byproducts included 
in the formula. You can display the following windows from the Formula Details 
window:

■ Formula Product Lines

■ Formula Product Line Edit

■ Formula By-Product Lines

■ Formula Ingredient Lines

Maintaining Formulas at the Formula Header Level
Use the following windows to maintain formulas at the header level:

■ Formula Summary By... to display a list of defined formulas with their 
individual version numbers and descriptions. These can be displayed by Class, 
Status, Owner, Laboratory, Product, or Plant. You can display the Formula 
Details window from the Formula Summary By... window.

■ Formula Header Summary to display important descriptive information on a 
specific formula. You can display the following windows from the Formula 
Header Summary window:

■ Formula Details

■ Formula Product Lines

■ Formula By-Product Lines

■ Formula Ingredient Lines

■ Formula Product Summary to display a summary of all formula products. You 
can display the following windows from the Formula Product Summary 
window:

■ Formula Product Lines

■ Formula Product Line Edit
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■ Formula Product Lines to display individual formula product lines. You can 
display the Formula Product Line Edit window from the Formula Product Lines 
window.

■ Formula By-Product Summary to display a summary of all formula byproducts. 
You can display the following windows from the Formula By-Product 
Summary window:

■ Formula By-Product Lines

■ Formula By-Product Line Edit

■ Formula By-Product Lines to display individual formula byproduct lines. You 
can display the Formula By-Product Line Edit window from the Formula 
By-Product Lines window.

■ Formula Ingredient Summary to display a summary of all formula ingredients. 
You can display the following windows from the Formula Ingredient Summary 
window:

■ Formula Ingredient Lines

■ Formula Ingredient Line Edit

■ Formula Ingredient Lines to display individual formula ingredient lines. You 
can display the Formula Ingredient Line Edit window from the Formula 
Ingredient Lines window.
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The following graphic depicts the previously described formula navigation flow 
from the Formulas node and from the Products, By-Products and Ingredients nodes:

Maintaining Formulas at the Line Level

Use the following windows to maintain formulas at product, byproduct, and 
ingredient line level:

■ Formula Product Line Summary to display a summary of the individual 
formula product lines, with an item number and unit of measure associated 
with each line. You can display the Formula Product Line Edit from the 
Formula Product Line Summary window.

■ Formula Product Line Edit to edit individual lines in the Formula Product Line 
Summary.

■ Formula By-Product Line Summary to display a summary of the individual 
formula byproduct lines, with an item number and unit of measure associated 
with each line. You can display the Formula By-Product Line Edit window from 
the Formula By-Product Line Summary window:

■ Formula By-Product Line Edit to edit individual lines in the Formula 
By-Product Line Summary.
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■ Formula Ingredient Line Summary to display a summary of the individual 
formula ingredient lines, with an item number and unit of measure associated 
with each line. You can display the Formula Ingredient Line Edit window from 
the Formula Ingredient Line Summary window.

■ Formula Ingredient Line Edit to edit individual lines in the Formula Ingredient 
Line Summary.

The following graphic depicts the previously described formula navigation flow 
from an individual product node (PROD 1), byproduct node (BY-PROD1), and 
ingredient node (INGR1).

Creating a Packaging Formula
In addition to defining the way bulk items are produced, formulas can be used to 
define the way items are packaged. To set up a packaging formula, enter the 
packaged item itself as product. Then enter the bulk item, packaging container, and 
package label as ingredients.

Migrating Formulas from Another Application
Use the Oracle Process Manufacturing Formula API to migrate formulas to the 
current release.

See Also
Oracle Process Manufacturing Formula API User’s Guide
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Finding a Formula
The Find Formulas window enables you to find a specific formula. You can find 
formulas and display summary windows from the workbench.

Prerequisites
❏ Enter and save formulas.

◗◗ To find a formula:
1. Navigate to the Find Formulas window.

2. Enter as many parameters as needed to complete the search:

■ Enter search parameters in the Standard region for: Formula, Version, 
Description, Class, Product, or Ingredient.

■ Enter search parameters in the Advanced region to enter a specific: Item, 
Condition, or Value.

3. Click Find.

4. Review the results of the search.

5. Close the window.
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Displaying the Formula Summary
The Formula Summary window presents a list of formulas associated with the View 
By... option selected. The window displays individual versions and a brief 
description of the formula, and can be viewed by Class, Status, Owner, Laboratory, 
Product, or Plant.

You can use folders with this window. See: Oracle Applications User’s Guide.

Prerequisites
❏ Optionally, enter and save formula classes.

❏ Enter and save formulas.

❏ Use the View By list to select how you want to view the summary of formulas. 
Select one of the following:

■ Class to display the list by formula class.

■ Status to display the list by formula status.

■ Owner to display the list by formula owner.

■ Laboratory to display the list by laboratory.

■ Product to display the list by primary product.

■ Plant to display the list by plant.

◗◗ To display a list of all defined formulas:
1. Navigate to the Formula Summary By... window.

2. The following fields are display only:

■ Formula determines the code assigned to the formula.

■ Version determines the version of the Formula.

■ Description determines a brief explanation of the Formula.

■ Product determines the primary product associated with the Formula.

■ Quantity determines the amount of material associated with the Formula.

■ UOM determines the primary unit of measure for the material associated 
with the Formula.
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3. Click Details to display the Formula Details window.

4. Close the window.
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Displaying the Formula Header Summary
The Formula Header Summary window displays important descriptive header 
information on a specific formula.

You can use folders with this window. See: Oracle Applications User’s Guide.

Prerequisites
❏ Optionally, enter and save formula classes.

❏ Enter and save formulas.

◗◗ To display a summary of formula headers:
1. Navigate to the Formula Header Summary window.

2. Select the appropriate Formula.

3. The following fields are display only:

■ Status determines the status of the Formula.

■ Formula determines the code assigned to the formula.

■ Version determines the version of the Formula.

■ Description determines a brief explanation of the Formula.

■ Comments determines the remarks or notes entered for the Formula.

■ Class determines an optional classification assigned to the Formula.

■ Class Description determines an optional classification description 
assigned to the Formula.

■ Main Product determines the end item for the listed Formula.

■ Product Description displays a description Main Product.

■ Owner determines a code for the owner of the Formula.

■ Owner Name determines the complete name of the Owner of the Formula.

■ The Scaling Allowed check box indicates whether or not the Formula 
allows scaling. If the check box is selected, scaling is allowed. Refer to the 
"Scaling Formulas" topic for advice.

■ The Packaging Formula check box indicates whether or not the Formula is 
a packaging type. If the check box is selected, the Formula is a packaging 
formula.
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4. Click Products to display the Formula Product Line Summary window. Drill 
down to individual formula product lines on the Formula Product Line Edit 
window.

5. Click By-products to display the Formula By-Product Line Summary window. 
Drill down to individual formula byproduct lines on the Formula By-Product 
Line Edit window.

6. Click Ingredients to display the Formula Ingredient Line Summary window. 
Drill down to individual formula ingredient lines on the Formula:Ingredient 
Line Edit window.

7. Click Details to display the Formula Details window.

8. Close the window.
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Entering Formula Details
The Formula Details window lets you enter the details for a specific formula. When 
creating a new formula on the Formula Details window, the LOV for the Formula 
field enables you to select or query the product from the item master. When you 
select a product name to use as a formula name, the formula Description field has 
the item description entered automatically. The product UOM and product 
description continue to be entered automatically. For automatic product and 
description entry, you must select a valid item. If the item description changes 
subsequently, the formula description does not change. It must be updated 
manually. When you modify formula details, you cannot delete the last remaining 
product or ingredient in a formula.

eRecord and eSignature Approvals
There may be an eSignature event associated with this window. Refer to "Appendix 
D" for additional information on eRecord and eSignature approvals associated with 
this window.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Optionally, enter and save formula classes.

To enter formula details:
1. Navigate to the Formula Details window.

2. Enter the code for the Formula. Required.

3. Enter the Formula Version. Required.

4. After entering all relevant information and saving the Formula with the default 
Status of New, return to this window if you need to change Formula Status by 
selecting Change Status from the Actions menu. Depending on whether 
Workflow is enabled, a different set of statuses is available.

Select a Status for the Formula you are entering from one of the following:

■ Approved for Laboratory Use to indicate that the Formula is approved for 
laboratory use.

■ Approved for General Use to indicate that the Formula is approved for use 
in production.
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■ Obsolete/Archived to indicate that the Formula is no longer approved for 
use and is obsoleted, archived, or both.

If Workflow is enabled, when you select:

■ Approved for Laboratory Use, Status changes to Request Approval for 
Laboratory Use until all approvers have accepted the Formula, then its 
Status changes to Approved for Laboratory Use.

■ Approval for General Use, Status changes to Request Approval for 
General Use until all approvers have accepted the Formula, then its Status 
changes to Approved for General Use.

Refer to the Understanding the Status Approval Workflow topic for additional 
information.

5. Enter a Description that briefly explains the Formula. Required.

6. Enter Comments that need to accompany this Formula. For example, you could 
enter CUSTOM PROPRIETARY FORMULA. DO NOT COPY. This field also 
allows multilingual entries.

7. Enter a Class for the Formula to identify how it is categorized. The Class 
Description assigned to the Formula displays.

8. Organization displays the name of the organization responsible for the 
Formula. The Organization Description assigned to the organization displays.

9. Enter the Owner of the Formula. The Owner Description displays.

10. The Scaling Allowed check box indicates whether or not the Formula allows 
scaling.

■ Select the check box to indicate that scaling is allowed.

■ Clear the check box to indicate that scaling is not allowed.

Refer to the "Scaling Formulas" topic for advice.

11. The Packaging check box indicates whether or not the Formula is a packaging 
formula.

■ Select the check box to indicate that the Formula is a packaging formula.

■ Clear the check box to indicate that the Formula is not a packaging formula.

Products
12. The Line number for each product listed displays. These fields cannot be 

edited.
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13. Enter the Product code for each item produced by this Formula. If the formula 
code you entered is the same as an item code, then that item code is displayed 
as the default in this field. Required.

14. The Description of the Product entered displays. This defaults from the Item 
Master table.

15. Enter Quantity of the Product that this Formula yields. The quantity entered in 
this field is the default standard quantity used for the recipe. Required.

16. Enter the UOM for the Quantity entered. The inventory unit of measure for the 
item is the default. If you enter a different unit of measure, set up a unit of 
measure conversion between the default and the unit of measure you decide to 
enter. Conversions between units of measure of the same unit of measure type 
are defined when the unit of measure is defined in System Administration. 
Conversions between different unit of measure types must be defined for each 
item on the Item Lot/Sublot Standard Conversion window in Inventory 
Management. Required.

17. Select the Scale Type as:

■ Fixed if the product is not scalable.

■ Proportional if the product is scalable.

Required. Refer to the "Scaling Formulas" topic for advice.

18. Select the Yield Type to indicate the type of product yield as:

■ Automatic when products are yielded automatically when the batch is 
completed.

■ Manual when products are yielded manually.

■ Incremental when product yield is calculated by incremental backflushing.

■ Automatic by Step when products are yielded automatically as the step is 
completed.

Required.

19. Cost Allocation indicates how the cost of this item is allocated for financial 
rollup purposes.

20. Click Edit Line to display the Formula Product Line Edit window.

21. Click Products to display the Formula Product Lines window.

22. Click By-Products to display the Formula By-Product Lines window.
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23. Click Ingredients to display the Formula Ingredient Lines window.

By-Products
24. The Line number for each By-Product listed displays. This field cannot be 

edited.

25. Enter the By-Product code for each item produced by this Formula. If the 
formula code you entered is the same as an item code, then that item code 
displays as the default in this field. Required if you enter one or more formula 
byproducts. Required.

26. The Description of the By-Product entered displays. This defaults from the Item 
Master table.

27. Enter the Quantity of the By-Product that this Formula yields. The quantity 
entered in this field is the default standard quantity used for the recipe. It can 
be changed at the recipe level. Required if you enter one or more By-Products 
for the Formula. Required.

28. Enter the UOM for the Quantity entered. The inventory unit of measure for the 
Item is the default. If you enter a different unit of measure, set up a unit of 
measure conversion between the default and the unit of measure you decide to 
enter. Conversions between units of measure of the same unit of measure type 
(for example, both mass) are defined when the unit of measure is defined in 
System Administration. Conversions between different unit of measure types 
must be defined for each item on the Item Lot/Sublot Standard Conversion 
window in Inventory Management. Required if you enter one or more 
By-Products for the Formula. Required.

29. Select the Scale Type as:

■ Fixed if the byproduct is not scalable.

■ Proportional if the byproduct is scalable.

Required. Refer to the "Scaling Formulas" topic for advice.

30. Select the Yield Type to indicate the type of byproduct yield as:

■ Automatic when byproducts are yielded automatically when the batch is 
completed.

■ Manual when byproducts are yielded manually.

■ Incremental when byproduct yield is calculated by incremental 
backflushing.
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■ Automatic by Step when byproducts are yielded automatically as the step 
is completed.

Required.

31. Click Edit Line to display the Formula By-Product Line Edit window.

32. Click Products to display the Formula Product Lines window.

33. Click By-Products to display the Formula By-Product Lines window.

34. Click Ingredients to display the Formula Ingredient Lines window.

Ingredients
35. The Line number for each ingredient listed displays. This field cannot be 

edited.

36. Enter the Ingredient code for each item required by this Formula. Required.

37. The Description of the ingredient entered displays. This defaults from the Item 
Master table.

38. Enter Quantity of the ingredient that this Formula requires. The quantity 
entered in this field is the default standard quantity used for the recipe. It can 
be changed at the recipe level. Required.

39. Enter the UOM for the Quantity entered. The inventory unit of measure for the 
Item is the default. If you enter a different unit of measure, you set up a unit of 
measure conversion between the default and the unit of measure you decide to 
enter. Conversions between units of measure of the same unit of measure type 
(for example, both mass) are defined when the unit of measure is defined in 
System Administration. Conversions between different unit of measure types 
must be defined for each item on the Item Lot/Sublot Standard Conversion 
window in Inventory Management. Required.

40. Select the Scale Type as:

■ Fixed if the ingredient is not scalable.

■ Proportional if the ingredient is scalable.

■ Integer if the ingredient is scalable by multiples.

Required. Refer to the "Scaling Formulas" topic for advice.

41. Enter the Scale Multiple as the scaling increment for the ingredient.

42. Enter the Scale Rounding Variance.
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43. Enter the Rounding Direction as:

■ Down if the acceptable rounding direction is down to the nearest multiple.

■ Either if the acceptable rounding direction is up or down to the nearest 
multiple.

■ Up if the acceptable rounding direction is up to the nearest multiple.

44. Select the Consumption Type to indicate the type of ingredient consumption as:

– Automatic when ingredients are consumed automatically when the batch is 
completed.

– Manual when ingredients are consumed manually.

– Incremental when ingredient consumption is calculated by incremental 
backflushing.

– Automatic by Step when ingredients are consumed automatically as the 
step is completed.

Required.

45. Contribute to Yield indicates whether the material contributes to the yield.

■ Select Yes if the Line contributes to yield.

■ Select No if the Line does not contribute to yield.

Required.

46. Contribute to Step Qty indicates whether the material contributes to the step 
quantity.

– Select Yes if the Line contributes to step quantity.

– Select No if the Line does not contribute to step quantity.

47. Select the Phantom Type:

■ Not a Phantom indicates the ingredient is not a phantom item.

■ Automatic Generation indicates the ingredient is a phantom item that is 
exploded automatically.

■ Manual Generation indicates that the ingredient is a phantom item that 
requires manual explosion.

Required.
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48. Enter the Scrap Factor as the anticipated amount of ingredient lost in the 
manufacturing process as a percentage. For example, if the Scrap Factor is 10 
percent, an additional 10 percent of material is added to accommodate for this 
loss. Required.

49. Required Qty displays the result of multiplying the Formula Quantity by the 
quantity one plus the Scrap Factor expressed as a percent. For example, if the 
Scrap Factor is 10 percent and the Formula Quantity is 100 pounds, the 
Required Quantity is 110 pounds. It represents the planned quantity plus the 
scrap.

50. Click Edit Line to display the Formula Product Line Edit window.

51. Click Products to display the Formula Product Lines window.

52. Click By-Products to display the Formula By-Product Lines window.

53. Click Ingredients to display the Formula Ingredient Lines window.

54. Save the window.

◗◗ To scale the formula:
1. Choose Scale from the Actions menu. The Scale Formula window displays.

2. Select one of the following:

■ Percent to scale by a percentage. Enter the value in the Factor field.

■ Item Quantity to scale by a specific quantity. Enter the New Quantity.

3. Click OK. The window displays the scaled formula.

◗◗ To mark the formula for deletion:
1. Choose Mark for Purge from the Actions menu.

2. The record is marked for deletion.

3. Save the window.

◗◗ To change the formula status:
1. Choose Change Status from the Actions menu.

2. Change the Current Status displayed by selecting a different status from the 
Change Status To list.

3. Click OK. The Formula Details window displays the revised Status for the 
Formula.
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◗◗ To edit the formula text:
1. Choose Edit Text from the Actions menu.

2. Make the appropriate edits to formula text.

3. Save the window.

◗◗ To access the Samples window:
1. Choose Samples from the Actions menu. The Samples window displays.

2. Evaluate production samples.

3. Close the window.

◗◗ To display the Specifications window:
1. Choose Specifications from the Actions menu. The Specifications window 

displays.

2. Evaluate specifications.

3. Close the window.

◗◗ To select technical data:
1. Choose Technical Data Selection from the Actions menu. The Technical Data 

Selection window displays.

2. Evaluate technical data.

3. Close the window.

◗◗ To display product technical parameters:
1. Select the Line where you want to display technical parameters.

2. Choose Product Technical Parameters from the Actions menu. The Product 
Technical Parameters window displays.

3. Evaluate the technical parameters for the product.

4. Close the window.

◗◗ To list experimental items:
1. Choose List Experimental Items from the Actions menu. The List 

Experimental Items window displays.
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2. Evaluate the list for the Laboratory Formula and Laboratory Version displayed. 
The Experimental Item and a brief Description are displayed for each 
component in the list.

3. Close the window.

◗◗ To display theoretical yield:
1. Choose Theoretical Yield from the Actions menu. The Theoretical Yield 

window displays.

2. Evaluate the Yield Percent.

3. Click OK to close the window.

◗◗ To duplicate a record:
1. Retrieve the Formula Details record you want to duplicate.

2. Choose New from the File menu.

3. Choose Duplicate Record Above from the Edit menu.

4. Enter a new Formula name and Version number.

5. Save the window.

◗◗ To display the eRecord Details window:
1. Choose eRecord Details from the Actions menu. The eRecord Generic Query 

displays if this option is implemented in your application.

2. Refer to "Appendix D" for information on eRecords.

3. Close the window.

Scaling a Formula
The Scale Formula window enables you to scale a formula by a percent or by an 
item quantity.

◗◗ Using a Percent to Scale a Formula
Enter a percentage to scale any scalable ingredient up or down by a percent of the 
displayed quantity. For example, if you enter 100 percent, the quantity of the 
selected item is scaled up by 100 percent, or doubled, and the other quantities are 
increased accordingly. If you enter -50, or negative fifty percent, the item quantity is 
decreased by half.
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◗◗ Using an Item Quantity to Scale a Formula
This is the simplest method to scale any scalable ingredients. Enter a new quantity 
of material.

◗◗ To scale a formula by a percentage:
1. Select the material Line you want to scale. For example, select a product.

2. Choose Scale from the Actions menu. The Scale Formula window displays.

3. Select the Percent radio button.

4. Enter a percentage for the scaling Factor. For example, to double the material, 
enter 100.

5. Click OK.

◗◗ To scale a formula by entering a new quantity:
1. Choose Scale from the Actions menu. The Scale Formula window displays.

2. Select the Item Quantity radio button.

3. The following fields are display only:

■ Line displays the line number of the material on the Formula Details 
window.

■ Item displays the item code listed on the Formula Details window.

■ Description displays a brief description of the Item.

■ Old Quantity displays the quantity you want to rescale with its UOM.

4. Enter a New Quantity for the material.

5. Click OK.

Displaying Ingredient Technical Parameters

◗◗ To display ingredient technical parameters:
1. Choose Ingredient Technical Parameters from the Actions menu. The 

Ingredient Technical Parameters window displays.

2. Evaluate technical parameters for selected ingredients and make necessary 
changes.

3. Close the window.
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Using the View Menu to Find a Formula
The Find selection on the View menu enables you to find a formula.

◗◗ To find a formula from the View menu:
1. Choose Find from the View menu.

2. Enter as many parameters as needed to complete the search:

■ Status

■ Formula

■ Version

■ Description

■ Product

■ Formula Class

■ Project

■ Organization

■ Scaling Allowed

■ Marked for Deletion

3. Click Find.

4. Review the results of the search.

5. Close the window.
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Displaying the Formula Product Summary
The Formula Product Summary window enables you to display a summary of 
products listed in a formula. 

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Enter and save formulas.

◗◗ To display the formula product summary:
1. Navigate to the Formula Product Summary window.

2. The following fields are display only:

■ Line determines the line sequence for products listed in the Formula.

■ Item No determines the item code for products listed in the Formula.

■ Quantity determines the amount for products listed in the Formula.

■ Description determines a brief explanation of the product entered. This 
defaults from the Item Master table.

■ UOM determines the unit of measure for products listed in the Formula.

■ Yield Type to indicate the type of product yield as:

– Automatic if the line is automatically released or completed when 
subsequent lines are released or completed.

– Manual if the line must be released and completed manually.

– Incremental if the line must be released by incremental backflushing.

– Automatic by Step when products are yielded automatically as the step is 
completed.

■ Required Qty displays planned quantity plus the scrap.

■ Scale Type displays whether the scaling is Fixed or Proportional. Refer to 
the "Scaling Formulas" topic for advice.

■ Cost Allocation indicates how the cost of this item is allocated for financial 
rollup purposes.
3-52 Oracle Process Manufacturing Product Development User’s Guide



Displaying the Formula Product Summary
3. Click Edit Line to display the Formula Product Line Edit window.

4. Close the window.
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Displaying the Formula Byproduct Summary
The Formula By-Product Summary window enables you to display a summary of 
byproducts listed in a formula.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Enter and save formulas.

◗◗ To display the formula byproduct summary:
1. Navigate to the Formula By-Product Summary window.

2. The following fields are display only:

■ Line determines the line sequence for byproducts listed in the Formula.

■ Item No determines the item code for byproducts listed in the Formula.

■ Quantity determines the amount for byproducts listed in the Formula.

■ Description determines a brief explanation of the byproduct entered. This 
defaults from the Item Master table.

■ UOM determines the unit of measure for byproducts listed in the Formula.

■ Select the Yield Type to indicate the type of byproduct yield as:

– Automatic when byproducts are yielded automatically when the batch is 
completed.

– Manual when byproducts are yielded manually.

– Incremental when byproduct yield is calculated by incremental 
backflushing.

– Automatic by Step when byproducts are yielded automatically as the step 
is completed.

■ Scale Type displays whether the scaling is Fixed or Proportional. Refer to 
the "Scaling Formulas" topic for advice.

■ By-product Type displays whether the byproduct is Rework, Sample, 
Waste, or Yield. Refer to the "Setting Up Formula Information" topic for 
more information.
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3. Optionally, click Edit Line to display the Formula By-Product Line Edit 
window.

4. Close the window.
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Displaying the Formula Ingredient Summary
The Formula Ingredient Summary window enables you to display a summary of 
ingredients listed in a formula.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Enter and save formulas.

◗◗ To display the formula ingredient summary:
1. Navigate to the Formula Ingredient Summary window.

2. The following fields are display only:

■ Line determines the line sequence for ingredients listed in the Formula.

■ Item No determines the item code for ingredients listed in the Formula.

■ Quantity determines the amount for ingredients listed in the Formula.

■ Description determines a brief explanation of the ingredient entered. This 
defaults from the Item Master table.

■ UOM determines the unit of measure for ingredients listed in the Formula.

■ Consumption Type indicates the type of ingredient consumption as:

– Automatic if the line is automatically released or completed when 
subsequent lines are released or completed.

– Manual if the line must be released and completed manually.

– Incremental if the line must be released by incremental backflushing.

– Automatic by Step when ingredients are consumed automatically as the 
step is completed.

■ Contributes to Step Qty indicates whether the Line contributes to step 
quantity, and displays:

– Yes if the ingredient contributes to the step quantity.

– No if the ingredient does not contribute to the step quantity.

■ Scrap Factor displays the anticipated amount of ingredient loss during 
manufacturing as a percentage. For example, if the Scrap Factor is 10 
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percent, an additional 10 percent of material is added to accommodate for 
this loss.

■ Required Qty displays the planned quantity plus the scrap.

■ Scale Type displays whether the scaling is Fixed, Proportional, or Integer. 
Refer to the "Scaling Formulas" topic for advice.

■ Phantom Type determines whether the ingredient is not a phantom, is an 
autogenerated phantom, or is a manually generated phantom.

3. Click Details to display the Formula Ingredient Line Edit window.

4. Close the window.
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Displaying a Summary of Formula Product Lines
The Formula Product Line Summary window enables you to display formula 
product lines.

Prerequisites
❏ Enter and save formulas.

◗◗ To display the formula product line summary:
1. Navigate to the Formula Product Line Summary window.

2. The following fields are display only:

■ Line determines the line sequence for each product listed in the Formula.

■ Item determines the item code for each product listed in the Formula.

■ Description displays a brief explanation of the product entered. This 
defaults from the Item Master table.

■ Quantity determines the amount for each product listed in the Formula.

■ UOM determines the unit of measure for quantities of product listed in the 
Formula.

■ Yield Type to indicate the type of product yield as:

– Automatic if the line is automatically released or completed when 
subsequent lines are released or completed.

– Manual if the line must be released and completed manually.

– Incremental if the line must be released by incremental backflushing.

– Automatic by Step when products are yielded automatically as the step is 
completed.

■ Scale Type displays whether the scaling is Fixed or Proportional. Refer to 
the "Scaling Formulas" topic for advice.

■ Rework Type determines if the product Line is Not Rework or the Default 
Batch Quantity.

■ Cost Allocation indicates how the cost of this item is allocated for financial 
rollup purposes.

3. Click Details to display the Formula Product Line Edit window.

4. Close the window.
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Editing Formula Product Lines
The Formula Product Lines window enables you to edit formula product lines.

You cannot delete the last remaining product or ingredient in a formula. You cannot 
delete a product from a formula that has a validity rule saved for the formula and 
product combination.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Enter and save formulas.

◗◗ To edit the formula product lines:
1. Navigate to the Formula Product Lines window.

2. Line displays the line sequence for each product listed in the Formula.

3. Enter the Item No as the item code for each product listed in the Formula. 
Required.

4. Enter the Quantity as the amount for each product listed in the Formula. 
Required.

5. Description displays a brief explanation of the product entered. This defaults 
from the Item Master table.

6. Enter the UOM as the unit of measure for the Quantity. Required.

7. Select the Yield Type to indicate the type of product yield as:

■ Automatic if the line is automatically released or completed when 
subsequent steps are released or completed.

■ Manual if the line must be released and completed manually.

■ Incremental if the line must be released by incremental backflushing.

■ Automatic by Step when products are yielded automatically as the step is 
completed.

Required.

8. Enter the Scale Type to indicate whether the scaling is Fixed, Proportional, or 
Integer. Refer to the "Scaling Formulas" topic for advice.
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9. Cost Allocation indicates how the cost of this item is allocated for financial 
rollup purposes.

10. Save the window.

11. Optionally, click Edit Line to edit a selected Line Number. The Formula 
Product Line Edit window displays.
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Editing a Formula Product Line
The Formula Product Line Edit window enables you to edit formula product lines.

Prerequisites
❏ Enter and save formulas.

◗◗ To edit a formula product line:
1. Navigate to the Formula Product Line Edit window.

2. The following fields are display only:

■ Line determines the line sequence for each product listed in the Formula.

■ Item determines the item code for each product listed in the Formula.

■ Description determines a brief explanation of the product entered. This 
defaults from the Item Master table.

3. Enter the Quantity for the product Line listed in the Formula. Required.

4. Enter the UOM for the Quantity. Required.

5. Select the Yield Type to indicate the type of product yield as:

■ Automatic if the line is automatically released or completed when 
subsequent steps are released or completed.

■ Manual if the line must be released and completed manually.

■ Incremental if the line must be released by incremental backflushing.

■ Automatic by Step when products are yielded automatically as the step is 
completed.

Required.

6. Select the Scale Type as Fixed, Proportional, or Integer. Refer to the "Scaling 
Formulas" topic for advice. Required.

7. Cost Allocation indicates how the cost of this item is allocated for financial 
rollup purposes.

8. Save the window.
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Displaying a Summary of Formula Byproduct Lines
The Formula By-Product Line Summary window enables you to display a summary 
of formula byproduct lines.

You can use folders with this window. See: Oracle Applications User’s Guide.

Prerequisites
❏ Enter and save formulas.

◗◗ To display a summary of formula byproducts:
1. Navigate to the Formula By-Product Line Summary window.

2. The following fields are display only:

■ Line determines the line sequence for each byproduct listed in the Formula. 

■ Item determines the item code for each byproduct listed in the Formula.

■ Description determines a brief explanation of the byproduct entered. This 
defaults from the Item Master table.

■ Quantity determines the amount for each byproduct listed in the Formula.

■ UOM determines the unit of measure for the quantity.

■ Select the Yield Type to indicate the type of byproduct yield as:

– Automatic when byproducts are yielded automatically when the batch is 
completed.

– Manual when byproducts are yielded manually.

– Incremental when byproduct yield is calculated by incremental 
backflushing.

– Automatic by Step when byproducts are yielded automatically as the step 
is completed.

■ Scale Type displays whether the scaling is Fixed, Proportional, or Integer. 
Refer to the "Scaling Formulas" topic for advice.

■ By-product Type displays whether the byproduct is Rework, Sample, 
Waste, or Yield. Refer to the "Setting Up Formula Information" topic for 
more information.
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3. Click Details to display the Formula By-Product Line Edit window.

4. Close the window.
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Editing Formula Byproduct Lines
The Formula By-Product Lines window enables you to edit formula byproduct 
lines.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Enter and save formulas.

◗◗ To edit the formula byproduct lines:
1. Navigate to the Formula By-Product Lines window.

2. Line displays the line sequence for each byproduct listed in the Formula.

3. Enter the Item No as the item code for each byproduct listed in the Formula. 
Required.

4. Enter the Quantity as the amount for each byproduct listed in the Formula. 
Required.

5. Description displays a brief explanation of the byproduct entered. This defaults 
from the Item Master table.

6. Enter the UOM as the unit of measure for the quantity. Required.

7. Select the Yield Type to indicate the type of byproduct yield as:

■ Automatic when byproducts are yielded automatically when the batch is 
completed.

■ Manual when byproducts are yielded manually.

■ Incremental when byproduct yield is calculated by incremental 
backflushing.

■ Automatic by Step indicates that the byproduct is released automatically as 
the step is completed.

Required.

8. Select the By-product Type as:

■ Rework when the byproduct requires rework.

■ Waste when the byproduct is a waste material.

■ Sample when the byproduct is a sample for quality testing.
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■ Yield when the byproduct generated is yielded to another process or step.

Required.

9. Enter the Scale Type to indicate whether the scaling is Fixed or Proportional. 
Refer to the "Scaling Formulas" topic for advice.

10. Save the window.

11. Optionally, click Edit Line to edit a selected Line Number. The Formula 
By-Product Line Edit window displays.
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Editing a Formula Byproduct Line
The Formula By-Product Line Edit window enables you to edit formula byproduct 
lines.

Prerequisites
❏ Enter and save formulas.

◗◗ To edit a formula byproduct line:
1. Navigate to the Formula By-Product Line Edit window.

2. The following fields are display only:

■ Line determines the line sequence for each byproduct listed in the Formula.

■ Item determines the item code for each byproduct listed in the Formula.

■ Description determines a brief explanation of the byproduct entered. This 
defaults from the Item Master table.

3. Enter the Quantity for the byproduct Line listed in the Formula. Required.

4. Enter the UOM for the quantity. Required.

5. Select the Yield Type to indicate the type of byproduct yield as:

■ Automatic when byproducts are yielded automatically when the batch is 
completed.

■ Manual when byproducts are yielded manually.

■ Incremental when byproduct yield is calculated by incremental 
backflushing.

■ Automatic by Step indicates that the byproduct is released automatically as 
the step is completed.

Required.

6. Enter the Scale Type as Fixed or Proportional. Refer to the "Scaling Formulas" 
topic for advice. Required.

7. Enter the By-product Type as Rework, Sample, Waste, or Yield. Refer to the 
"Setting Up Formula Information" topic for more information.

8. Save the window.
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Displaying a Summary of Formula Ingredient Lines
The Formula Ingredient Line Summary window enables you to display formula 
product lines.

You can use folders with this window. See: Oracle Applications User’s Guide.

Prerequisites
❏ Enter and save formulas.

◗◗ To display a summary of formula ingredients:
1. Navigate to the Formula Ingredient Line Summary window.

2. The following fields are display only:

■ Line determines the line sequence for each ingredient listed in the Formula.

■ Item determines the item code for each ingredient listed in the Formula. 

■ Description determines a brief explanation of the ingredient entered. This 
defaults from the Item Master table.

■ Quantity determines the amount for each ingredient listed in the Formula.

■ UOM determines the unit of measure for the quantity.

■ Select the Consumption Type to indicate the type of ingredient 
consumption as:

– Automatic when ingredients are consumed automatically when the batch is 
completed.

– Manual when ingredients are consumed manually.

– Incremental when ingredient consumption is calculated by incremental 
backflushing.

– Automatic by Step when ingredients are consumed automatically as the 
step is completed.

■ Scale Type displays whether the scaling is Fixed, Proportional, or Integer. 
Refer to the "Scaling Formulas" topic for advice.

■ Phantom Type indicates whether the ingredient is not a phantom, is an 
autogenerated phantom, or is a manually generated phantom.

■ Contributes to Step Qty displays:
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– Yes if the ingredient contributes to the step quantity.

– No if the ingredient does not contribute to the step quantity.

■ Scrap Factor indicates the anticipated amount of ingredient lost in the 
manufacturing process as a percentage. For example, if the Scrap Factor is 
10 percent, an additional 10 percent of material is added to accommodate 
for this loss.

■ Required Quantity displays the result of multiplying the Formula Quantity 
by the quantity one plus the Scrap Factor expressed as a percent. For 
example, if the Scrap Factor is 10 percent and the Formula Quantity is 100 
pounds, the Required Quantity is 110 pounds.

3. Click Details to display the Formula Ingredient Line Edit window.

4. Close the window.
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Editing Formula Ingredient Lines
The Formula Ingredient Lines window enables you to edit formula ingredient lines.

You cannot delete the last remaining product or ingredient in a formula.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Enter and save formulas.

◗◗ To edit the formula ingredient lines:
1. Navigate to the Formula Ingredient Lines window.

2. Line displays the line sequence for each ingredient listed in the Formula.

3. Enter the Item No as the item code for the ingredient listed in the Formula. 
Required.

4. Enter the Quantity as the amount for each ingredient listed in the Formula. 
Required.

5. Description displays a brief explanation of the ingredient listed in the Formula. 

6. Enter the UOM as the unit of measure for the quantity. Required.

7. Select the Consumption Type to the type of ingredient consumption as:

– Automatic when ingredients are consumed automatically when the batch is 
completed.

– Manual when ingredients are consumed manually.

– Incremental when ingredient consumption is calculated by incremental 
backflushing.

– Automatic by Step when ingredients are consumed automatically as the 
step is completed.

Required.

8. Contributes To Step Qty indicates whether the material contributes to the step 
quantity.

■ Select Yes if the ingredient contributes to the step quantity.

■ Select No if the ingredient does not contribute to the step quantity.
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Required.

9. Contribute to Yield indicates whether the material contributes to the yield.

■ Select Yes if the Line contributes to yield.

■ Select No if the Line does not contribute to yield.

10. Enter the Scrap Factor as the anticipated amount of ingredient lost in the 
manufacturing process as a percentage. For example, if the Scrap Factor is 10 
percent, an additional 10 percent of material is added to accommodate for this 
loss. Required.

11. Required Qty displays the result of multiplying the Formula Quantity by the 
quantity one plus the Scrap Factor expressed as a percent. For example, if the 
Scrap Factor is 10 percent and the Formula Quantity is 100 pounds, the 
Required Quantity is 110 pounds. It represents the planned quantity plus the 
scrap.

12. Enter the Scale Type displays whether the scaling is Fixed, Proportional, or 
Integer. Refer to the "Scaling Formulas" topic for advice.

13. Enter the Phantom Type to indicate whether the ingredient is not a phantom, is 
an autogenerated phantom, or is a manually generated phantom. Required.

14. Save the window.

15. Optionally, click Edit Line to edit a selected Line Number. The Formula 
Ingredient Line Edit window displays.

◗◗ To find a formula line:
1. Choose Find... from the View menu. The Find Formula Line window displays.

2. Enter one or more of the following to narrow your search:

■ Formula No as the formula code number.

■ Formula Version as the formula version number.

■ Line Type as Automatic, Manual, or Incremental release.

3. Click Find.

4. Review the results of your search.

5. Optionally, click New to enter a new formula line.
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Editing a Formula Ingredient Line
The Formula Ingredient Line Edit window enables you to edit formula ingredient 
lines.

You can use folders with this window. See: Oracle Applications User’s Guide.

Prerequisites
❏ Enter and save formulas.

◗◗ To edit a formula ingredient line:
1. Navigate to the Formula Ingredient Line Edit window.

2. The following fields are display only:

■ Line determines the line sequence for each ingredient listed in the Formula.

■ Item determines the item code for each ingredient listed in the Formula.

■ Description determines a brief explanation of the ingredient entered. This 
defaults from the Item Master table.

3. Enter the Quantity for the ingredient Line listed in the Formula. Required.

4. Enter the UOM for the quantity. Required.

5. Select the Consumption Type to indicate the type of ingredient consumption as:

– Automatic when ingredients are consumed automatically when the batch is 
completed.

– Manual when ingredients are consumed manually.

– Incremental when ingredient consumption is calculated by incremental 
backflushing.

– Automatic by Step when ingredients are consumed automatically as the 
step is completed.

Required.

6. Enter the Scale Type as Fixed, Proportional, or Integer. Refer to the "Scaling 
Formulas" topic for advice. Required.

7. Enter the Phantom Type to indicate that this Line is not a phantom, is an 
autogenerated phantom, or is a manually generated phantom. Required.
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8. Select the Contributes To Step Qty check box if the Line contributes to step 
quantity. Clear the box if the Line does not contribute to step quantity.

9. Enter the Scrap Factor as the anticipated amount of ingredient lost in the 
manufacturing process as a percentage. For example, if the Scrap Factor is 10 
percent, an additional 10 percent of material is added to accommodate for this 
loss. Required.

10. Required Quantity displays the result of multiplying the Formula Quantity by 
the quantity one plus the Scrap Factor expressed as a percent. For example, if 
the Scrap Factor is 10 percent and the Formula Quantity is 100 pounds, the 
Required Quantity is 110 pounds.

11. Cost Allocation indicates how the cost of this item is allocated for financial 
rollup purposes.

12. Save the window.
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Running the Indented Bill of Materials Report
The Indented Bill of Materials Report is also called the Indented Formulas Report. 
The report displays all of the ingredients and ingredient quantities that are used to 
produce an item. Any ingredients that are intermediates can be exploded into their 
ingredients. Note that circular references are allowed one level deep so that an item 
can be both an ingredient and a product in a formula. Circular references beyond 
one level, however, are identified with an error message.

Prerequisites
❏ Enter and save formulas.

Understanding the Indented Bill of Materials Report
The Indented Bill of Materials Report window enables you to specify the formula, 
item, or range of formulas for the report. Enter other parameters to specify the 
formula to use, such as the type of laboratory, whether the formula is used for 
production, MRP, or cost management, and the effective date of that formula.

The Indented Bill of Materials Report window has two modes of operation:

■ Interactive, where the application initially displays a list of all of the formulas 
that meet the parameters entered. For example, if you enter an item and batch 
quantity, and there are several valid formulas for making the specified quantity 
and effective date for the item, the application lists each of those formulas. You 
select the appropriate formula, and the Indented Bill of Materials Report is 
generated for that formula.

■ Noninteractive, where the application picks the formula to use based on the 
effective date preference. If two or more formulas have the same preference 
level, the application uses the most recent formula.

◗◗  To run the report:
1. Navigate to the Indented Bill of Materials Report window.

Selection Range
2. Determine how you want to explode formulas:

■ Select the Interactive check box to use the interactive mode. This enables 
you to select from a list of effective dates.

■ Clear the Interactive check box to use the noninteractive mode. This uses 
the most recent effective date for a formula.
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3. When you run an IBOM report for the first time, the report explodes a formula 
regardless of the selection indicated in this field. Determine if you want to 
reexplode formulas that have already been exploded in previous reports:

■ Select the Re-Explode check box if you want to reexplode formulas that 
appear in the report.

■ Clear the Re-Explode check box if you do not want to reexplode formulas 
that appear in the report.

4. Determine if you want to explode inactive formulas:

■ Select the Use Inactive check box if you want to explode inactive formulas.

■ Clear the Use Inactive check box if you do not want to explode inactive 
formulas.

5. Select one of the following radio buttons:

■ Select the Single Formula radio button if you want to print the Indented 
Bill of Materials Report for a single formula. When you click this button, the 
Formula and Version fields become available for entry.

– Enter the code of the Formula for the Indented Bill of Materials Report. This 
field is editable if you selected to explode a single formula Required when 
displayed.

– Enter the Formula Version you want for the Indented Bill of Materials 
Report. This field is editable if you selected to explode a single formula. 
Required when displayed.

■ Select the Single Item radio button if you want to print the Indented Bill of 
Materials Report for a specific product.

– Enter the Item code for the product you for the Indented Bill of Materials 
Report. This field only displays when you select to explode a single item. 
The item description displays. Required when displayed.

– Enter the Batch Qty of the product you want for the Indented Bill of 
Materials Report. This quantity is used to determine the formula to use. The 
formula must be valid for this quantity and capable of proper ingredient 
scaling. This field is only displayed if you selected to explode a formula for 
a single item. Required when displayed.

– Enter the UOM for the batch quantity. This field is only displayed if you 
selected to explode a formula for a single item. Required when displayed.
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■ Select Formula Range if you want to print the bills of materials for a range 
of formulas. You cannot enter formula ranges if you are using the 
interactive mode. Enter the starting and ending Range of formulas you 
want. If you enter a range of formulas, the application starts one concurrent 
process for each formula entered. Each formula has its own separate report.

Other Options
6. Enter Scale By as the appropriate scaling percent. The default is 100. Required.

7. Enter the number of Levels you want printed on report. The default is All.

8. Select a Recipe Use to use as the basis of the report. You can select production, 
planning, costing, or technical. Required.

9. Enter the Effective Date and time for the Formula. Only formulas that are 
effective on this date and time are used as the basis for the report. Required.

10. Select the UOM Type as:

■ Formula if you want the formula unit of measure type used.

■ Inventory if you want the inventory unit of measure type used.

Required.

Print Options
11. Enter the number of report Copies you want. If you selected a range of 

formulas, then each bill of materials is printed this number of times. Required.

12. Enter the code identifying the Printer to use to print the report.

13. Click OK.

14. The Submission History window displays.

15. Record the Request ID.

◗◗ To display the output of the Indented Bill of Materials Report: 
1. Run the Indented Bill of Materials Report.

2. Choose Requests from the View menu.

3. Select All My Requests.

4. Click Find.
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5. Choose the indicator next to the requested Indented Bill of Materials Report to 
display. Make sure that the report phase has completed without errors.

6. Click View Output. The report you selected is displayed.

◗◗ To interpret the Indented Bill of Materials Report:
1. Run the Indented Bill of Materials Report.

2. The following fields are display only:

■ Formula is the code for the formula used for the Indented Bill of Materials 
Report. A colon appears before the formula version number. A description 
of the Formula and the Version displays.

■ Recipe Use indicates whether the formula is for production, planning, 
costing, or technical.

■ Effective Date specified. Formulas that appear on the report are effective on 
this date.

■ Products produced by the Formula. To the right of each product item code 
two numbers appear in parentheses. Each number is separated by a slash 
mark. The first number displays the batch quantity of the product. This 
number is either the product quantity multiplied by the scale, or the batch 
quantity you entered in the Batch Quantity field. The second number is the 
product quantity from the Formula. The unit of measure for the batch 
quantity and formula quantity follow in parentheses with the item 
description of the product.

■ Scale Percent indicates the scaling percent for the Formula. A scale percent 
of zero indicates that a formula is not scaled, and is the same as the scale 
percent of 100.

■ Use Inactive Formulas has a 0 if no inactive formulas were used, or a 1 if 
inactive formulas were used.

■ Max Explode Levels indicates the maximum number of levels to explode 
formulas.

■ Exploded Date is the date the Formula was exploded.

■ Ingredient -- Description indicates the item code for each ingredient in the 
exploded formula followed by the ingredient description. In addition to 
ingredients, byproducts are displayed, and are preceded by the label 
By-product. If any of the ingredients is an intermediate, or a product in 
another formula, the ingredient line is followed by the label Formula. This 
3-76 Oracle Process Manufacturing Product Development User’s Guide



Running the Indented Bill of Materials Report
line displays formula codes and versions used to explode intermediates into 
their ingredients. Following this line are the ingredients in this Formula. In 
addition to the ingredients, byproducts are identified with the label Byp: 
and coproducts are identified by Cop: label. Byproducts, coproducts, and 
ingredients in the Formula that produces the intermediate are indented 
separately from the ingredients in the main formula. Once the indentation 
ends, the items that begin at the left margin of the report are ingredients in 
the main formula listed at the top of the report page.

■ Levels of indentation are displayed for item lines from the main formula 
listed at the top of the report page. The highest level is level one is 
identified by a 1. Intermediates are at level two is identified by 2. The 
indentation progresses for each of the defined Levels. For example, 3, 4, and 
5 are indentations for levels 3, 4, and 5 respectively.

■ Batch Quantity is the amount of ingredient necessary to produce the batch 
quantity of the product. For byproduct or coproduct lines, this is the 
quantity of the byproduct or coproduct that is produced when the batch 
quantity of the main product is produced.

■ Formula Quantities are the amounts of ingredients, byproducts, and 
coproducts in the Formula.

■ Standard Quantity of product is the amount used to produce any 
intermediates. If the quantity of an intermediate needed in the main 
formula is different from this standard quantity, the intermediate formula is 
automatically scaled. The scaled product quantity and scaled ingredient 
quantities are shown in the Batch Quantity column.

■ UOM is the unit of measure for the unit of measure for the Standard 
Quantity.
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Using Formula Inquiry
The Formula Inquiry Selection window is the starting point for Formula Inquiry 
queries. Using a selection range to narrow the search of formula information, you 
have the ability to display a summary list of formulas that fit the parameters you 
specify. The inquiry delivers a Formula Inquiry Summary View window where you 
display parent level and intermediate level formula information.

Prerequisites
❏ Enter and save formulas.

◗◗ To perform a formula inquiry:
1. Navigate to the Formula Inquiry Selection window.

2. Select one of the following for the Active/Inactive Formula field:

■ Active to query formulas that are active.

■ Inactive to query formulas that are inactive.

■ All to query all active and inactive formulas.

3. Select one of the following for the Validity Rules field:

■ Defined to query components with defined validity rules.

■ Undefined for components with undefined validity rule.

■ Both to query all components.

Recipe Used In
4. Select one, all or any combination of the following uses: 

■ Production for use in production.

■ Planning for use in planning.

■ Costing for use in cost management.

■ Technical for use in formula analysis. Technical Class is a category used to 
identify and group ingredients where the overall contribution of specific 
technical characteristics of the ingredients is significant.

Selection Range
5. Determine whether you want to display a specific Formula, a range of 

formulas, or all formulas. To select a specific Formula, enter the same formula 
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in the From and To fields. To select a range of formulas, enter different formula 
numbers in the From and To fields. To select all formulas leave the fields blank.

6. Determine whether you want to display a specific Formula Version, a range of 
versions or all versions. To select a specific version, enter the same version 
number in the From and To fields. To select a range of formula versions, enter 
different version numbers in the From and To fields. To select all versions leave 
the fields blank. Required.

7. Determine whether you want to display a specific Routing, a range of routings 
or all routings. To select a specific routing, enter the same routing number in the 
From and To fields. To select a range of routings, enter different routing 
numbers in the From and To fields. To select all routings leave the fields blank.

8. Determine whether you want to display a specific Routing Version, a range of 
routing versions or all routing versions. To select a specific routing version, 
enter the same routing number in the From and To fields. To select a range of 
routing numbers, enter different routing numbers in the From and To fields. To 
select all routing numbers leave the fields blank.

9. Determine whether you want to display formulas for a specific Organization, a 
range of organizations or all organizations effective for your user code. To select 
a specific organization, enter the same Organization in the From and To fields. 
To select a range of organizations enter different organizations in the From and 
To fields. To select all organizations leave the fields blank.

10. Determine whether you want to display the formulas for a specific Effective 
Date, a range of effective dates or all effective dates. To select a specific date, 
enter the same date in the From and To fields. To select a range of dates, enter 
different dates in the Range From and To fields. To select all dates leave the 
fields blank.

11. Determine whether you want to display formulas for a specific Customer, a 
range of customers or all customers. To select a specific customer, enter the 
same customer code in the From and To fields. To select a range of customers, 
enter different customer numbers in the Range From and To fields. To select all 
formulas leave the fields blank.

12. Enter the Product item number in this field to display formulas for a specific 
product.

13. Enter the Effective Qty of the item produced by the formula. This field becomes 
available if you indicate a specific formula and version or a specific item 
produced. The unit of measure displays.

14. Enter the Ingredient used to display formulas that contain it.
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15. Click OK. The Formula Inquiry Summary View window displays.

16. Refer to the Interpreting a Formula Inquiry topic for a complete explanation of 
using the Formula Inquiry Summary View window.
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Interpreting a Formula Inquiry
The Formula Inquiry Summary View is the first window displayed after you make 
entries in the Formula Inquiry window. It lists formulas that meet the entered 
parameters.

From this window, you can obtain additional information for any formula. Formula 
Inquiry Summary consists of two window areas. The top area is scrollable and lists 
the organization, formula number and version, routing, and minimum and 
maximum quantity from the formula effectivity record. The bottom area of the 
window is synchronized with the line that is selected in the upper area and lists the 
Start and End Dates, the Formula Status, the Standard Quantity, the Customer, and 
Formula Use.

Formulas you are not permitted to access are shown with a # symbol in the far left 
column.

You can use flexfields with this window. See Oracle Applications User’s Guide and 
Oracle Applications Flexfields Guide.

Prerequisites
❏ Complete the appropriate entries in the Formula Inquiry window to display the 

Formula Inquiry Summary View.

◗◗ To interpret the Formula Inquiry Summary:
1. Navigate to the Formula Inquiry Summary View window.

2. The following fields are display only:

■ Organization where the formula is effective. You can only display formulas 
effective to organizations linked to your user code. A # sign indicates you 
cannot display the formula. 

■ Formula code for each formula.

■ Version number for each Formula.

■ Routing number for each Formula Version.

■ Version number for each Routing.

■ Minimum Qty as the minimum quantity where the Formula is valid.

■ Maximum Qty for as the maximum quantity where the Formula is valid.

■ UOM listed for each Formula.
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3. The following fields display data that is specific to the formula selected:

■ Effective Dates lists the dates that formulas and versions are valid.

■ Formula Status indicates the current formula status.

■ Standard Qty is the typical quantity that is produced by each formula.

■ Customer is the name of the individual or company who buys the listed 
formulas.

■ Recipe Use displays the intended use for the Formula in production, 
planning, costing, or technical.

■ Customer displays the customer who uses the selected formula.

4. Close the window.

Displaying Details from a Formula Inquiry
The Formula View window enables you to display the parent formula or highest 
level formula. You have the ability to display intermediates from this window using 
the Actions menu.

◗◗ To display details from a formula inquiry:
1. Select the appropriate Formula from the Formula View Inquiry window.

2. Choose Formula View from the Actions menu. The Formula View window 
displays.

3. The following fields are display only:

■ Formula displays the unique identifying code for the formula selected.

■ Status indicates the status of the formula.

■ Version displays the version of the Formula.

■ Comments displays the detailed descriptive information about the 
Formula.

■ Comments displays any comments that you added at the header level.

■ Formula Class displays how the Formula is classified at the header level.

■ Scaling Allowed check box is selected if scaling is allowed on the formula. 
It is cleared with scaling is not allowed. This information is taken from the 
formula’s additional information. Refer to the "Scaling Formulas" topic for 
advice.
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Details
4. The following fields are display only:

■ Type indicates whether the item is a product, byproduct, or ingredient of 
the formula. The drill down indicator to the left of Type lets you drill down 
to a subcomponent.

■ Item displays the item code of the product, byproduct, or ingredient of the 
formula.

■ Description displays a brief description of the item.

■ Quantity displays the quantity of the item used in the formula.

■ UOM displays the unit of measure of the item.

5. The following fields display data that is specific to the component selected:

■ Phantom Type indicates whether the material is not a phantom, is an 
autogenerated phantom, or is a manually generated phantom.

■ Scrap Factor indicates the anticipated amount of ingredient lost in the 
manufacturing process as a percentage. For example, if the Scrap Factor is 
10 percent, an additional 10 percent of material is added to accommodate 
for this loss. Required.

■ Scale Type displays whether the scaling is Fixed, Proportional, or Integer. 
Refer to the "Scaling Formulas" topic for advice.

■ Cost Allocation indicates how the cost of this item is allocated for financial 
rollup purposes.

6. Release Type indicates the type of yield for products and byproducts, or 
Consumption Type for ingredients.

7. Close the window.

◗◗ To display formula text:
1. Choose View Text from the Actions menu.

2. The Text Editor window for the formula displays. If the cursor is on:

■ the formula header area, header text displays.

■ an unexpanded detail line, text associated with the ingredient displays.

■ an expanded detail line, product text displays.

3. Edit appropriate text.
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4. Save the window.

Displaying an Intermediate Formula
The intermediate formula can only be displayed if the row is preceded by a + sign.

◗◗ To display an intermediate formula:
1. Select a row on the Formula View window that is preceded by a + sign.

2. Choose Lower Level from the Actions menu.

3. The intermediate formula of the selected item or product displays on the 
Intermediate Formula Inquiry Summary View window.

4. The following fields are display only:

■ Organization displays the organization that owns the formula.

■ Formula displays the intermediate formula name.

■ Version displays the formula version number.

■ Routing displays the routing associated to the formula.

■ Version displays the routing version number.

■ Minimum Qty displays the minimum quantity of the displayed formula 
produced by the routing.

■ Maximum Qty displays the maximum quantity of the displayed formula 
produced by the routing.

■ UOM is the unit of measure for the Minimum Qty and Maximum Qty.

■ Effective Dates displays the dates that formulas and versions are valid.

■ Standard Qty displays the typical quantity that is produced by the formula.

■ Customer displays the name of the individual or company who buys the 
listed formulas.

■ Active Formula displays whether you are displaying an active or inactive 
formula.

■ Recipe Use displays how the recipe is used. For example, in production, 
planning, costing, or technical.

5. Close the window.
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◗◗ To condense an intermediate formula:
The cursor must be on a line preceded by a - sign. All expanded formulas that 
follow that line are already condensed.

1. Choose Condense from the Actions menu.

2. The window contracts the display of lower level formulas.

3. Close the window.
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Analyzing a Formula
Formula analysis enables you to simulate the contribution of formula components 
in a product by weight or by volume. You can determine the quantities and 
percentages of ingredients that have been classified by a Technical Class and a 
Technical Subclass. For example, a Technical Class could include all volatile organic 
solvents in a formula. Technical Subclasses of volatile organic solvents could 
include mineral spirits or alcohols.

The Formula Analysis Parameters window lets you analyze a formula for Technical 
Class and Technical Subclass composition. You display the results of the analysis in 
the Formula Ingredient Contribution Analysis window.

Formula analysis is performed in the concurrent program manager so that results 
can be queried at your convenience. Each time this process is repeated for a specific 
formula in a specific organization, any previously calculated data is replaced for 
that formula in that organization. The log file provides status messages issued 
during the formula analysis calculations. Use this file to identify any errors that 
occur.

Prerequisites
❏ Set up technical parameters and appropriate sequences.

❏ Enter item technical data for the density of ingredients in formulas to be 
analyzed. This is not required for intermediate items, but it is required for their 
component materials.

❏ Set up technical classes and technical subclasses for ingredients that are 
included in a formula analysis. This is not required for intermediate items, but 
it is required for their component materials.

❏ Enter and save formulas. Identify the correct formula to use for any 
intermediates in the parent formula. You can do this either by setting the Item 
Technical Data Selection or by using a Recipe with Validity Rules.

◗◗ To analyze a formula:
1. Navigate to the Formula Analysis Parameters window.

2. Specify the rule to use during the explosion of formula intermediates:

■ Select Use Production Formulas to explode intermediates using a formula 
that is Approved for General Use. Experimental intermediates are exploded 
using a formula that is Approved for Laboratory Use. Name indicates the 
name of the Organization entered.
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■ Select Use Laboratory Formulas to explode all intermediates using a 
formula that is Approved for Laboratory Use.

Required.

3. Enter the code for the Organization where you want to analyze the formula. 
The organization entered retrieves and uses appropriate recipe validity rules 
when it explodes an intermediate. If no validity rules are available for the 
organization entered, global validity rules are applied. Required.

4. Enter the Formula to be used in the analysis. Required.

5. Enter the Version of the formula to be used in the analysis. Required.

6. The following fields are display only:

■ Description of formula entered.

■ Status of the formula entered.

7. Enter the Analysis Quantity as the total formula output required for this 
analysis. This value must be greater than zero. Required.

8. Enter the UOM for the Analysis Quantity. The unit of measure entered here 
must be defined in the profile option GMD:UOM Mass Type or GMD:UOM 
Volume Type. Required.

9. Click Analyze. Note the Request ID number.

10. Choose View from the menu, and choose Requests to view the status of your 
request in the concurrent program manager.

11. When your Request ID has completed with a Status of Normal, display the 
results of the analysis as described in the "Displaying Formula Analysis 
Results" topic.

12. Select View Log... on the Requests window to view the explosions performed 
on intermediates using the rule that you specified in step 2. If any problems 
were encountered in the explosion, they are listed in the Log file.
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Displaying Formula Analysis Results
The Formula Ingredient Contribution Analysis window displays the details of the 
analysis of a particular formula in a specified organization. The window consists of 
two separate views that display Technical Class and Technical Subclass analysis 
results by weight or by volume.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Analyze a formula as described in the Analyzing a Formula topic.

◗◗ To display the results of a formula analysis by weight:
1. Navigate to the Formula Ingredient Contribution Analysis window.

2. Query the analyzed formula.

3. Select View By Weight.

4. The following fields are display only:

■ Organization displays the facility that owns the formula analyzed.

■ Analysis Date displays the date of the analysis.

■ Formula displays the formula used in the analysis.

■ Version displays the version of the formula used in the analysis.

■ Status displays the approval Status of the formula used in the analysis. For 
example, Approved for Laboratory Use indicates that the formula can be 
used in the laboratory.

■ Product displays the main item in the formula analyzed.

■ Description displays a description of the main item in the formula 
analyzed. 

■ View By displays the current type of view displayed. When View By 
Weight is selected, Weight displays in this field.

■ Explosion Rule displays the currently selected Explosion Rule used to 
explode intermediates.

■ Technical Class displays the Technical Class used to group ingredient 
contributions.
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■ Direct Weight displays the actual weight of ingredients in the selected 
Formula Technical Class.

■ Direct (%) displays the Direct Weight of the Formula Technical Class as a 
percentage of the Total Weight.

■ Indirect Weight displays the weight of ingredients within exploded 
intermediate products in the selected Formula Technical Class.

■ Indirect (%) displays the Indirect Weight of the Formula Technical Class as 
a percentage of the Total Weight.

■ Total Weight displays the sum of the Direct Weight and Indirect Weight in 
the selected Formula Technical Class.

■ Total (%) displays Total Weight of the Formula Technical Class as a percent 
of the entire Formula weight.

Item Detail
5. The following fields are display only:

■ Subclass displays the Formula Technical Subclass.

■ Item displays the selected ingredient item in the Formula Technical 
Subclass.

■ Direct Weight displays the actual weight of ingredients in the selected 
Formula Technical Subclass.

■ Direct (%) displays the Direct Weight of the Formula Technical Subclass as 
a percentage of the Total Weight.

■ Indirect Weight displays the weight of ingredients within exploded 
intermediate products in the selected Formula Technical Subclass.

■ Indirect (%) displays the Indirect Weight of the Formula Technical Subclass 
as a percentage of the Total Weight.

■ Total Weight displays the sum of the Direct Weight and Indirect Weight in 
the selected Formula Technical Subclass.

■ Class (%) displays the percentage contribution of the selected Formula 
Technical Subclass to the entire Formula Technical Class.

■ Formula (%) displays the percentage contribution of the selected Formula 
Technical Subclass as a percentage of the total Formula weight.
Formulas 3-89



Displaying Formula Analysis Results
Subtotal
6. The following fields are display only:

■ Subclass displays the Formula Technical Subclass.

■ Direct Weight displays the actual weight of ingredients in the selected 
Formula Technical Subclass.

■ Direct (%) displays the Direct Weight of the Formula Technical Subclass as 
a percentage of the Total Weight.

■ Indirect Weight displays the weight of ingredients within exploded 
intermediate products in the selected Formula Technical Subclass.

■ Indirect (%) displays the Indirect Weight of the Formula Technical Subclass 
as a percentage of the Total Weight.

■ Total Weight displays the sum of the Direct Weight and Indirect Weight in 
the selected Formula Technical Subclass.

■ Class (%) displays the percentage contribution of the selected Formula 
Technical Subclass to the entire Formula Technical Class.

■ Formula (%) displays the percentage contribution of the selected Formula 
Technical Subclass as a percentage of the total formula weight.

◗◗ To display results of a formula analysis by volume:
1. Navigate to the Formula Ingredient Contribution Analysis window.

2. Query the analyzed formula.

3. Select View By Volume.

4. The fields displayed are calculated in terms of volume rather than weight.

Interpreting a Formula Ingredient Contribution Analysis
The following example illustrates a simple formula analysis of Formula F1. It assists 
you in the interpretation of results displayed on the Formula Ingredient 
Contribution Analysis window.

Formula F1 makes 100 pounds of Product 1. The Analysis Quantity of Formula F1 is 
200.00 pounds. Formula F1 contains an intermediate, INT1. The intermediate INT1 
is produced by Formula F2.

Formula F1 is composed of:

■ 40 pounds of ingredient 1
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■ Technical Class is Binder

■ Technical Subclass is Acrylic

■ 10 pounds of ingredient 2

■ Technical Class is Solvent.

■ Technical Subclass is Organic

■ 50 pounds of intermediate 1

Intermediate INT1, Formula F2, is 50 pounds, and is composed of:

■ 10 pounds of ingredient 1

■ Technical Class is Binder

■ Technical Subclass is Acrylic

■ 25 pounds of ingredient 3

■ Technical Class is Binder

■ Technical Subclass is Acrylic

■ 15 pounds of ingredient 4

■ Technical Class is Solvent

■ Technical Subclass is Alcohol

Formula Analysis of Formula F1 is:
■ The application calculates the ingredient direct contributions at the formula 

level:

■ ING1 is scaled to 80.00 pounds

■ ING2 is scaled to 20.00 pounds

■ INT1 is scaled to 100.00 pounds

■ The application calculates the ingredient contributions at the exploded lower 
levels. These calculations consist of exploding each intermediate found at each 
level of the formula. There is only one intermediate, INT1, in this example. The 
formula that produces this intermediate does not contain any additional 
intermediates. Therefore, the formula is exploded only one level. INT1 is 
exploded using Formula F2. Formula F2 is scaled by the quantity of INT1 
consumed by F1 after scaling, or 100 pounds.

Exploding F1 results in the following:
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■ 80.00 pounds of ING1 calculated from the direct contribution

■ 20.00 pounds of ING1 calculated from the explosion of INT1

■ 20.00 pounds of ING2 calculated from the direct contribution

■ 50.00 pounds of ING3 calculated from the explosion of INT1

■ 30.00 pounds of ING4 calculated from the explosion of INT1

The Formula Ingredient Contribution Analysis for this example is:

Direct Weight
Binder

■ Acrylic

■ ING1 is 80.00 pounds, representing 100% of the Direct Weight contribution

■ Subclass Direct Weight is 80.00 pounds

■ Class Direct Weight Total is 80.00 pounds

Binder Class Total is 80.00 pounds

Solvent

■ Organic

■ ING2 is 20.00 pounds, representing 100% of the Direct Weight contribution

■ Subclass Direct Weight is 20.00 pounds

Solvent Class Total is 20.00 pounds

Indirect Weight
Binder

■ Acrylic

■ ING1 is 20.00, representing 28.60% of the Indirect Weight contribution

■ ING3 is 50.00, representing 71.40% of the Indirect Weight contribution

■ Subclass Indirect Weight is 70.00 pounds

Binder Class Total is 70.00 pounds

Solvent

■ Alcohol
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■ ING 4 is 30.00 pounds, representing 100% of the Indirect Weight 
contribution

Solvent Subclass Total is 30.00 pounds

Total Weight
Binder

■ Acrylic

■ ING1 is 100.00 pounds, representing 66.67% of the Class

■ ING3 is 50.00 pounds, representing 33.33% of the Class

Binder Subclass Total is 150.00 pounds, representing 100.00% of the Class and 
75.00% of the formula weight

Solvent

■ Organic

■ ING2 is 20.00 pounds, representing 40.00% of the Subclass

Solvent Subclass Total is 20.00 pounds, representing 40.00% of the Subclass and 
10.00% of the formula weight

■ Alcohol

■ ING4 is 30.00 pounds, representing 60.00% of the Subclass

Solvent Subclass Total is 30.00 pounds, representing 60.00% of the Subclass and 
15.00% of the formula weight

Ingredient Contribution Summary
Binder is 75.00% of the formula weight

Solvent is 25.00% of the formula weight, with 10% Organic Subclass and 15% 
Alcohol Subclass
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Finding a Formula Analysis
The Find Analysis window helps you find an existing Formula Ingredient 
Contribution Analysis.

Prerequisites
❏ Analyze formulas as described in the Analyzing a Formula topic.

◗◗ To find a formula analysis:
1. Navigate to the Find Analysis window.

2. Enter one or more of the following fields to narrow your search:

■ Organization where the analysis was performed.

■ Formula code of the formula.

■ Version number of the Formula.

■ Product as the main item in the Formula.

3. Click Find.

4. The Formula Ingredient Contribution Analysis window displays the analysis 
found that meets your search parameters.
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Overriding Default Explosion Rules
The Item Technical Data Selection window enables you to specify the formula 
sources for intermediate technical parameter values, thereby overriding automatic 
selection.

Prerequisites
❏ Set up technical parameters.

❏ Set up technical parameter sequences.

❏ Enter item technical data for the density of every ingredient in formulas to be 
analyzed.

❏ Set up technical classes and technical subclasses for all ingredients that are 
included in a formula analysis.

❏ Enter and save formulas.

◗◗ To override default explosion rules:
1. Navigate to the Formula Details window.

2. Select the Ingredient for custom explosion rules.

3. Choose Item Technical Data Selection from the Actions menu. The Item 
Technical Data Selection window displays.

Spreadsheet
4. This region is not used in this procedure.

Ingredient Contribution
5. Enter the Formula number and Version to be used for the explosion of the 

intermediate during the formula ingredient contribution analysis calculation.

6. Click OK.
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4

Operations

This topic shows you how to define and maintain operations, activities, and 
resources. You are also shown to find an operation. Summaries of operations and 
operation headers provides an overview what is created. The process to enter 
operation activity details and activity-resource details is explained. You are also 
shown how to display activity lines and edit a summary of resource lines.

The following topics provide a basic understanding of operations:

■ Understanding Operations

■ Requirements

■ Solutions

■ Defining and Maintaining Operations

■ Defining and Maintaining Activities

■ Defining and Maintaining Resources

■ Finding an Operation

■ Displaying the Operations Summary

■ Displaying the Operation Header Summary

■ Entering Operation Activity Details

■ Entering Activity-Resource Details

■ Displaying Operation Activity Line Summary

■ Displaying the Resource Line Summary

■ Editing a Resource Line

■ Displaying Operation Resource Process Parameters
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Understanding Operations
An operation is an ordered set of activities that have to be completed for a 
predetermined step in a production batch. Resource requirements that are needed to 
perform these activities are usually specified. You build operations from activities 
that require resources.

Operations are depicted hierarchically in the following diagram that shows the:

■ Routing composed of a series of Operations organized in Steps.

■ Operations composed of Activities containing Resources.

■ Formula composed of Ingredient, Product, and possibly Byproduct.

■ Recipe linking the Routing and Formula together with Processing Instructions.

The assembly of several operations in a stepwise progression creates a Routing.
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Requirements
Following are some requirements that customers have for operations in Product 
Development. The answers are explained in detail in the Solutions topic.

Does the application maximize production capacity resource usage?
Yes. By using the Charge to calculate resource usage, the application captures the 
number of passes required to process a step based on the maximum capacity of that 
step. This is derived from specific resources used and can assist in maximizing 
usage of production capacity resources.

Can the application simplify the repeated entry of the same data for the 
same activity?
Yes. Using an Activity Factor defines the number of iterations that a specific activity 
can be performed during an operation. The Activity Factor is considered in 
planning and calculating resource usage.
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Solutions
Product Development provides solutions to help resolve issues at every stage of the 
product development process. The following represent some of the key 
performance solutions for operations.

Charges Refine Processing Requirements for Better Planning and Cost Management  In many 
process manufacturing plants, the capacity of a step is determined by the 
equipment used. For example, a mixing tank has a maximum capacity of 1000 
gallons. If more than 1000 gallons of material is added to this tank, it would 
overflow. This maximum capacity determines the number of charges or iterations 
that are required to process the ingredients required for a defined batch. The time 
that it takes to mix any volume of material through this operation is a fixed value. 
For example, one charge can require one hour of mixing. The problem arises when a 
batch is greater than the step capacity, and the step must be repeated several times 
to make a full batch volume. Proportional scaling does not always reflect the 
processing requirements. For example, if a batch is planned for 4500 gallons and the 
routing step can have a tank capacity of 1000 gallons, five charges, or mini-batches, 
would be required to process the full 4500 gallons. Proportional scaling results in 
only 4.5 hours of process time, whereas the actual required process time would be 
five hours. By refining the process requirements, the application delivers a better 
assessment of usage rates that affect planning and cost management.

Activity Factors Streamline Resource Definition  An Activity Factor defines the number of 
times an activity is performed. For example, if a quality test must be performed at 
the beginning, middle, and end of a mixing time period, you must use an Activity 
Factor of three. Activity Factors are applied to resource usage when planning and 
calculating resource costs. They can be set to zero to exclude a particular activity or 
to select specific equipment or resources.
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Defining and Maintaining Operations
Operations are composed of a sequence of activities and required resources. You 
enter and maintain the sequence of activities in the operation, and specify the 
resource, resource usage, and process quantity used for each activity. For example, a 
mixing activity can require one-half hour of use of a mixing system. Resource usage 
and cost analysis codes that are associated with each activity are used to calculate 
activity-based product costing.

Creating a New Operation
Create new operations on the Operation Details Activities window. When you 
define an operation, specify a combination of one or more activities performed in 
the production batch and assign the resources used to perform those activities. A 
resource can be any noninventory item that is used in production, such as a blender 
or a heating device.

Maintaining Operations
Use the the following windows to maintain operations:

■ Operations Summary By... to display a list of all defined operations with their 
individual version numbers and validity rules. These are summaries by Class, 
Status, or Owner. Display the Operation Details Activities window from the 
Operations Summary By... window.

■ Operation Header Summary to display descriptive information on a specific 
operation. Display the Operation Details Activities window from the Operation 
Header Summary window.

■ Operation Details Activities to enter, view, and edit an operation. Display the 
following window from the Operation Details Activities window:

■ Operation Activity Line

■ Operation Details Activity Resources
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The following graphic depicts the previously described operation navigation flow:
4-6 Oracle Process Manufacturing Product Development User’s Guide



Defining and Maintaining Activities
Defining and Maintaining Activities
Activities are the basic tasks performed at your plant such as setup, mixing, 
cleanup, or cooling. You combine activities with resources such as blender, oven, 
labor, or utilities to define operations. Basic plant activities are identified by activity 
codes. These codes are then combined to define the sequence of activities that can 
make up an operation. You can associate a cost analysis code with each activity. For 
example, by defining cost classes, you can categorize individual activities on 
whether or not they add value. Activity costs are the basic components of an 
activity based accounting system.

Prerequisites
❏ Set up activities.

Attaching Activities to Operations
Attach activities that were created in setup to specific operations using the 
Operation Details Activities window.

Maintaining Activities
You can use the the following windows to maintain activities:

■ Operation Activity Line Summary to view a summary of a specific activity line 
including its description, process parameter, and factor. You can display the 
Operation Activity Line window from the Operation Activity Line Summary 
window.

■ Operation Activity Line to view and edit pertinent information that is relevant 
to a specific operation line selected.
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Defining and Maintaining Resources
You define and maintain resources on the Operation Activity window. Resources 
are the assets to produce batches, including production equipment, and employee 
labor. You can define each resource very generally, for example, OVENS, or 
specifically OVEN 1, OVEN 2 . . . OVEN n. For each resource assign a classification 
code for cost management purposes. You can group resources into resource 
classifications, for example, group OVENS and STOVES into COOKING UNITS.

Prerequisites
❏ Set up resources.

See Also
Oracle Process Manufacturing Cost Management User’s Guide

Attaching Resources to Activities
Attach resources that were created in setup to activities using the Operation 
Activity window.

Maintaining Resources
Use the the following windows to maintain resources:

■ Operation Resource Line Summary to view a summary of resource lines. You 
can display the Operation Resource Line window from the Operation Resource 
Line Summary window

■ Operation Resource Line to view and edit specific resource lines.
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Finding an Operation
The Find Operations window enables you to find a specific operation.

Prerequisites
❏ Enter and save operations.

◗◗ To find an operation:
1. Navigate to the Find Operations window.

2. Enter as many parameters as needed to complete the search:

■ Enter search parameters in the Standard region for: Operation, Version, 
Description, Class, Valid From date, Valid To date, Process Quantity, or 
Status.

■ Enter search parameters in the Advanced region for a specific: Item, 
Condition, or Value.

3. Click Find.

4. Review the results of the search.

5. Close the window.
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Displaying the Operations Summary
The Operations Summary By... window displays a list of all defined operations with 
their individual version numbers and validity rules, by class, owner, or status. 
Display the Operation Details Activities window to view specific activities 
associated with each of the operations.

You can use folders with this window. See: Oracle Applications User’s Guide.

Prerequisites
❏ Optionally, enter and save operation classes.

❏ Enter and save operations.

❏ Use the View By list to select how you want to view the summary of operations. 
Select one of the following:

■ Class to display the list by operation class.

■ Owner to display the list by owner.

■ Status to display the list by operation status.

◗◗ To display a list of all defined operations:
1. Navigate to the Operations Summary By... window.

2. The following fields are display only:

■ Operation is the name of the Operation.

■ Version is the version of the Operation.

■ Valid From is the date the Operation is effective.

■ Valid To is the date the Operation is no longer effective.

■ Description is a brief explanation of the Operation.

■ Class is the optional class of the Operation.

■ Minimum Transfer Quantity is for future use by the Oracle Advanced 
Planning and Scheduling application. It is intended to reduce overall lead 
times by defining the minimum amount of material that must be produced 
in a step at a specific production operation and resource before the next 
operation can begin. This reduces bottlenecks by letting processes transfer 
an interim quantity of completed material to the next step without the 
requirement to complete the entire step.
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■ Process Quantity UOM is the unit of measure for the process quantity 
associated with the Operation.

3. Click Details to display the Operation Details Activities window.

4. Close the window.
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Displaying the Operation Header Summary
The Operation Header Summary window displays important descriptive 
information on a specific operation. Use the Operation Details Activities window to 
enter, view, and edit an operation.

You can use folders with this window.

See: Oracle Applications User’s Guide.

Prerequisites
❏ Optionally, enter and save operation classes.

❏ Enter and save operations.

◗◗ To display a summary of the operation headers:
1. Navigate to the Operation Header Summary window.

2. Select the appropriate Operation.

3. The following fields are display only:

■ Status is the status of the Operation. Statuses are entered on the Operation 
Details Activities window.

■ Operation is the name of the Operation.

■ Version is the version of the Operation.

■ Description is a brief explanation of the Operation.

■ Class is the optional class assigned to the Operation.

■ Class Description is a brief description of the Class.

■ Valid From is the date the Operation is effective.

■ Valid To is the date the Operation is no longer effective.

■ Min Transfer Qty is for future use by the Oracle Advanced Planning and 
Scheduling application. It is intended to reduce overall lead times by 
defining the minimum amount of material that must be produced in a step 
at a specific production operation and resource before the next operation 
can begin. This reduces bottlenecks by letting processes transfer an interim 
quantity of completed material to the next step without the requirement to 
complete the entire step.
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■ Process Qty UOM is the unit of measure for the process quantity associated 
with this Operation.

4. Click Details to display the Operation Details Activities window.

5. Close the window.
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Entering Operation Activity Details
Operations are a combination of one or more activities performed in a production 
batch and the resources used to perform those activities. The Operation Details 
Activities window links operations to activities. Use the Activity Factor and 
activity-resource association to enter an activity several times within an operation. 
Activity Factor simplifies data entry of the same activity several times by defining 
the specific number of times that an activity is performed during an operation. 
Activity factor is taken into consideration for planning and resource calculation 
purposes. Display the Operation Activity window to link one or more resources to a 
single activity. Go to the Operation Activity Line Edit window to edit individual 
activity lines.

You have the ability to save an operation that contains activities with no associated 
resources as long as the operation status is New. Status cannot be changed to 
Approved for Laboratory Use or to Approved for General Use until all activities 
have resources associated to them.

Understanding Sequence Dependent Operations
Sequence dependency indicates that there is an additional setup time required 
when products are processed through each operation in a specific sequence.

eRecord and eSignature Approvals
There may be an eSignature event associated with this window. Refer to "Appendix 
D" for additional information on eRecord and eSignature approvals associated with 
this window.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Optionally, enter and save operation classes.

❏ Enter and save activities.

❏ Enter and save resources.

◗◗ To enter operation details and activities:
1. Navigate to the Operation Details Activities window.

2. Enter a name for the Operation to be entered. Required.
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3. After entering all relevant information and saving the Operation with the 
default Status of New, return to this window if you need to change Operation 
Status by selecting Change Status from the Actions menu. Depending on 
whether Workflow is enabled, a different set of statuses is available.

Select a Status for the Operation you are entering from one of the following:

■ Approved for Laboratory Use to indicate that the operation is approved for 
laboratory use.

■ Approved for General Use to indicate that the operation is approved for 
use in production.

■ Obsolete/Archived to indicate that the operation is no longer approved for 
use and is obsoleted, archived, or both.

If Workflow is enabled, when you select:

■ Approved for Laboratory Use, Status changes to Request Approval for 
Laboratory Use until all approvers have accepted the operation, when its 
Status changes to Approved for Laboratory Use.

■ Approval for General Use, Status changes to Request Approval for 
General Use until all approvers have accepted the operation, when its 
Status changes to Approved for General Use.

Refer to the Understanding the Status Approval Workflow topic for additional 
information.

4. Enter the Version number for this operation. The combination of operation 
number and version must be unique. Required.

5. Enter a brief Description for the Version entered. Required.

6. Enter a Class for this operation to identify how it is categorized. The Class 
Description assigned to the Class displays.

7. Enter a Valid From date as a validity rule for this operation. The default date is 
the current system date. Required.

8. Enter a To date as a validity rule for the expiration of this Operation. If there is 
no expiration date for this Operation, leave the field blank.

9. Enter the Owner Organization for this Operation. A Description of the Owner 
Organization displays.

10. Minimum Transfer Qty is for future use by the Oracle Advanced Planning and 
Scheduling application. It is intended to reduce overall lead times by defining 
the minimum amount of material that must be produced in a step at a specific 
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production operation and resource before the next operation can begin. This 
reduces bottlenecks by letting processes transfer an interim quantity of 
completed material to the next step without the requirement to complete the 
entire step.

11. Enter a Process Qty UOM for this Operation. Required.

Activities
12. Enter an Activity required for this Operation. A Description of this activity 

displays.

13. Enter the Activity Factor to specify the number of times the activity is 
performed in this Operation. Required.

For example, if a quality test must be performed at the beginning, middle, and 
end of a mixing time period, rather than defining the activity and associated 
resources three times, use the Activity Factor or multiplier to indicate the 
number of iterations for the same activity.

To indicate that the activity must be performed at the beginning, middle, and 
end of the mixing time period, enter a factor of 3. Factors are applied to usage of 
a resource when planning and calculating cost. Set the Activity Factor to zero to 
exclude a particular activity. You can also use this to select equipment used for a 
production run within this specific plant.

14. Sequence Dependency is selected when the activity has a sequence dependent 
setup. It is cleared when there is no sequence dependency.

15. Enter the Offset Interval as the time delay from the start of the activity to the 
point where the resource is actually required. Required.

16. Repeat steps 11 through 13 for each Activity you need to enter for the specified 
Operation.

17. Save the window.

18. Click Resources to display the Operation Activity window.

19. Optionally, click Edit Activity Line to display the Operation Activity Line 
Summary window.

◗◗ To mark the operation for deletion:
1. Choose Mark for Purge from the Actions menu.

2. The record is marked for deletion.
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3. Save the window.

◗◗ To edit operation text:
1. Choose Edit Text from the Actions menu.

2. Make the appropriate edits to operation text.

3. Save the window.

◗◗ To display the Specifications window:
1. Choose Specifications from the Actions menu. The Specifications window 

displays.

2. Evaluate specifications

3. Close the window.

◗◗ To display the Samples window:
1. Choose Samples from the Actions menu. The Samples window displays.

2. Evaluate the samples.

3. Close the window.

◗◗ To view alternate resources for the operation:
1. Choose Operation Alternate Resources from the Actions menu.

2. The window displays the alternate resources available to this Operation if any 
exist.

3. Close the window.

◗◗ To change the operation status:
1. Choose Change Status from the Actions menu.

2. Change the Current Status displayed by selecting a different Status from the 
Change Status To list.

3. Click OK.

4. The Operation Details Activities window displays the revised Status for the 
Operation.
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◗◗ To duplicate a record:
1. Query the Operation Details Activity record you want to duplicate.

2. Choose New from the File menu.

3. Choose Duplicate Record Above from the Edit menu.

4. Enter a new Operation name and Version number.

5. Click OK.

6. Save the window.

◗◗ To display the eRecord Details window:
1. Choose eRecord Details from the Actions menu. The eRecord Generic Query 

displays if this option is implemented in your application.

2. Refer to "Appendix D" for information on eRecords.

3. Close the window.

Using the View Menu to Find an Operation
The Find selection on the View menu lets you to find an operation.

◗◗ To find an operation from the View menu:
1. Choose Find from the View menu.

2. Enter one or more of these search parameters.

■ Status

■ Operation

■ Version

■ Description

■ Operation Class

■ Activity

■ Resource

■ Mark for Deletion

3. Click Find.
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Entering Activity-Resource Details
The Operation Activity window assigns resources to each activity, and lets you edit 
a resource line once activities are associated with an operation. You access this 
window when you click Resources on the Operation Details Activities window.

Charge calculates resource usage by capturing the number of passes required to 
process a step. This is based on the maximum capacity of the step as derived from 
specific resources used.

You can use flexfields with this window.

See: Oracle Applications User’s Guide.

Prerequisites
❏ Enter and save operations.

◗◗ To assign resources to an activity:
1. Navigate to the Operation Activity window.

2. Enter the Operation to associate activities. Required.

3. The Status assigned to the Operation displays.

4. The current Version number for the Operation displays.

5. Select the Activity to enter or edit a resource.

6. Click Resources.

Throughput
Process units of measure and usage units of measure are derived from the plant 
resource if one is defined. You can override these values using this window. A 
process quantity is converted to an operation process quantity unit of measure if 
needed.

7. The Resource and its Description displays.

8. Enter the planned Process Quantity for the Resource. Required.

This value combined with the Usage quantity define the usage rate. For 
example, if a resource can mix 200 gallons per hour, enter 200 as the Process 
Quantity, 1 as the Usage, and the unit of measure for hours.

9. The UOM entered on the header displays. This is the unit of measure for the 
planned process quantity.
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10. Enter the planned resource Usage. This is typically expressed in hours. 
Required.

11. Enter the UOM as the unit of measure for the Resource. Required.

Cost Information
12. The Resource and its Description displays.

13. Enter the Component Class code. The Component Class Description for the 
Resource displays. The Component Class is set up in the Cost Management 
application and defaults from the Resource. Required.

14. The Cost Analysis Code and Cost Analysis Description for the Activity 
displays. This code defaults from the Activity.

Scheduling Information
15. The Resource and its Description displays.

16. Select a Plan Type. You need to determine if this Resource is Auxiliary, Primary, 
or Secondary. Required.

■ Select Auxiliary for resources that work as companions with the primary 
resources to perform an activity in the Operation. These resources do not 
affect the rate of the Operation. For example, a primary resource in a mixing 
activity is a mixer with a throughput rate of 100 gallons per hour. An 
auxiliary resource is the worker who operates the mixer. No matter how 
fast or slow the worker is, the mixer rate remains at a constant 100 gallons 
per hour.

■ Select Primary to indicate that this is the rate determining resource. It limits 
or determines throughput. It is also referred to as the bottleneck or critical 
resource. There can only be one Primary per resource.

■ Select Secondary to indicate the resource that would replace the primary 
resource when it is not available. This resource performs the same task as 
the primary resource, but can have a different usage.

Required.

17. Enter the Count as the number of resources needed for the activity entered. For 
example, it two blenders are used for mixing, enter a 2 in the count. Required.

18. Enter the Offset Interval as the time delay from the start of the activity to the 
point where the resource is actually required.
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19. Select the Scale Type. You can designate whether scaling is used to determine 
resource quantity. Scaling is defined as the proportional increase or decrease of 
resources. For example, setup and cleanup activities are usually not scaled, 
while manufacturing activities are scaled.

■ Select Proportional Scaling if the resources change in a ratio that is 
proportional to the quantity of material being processed.

■ Select Fixed if the resources do not change, regardless of the quantity of 
material being processed.

■ Select Fixed By Charge if the resources change as a result of the number of 
charges specified.

20. Save the window.

◗◗ To edit a resource line:
1. Select the appropriate Resource line.

2. Click Edit Resource Line to display the Operation Resource Line Edit window.

3. Make the appropriate changes to the line.

4. Save the window.

◗◗ To display the Operation Resource Process Parameters window:
1. Click Parameters. The Operation Resource-Process Parameter window 

displays.

2. Refer to the "Displaying Operation Resource Process Parameters" topic for 
details.

3. Close the window.
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Displaying Operation Activity Line Summary
The Operation Activity Line Summary window presents all pertinent information 
that is relevant to a specific operation line selected. Use this window to edit the 
selected activity line. To edit this information click Details to display the 
Operation-Activity Line Edit window.

Refer to the Oracle Process Manufacturing Capacity Planning User’s Guide for a 
complete discussion of setting up process parameters.

Understanding Sequence Dependent Operations
Sequence dependency indicates that there is an additional setup time required 
when products are processed through each operation in a specific sequence.

You can use folders and flexfields with this window.

See: Oracle Applications User’s Guide and Oracle Applications Flexfields Guide.

Prerequisites
❏ Enter and save operations.

❏ Enter and save activities.

◗◗ To display information about an operation activity line:
1. Navigate to the Operation Activity Line Summary window.

2. The following fields are display only:

■ Activity indicates the activity selected for this Operation.

■ Description is a brief explanation of the activity.

■ Factor is the process factor entered for the activity. Required.

■ Offset Interval is the time required before the activity begins. In process 
operations, this is usually the number of hours from the batch step start to 
the start time of this activity.

3. Click Details to display the Operation Activity Line window.

4. Close the window.

◗◗ To edit an operation activity line:
1. Navigate to the Operation Activity Line window.

2. The following fields are display only:
4-22 Oracle Process Manufacturing Product Development User’s Guide



Displaying Operation Activity Line Summary
■ Activity displays the activity selected for the Operation. 

■ Description is a brief explanation of the activity.

3. Enter the Factor as the process factor for the activity. Required.

4. Enter the Offset Interval as the time delay from the start of the activity to when 
the resource is actually required.

5. Sequence Dependency is selected when the activity has a sequence dependent 
setup. It is cleared when there is no sequence dependency.

6. Save the window.
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Displaying the Resource Line Summary
The Operation Resource Line Summary window presents all pertinent information 
that is relevant to a selected operation-activity line.

Refer to the Oracle Process Manufacturing Capacity Planning User’s Guide for a 
complete discussion of setting up process parameters.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Enter and save operations.

❏ Enter and save activities. 

◗◗ To display the resource line summary:
1. Navigate to the Operation Resource Line Summary window.

Resource
2. The following fields are display only:

■ Resource displays the resource associated to the activity with its 
Description.

■ Quantity displays the process amount for the resource with Quantity UOM 
as its unit of measure.

■ Usage displays the rate of use for the resource. Usage UOM is the unit of 
measure for the resource. This is usually specified in hours.

■ Component Class and Class Description indicate the assigned component 
class for the resource.

■ Cost Analysis Code indicates the cost code assigned to the resource with its 
associated Cost Analysis Description.

■ Plan Type displays whether this resource is a primary, secondary, or 
auxiliary resource. Auxiliary indicates resources that work as companions 
with the primary resources to perform an activity in the Operation. Primary 
indicates a the rate determining resource. Secondary indicates the resource 
that would replace the primary resource when it is not available. This 
resource performs the same task as the primary resource, but can have a 
different usage.
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■ Count indicates the number or quantity of the resource used in the 
specified plant where you are defining production costs and usage 
availability.

■ Offset indicates the time delay from the start of the activity to the point 
where the resource is actually required. This lag time is used by Process 
Operation Control.

■ Scale Type displays which type of scaling is used to determine resource 
quantity. Proportional Scaling indicates the resources change in a ratio that 
is proportional to the quantity of material being processed. Fixed scale type 
indicates the resources do not change, regardless of the quantity of material 
being processed. Fixed By Charge indicates resources change as a result of 
number of charges specified. With this type of scaling:

Resource Usage = Count multiplied by Usage multiplied by Charges

Process Parameters
3. The following fields default from the process parameter set up in the planning 

application:

■ Seq is the sequence of the resource process parameter.

■ Parameter is the process parameter name. For example, Bath Temperature.

■ Target indicates the target value for the process parameter.

■ Minimum is the lowest acceptable value for a numeric range type of 
process parameter.

■ Maximum is the highest acceptable value for a numeric range type of 
process parameter.

■ Units is the unit of measure for the process parameter.

4. Close the window.

◗◗ To edit an operation resource line:
1. Click Details to display the Operation Resource Line window where you can 

edit individual resource lines.

2. Resource displays the resource associated to the activity and its Description.

3. Enter the Quantity as the process amount for the resource with Quantity UOM 
as its unit of measure. Required.

4. Quantity UOM displays the unit of measure for the resource. Required.
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5. Enter the Usage as actual usage of the resource for the line. Required.

6. Usage UOM displays the unit of measure for the resource. This is usually 
specified in hours.

7. Enter the Component Class code. The component Class Description displays. 
The Component Class is set up in the Cost Management application and 
defaults from the resource. Required.

8. Enter the appropriate Cost Analysis Code for the resource. Required.

9. Cost Analysis Description displays the description of the Cost Analysis Code 
field.

10. Enter the Plan Type as:

■ Auxiliary to indicate the resources that work as companions with the 
primary resources to perform an activity in the operation.

■ Primary to indicate the rate determining resource. There can only be one 
primary per resource.

■ Secondary to indicate the resource that would replace the primary if it were 
not available. This resource performs the same task as the primary, but can 
have a different usage.

Required.

11. Enter Count as the planned number of resources for the activity. Count 
indicates the number or quantity of the resource used in the specified Plant 
where you define production costs and usage availability. Required.

12. Enter Offset as the time delay from the start of the activity to the point where 
the resource is actually required. Required.

13. Enter Scale Type as the type of scaling used to determine resource quantity. 
Proportional Scaling indicates the resources change in a ratio that is 
proportional to the quantity of material being processed. Fixed scale type 
indicates the resources do not change, regardless of the quantity of material 
being processed. By Charge indicates resources change as a result of number of 
charges specified. With this type of scaling:

14. Resource Usage = Count multiplied by Usage multiplied by Charges

Process Parameters
15. The following fields default from the process parameter set up in the planning 

application:
4-26 Oracle Process Manufacturing Product Development User’s Guide



Displaying the Resource Line Summary
■ Seq is the sequence of the resource process parameter.

■ Parameter is the process parameter name. For example, Bath Temperature.

■ Target indicates the target value for the process parameter.

■ Minimum is the lowest acceptable value for a numeric range type of 
process parameter.

■ Maximum is the highest acceptable value for a numeric range type of 
process parameter.

■ Units is the unit of measure for the process parameter.

16. Click Reset Values to remove overrides set up for a process parameter. Refer to 
the "Displaying Operation Resource Process Parameters" topic for a complete 
discussion of this feature and the hierarchy that is enforced.

17. Save the window.
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Editing a Resource Line
The Operation Resource Line window enables you to edit resource lines.

Refer to the Oracle Process Manufacturing Capacity Planning User’s Guide for a 
complete discussion of setting up process parameters.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Enter and save operations.

❏ Enter and save activities. 

◗◗ To edit a resource line:
1. Navigate to the Operation Resource Line window.

Resource
2. Resource and its Description indicate the resource you are editing.

3. Enter the appropriate process Quantity. Required.

4. The Quantity UOM displays for the process quantity entered.

5. Enter the Usage as the rate of use for the Resource. This value is usually 
expressed in hours or partial hours. For example, one hour and 15 minutes 
would be entered as 1.25. Required.

Resource Usage = Count multiplied by Usage multiplied by Charges

6. Enter the Usage UOM as the unit of measure the resource is measured in the 
specified plant. This is usually specified in hours. Required.

7. Enter the Component Class. The Class Description assigned to the Component 
Class displays. Required.

8. Enter the appropriate Cost Analysis Code for the resource. Required.

9. The Cost Analysis Descriptor associated with the Cost Analysis Code displays.

10. Plan Type indicates whether this Resource is an auxiliary, primary, or 
secondary resource.

■ Select Auxiliary for resources that work as companions with the primary 
resources to perform an activity in the Operation. These resources do not 
affect the rate of the Operation. For example, a primary resource in a mixing 
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activity is a mixer with a throughput rate of 100 gallons per hour. An 
auxiliary resource is the worker who operates the mixer. No matter how 
fast or slow the worker is, the mixer rate remains at a constant 100 gallons 
per hour.

■ Select Primary to indicate that this is the rate determining resource. It limits 
or determines throughput. It is also referred to as the bottleneck or critical 
resource. It is recommended that the RUN-TIME activity’s resource be 
assigned this way.

■ Select Secondary to indicate the resource that would replace the primary 
resource when it is not available. This resource performs the same task as 
the primary resource, but can have a different usage.

These fields are read only.

11. Enter the appropriate Count. This is the number or quantity of the resource 
used in the specified plant where you are defining production costs and usage 
availability. The number you enter depends on how broad a resource 
categorization you are defining. For example, if you define the resource as 
Blender 1, enter 1. If you use three blenders in the production line, and you 
define the resource as Blenders rather than defining each individually, enter 3. 
Required.

12. Enter the appropriate Scale Type. You can designate whether scaling is used to 
determine resource quantity. Scaling is defined as the proportional increase or 
decrease of resources. For example, setup and cleanup activities are usually not 
scaled, while manufacturing activities are scaled. This field defaults to Linear 
scaling.

■ Select Proportional if the resources change in a ratio that is proportional to 
the quantity of material being processed.

■ Select Fixed if the resources do not change, regardless of the quantity of 
material being processed.

■ Select Scale by Charge if the resources are scaled by charges.

13. Enter the appropriate Offset as the time delay from the start of the activity to 
the point where the resource is actually required. This lag time is used by 
Process Operation Control.

Process Parameters
14. The following fields default from the process parameter set up in the planning 

application:
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■ Seq is the sequence of the resource process parameter.

■ Parameter is the process parameter name. For example, Bath Temperature.

■ Target is the target value for the process parameter.

■ Minimum is the lowest acceptable value for a numeric range type of 
process parameter.

■ Maximum is the highest acceptable value for a numeric range type of 
process parameter.

■ Units is the unit of measure for the process parameter.

15. Click Reset Values to remove overrides set up for a process parameter. Refer to 
the "Displaying Operation Resource Process Parameters" topic for a complete 
discussion of this feature and the hierarchy that is enforced.

16. Save the window.
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Displaying Operation Resource Process Parameters
Process parameters are a component of the process instructions necessary to run 
resources during the batch process. They are usually machines or instruments and 
are the standard for executing a task. They can be generic or specific. Each industry 
and company uses different machines and instruments, and there are different 
requirements for recording process parameters.

A process parameter details information such as temperature, pressure, or time that 
is pertinent to the product, but does not fall into the classification of input or 
output. You can use process parameters as set points, comparison values, or in 
conditional logic.

You can use folders with this window.

See: Oracle Applications User’s Guide and Oracle Flexfields User’s Guide.

Prerequisites
❏ Set up process parameters.

Refer to the Oracle Process Manufacturing Capacity Planning User’s Guide for a 
complete discussion of setting up process parameters.

◗◗ To display the Operation-Resource Process Parameters window:
1. Navigate to the Operation-Resource Process Parameters window.

2. The following fields are display only:

■ Operation displays the operation with its Version and Description.

■ Activity displays the activity related to the step and its Description.

■ Resources displays the resource attached to the activity and its 
Description.

Parameter Values
3. The following fields default from the process parameter set up in the planning 

application:

■ Seq is the sequence of the resource process parameter.

■ Parameter is the process parameter name. For example, Bath Temperature.

■ Minimum is the lowest acceptable value for a numeric range type of 
process parameter.
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■ Maximum is the highest acceptable value for a numeric range type of 
process parameter.

■ Units is the unit of measure for the process parameter.

4. Click OK to close the window.

◗◗ To reset values based on the hierarchy:
You can override certain process parameters at the operation and recipe levels. Click 
Reset Values to remove overrides set up for a process parameter. The following 
illustrates how the process parameter is reset.

The hierarchy is:

■ Recipe

■ Operation

■ Default value from the planning application

For example, if the default for a process parameter from the planning application is 
set to 10, you can override it at the operation level and at the recipe level. The 
following values are used for illustration:

■ Recipe = 20

■ Operation = 15

■ Default value from the planning application = 10

If you click Reset Values for the process parameter on the:

■ Recipe Details window, then the process parameter value changes from 20 to 15, 
the next step down in the hierarchy.

■ Operation Activity Details window, then the process parameter value changes 
from 15 to 10.

If no override exists at the operation level, and you click Reset Values at the recipe 
level, then the process parameter value changes to 10, which is the original default 
value from the planning application.
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Routings

This topic shows you how to define and maintain routings. You are also shown how 
to find a routing. A summary of routings and routing headers provides an overview 
of the routings that are available. The processes of entering routing details and 
displaying the routing step line summary are explained. You are also shown how to 
edit routing step lines, and how to enter routing step dependencies. Procedures for 
displaying and editing theoretical process loss are provided.

The following topics provide a basic understanding of routings:

■ Understanding Routings

■ Requirements

■ Solutions

■ Defining and Maintaining Routings

■ Finding a Routing

■ Displaying the Routings Summary

■ Displaying the Routing Header Summary

■ Entering Routing Details

■ Displaying the Routing Step Line Summary

■ Editing Routing Step Lines

■ Entering Routing Step Dependencies

■ Displaying Theoretical Process Loss

■ Editing Theoretical Process Loss
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■ Understanding the Routing Designer

■ Using the Routing Designer
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Understanding Routings
A routing is a sequenced set of operations that need to be performed to complete a 
production batch. The operations are presented in a series of steps that organize 
these operations into an orderly set of activities that have individual resources 
associated to them.

Routings are depicted hierarchically in the following diagram which shows the:

■ Routing composed of a series of Operations organized in Steps.

■ Operations composed of Activities containing Resources.

■ Formula composed of Ingredient, Product, and possibly Byproduct.

■ Recipe linking the Routing and Formula together with Processing Instructions.
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Requirements
Following are some requirements that customers have for routings in Product 
Development. The answers are explained in detail in the Solutions topic.

Can a default routing be set up?
Yes. Set up a default routing with average material. Material flow can be specified at 
the validity rule level. By having a default routing, the expected average material 
throughput is defined as a benchmark.

Can process loss be captured as a cost?
Yes. Use Theoretical Process Loss to reflect a planned percentage of material that is 
lost for a specific routing. Calculate the actual ingredient usage from a production 
perspective, which accommodates for that loss in standard costing.

Does the application support automatic calculation of step quantities 
based on material input and output?
Yes. The application automatically calculates step quantities based on the amount of 
materials input and output for each step.

Can manufacturing activities and routings be managed on the 
manufacturing floor?
Yes. The Process Engineer workbench manages routings, operations, and recipes at 
the shop floor level.

Is it possible to model when ingredients are relieved from inventory?
Yes. The application provides three separate methods to update inventory: 
automatic release, manual release, and incremental release.
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Solutions
Product Development provides solutions to help resolve issues at every stage of the 
product development process. The following represent some of the key 
performance solutions for routings.

Operations Throughput Enhanced by Default Routings  Process speeds and feeds must be 
updated at the item or step level to eliminate the need to have a unique routing 
whenever the throughput varies by material viscosity or evaporation. Set up a 
default routing with an average material throughput, while indicating 
material-specific flows at the validity rule level. By locating routing management in 
this area, the larger corporate process engineering responsibilities are better defined 
and controlled.

Process Loss Factors Enable Better Material Planning  Due to factors such as evaporation 
or changeovers, materials can be lost or unrecoverable in a production step. These 
lost materials need to be planned for to achieve the targeted process quantity for a 
step. The loss can vary depending on the material being processed, therefore a 
production loss factor must be defined at a product operation level, and it must be 
reflected in production and planning for ingredients associated to the step. Product 
Development allows entry of a process loss factor to enable better material 
planning.

Step Quantity Calculations Deliver Accurate Total Quantity Usage  All step quantities are 
calculated based on the routing step definitions and ingredient usage per step. 
Quantities are cumulative in that ingredients in step one are added to ingredients in 
step two. When byproducts or coproducts are yielded at the step they decrease the 
total step quantity. Product Development accounts for this yield to deliver an 
accurate total step usage.

Seamless Integration of Product Development Responsibilities  In addition to the default 
Recipe Data Organizer, the Process Engineer can manage all routings, operations, 
and recipes as part of a seamless integration of all pertinent job functions on the 
shop floor.

Select the Appropriate Ingredient Release Method  Release method specification enables 
the automatic release of ingredients after each step is completed, on a step by step 
basis using manual release, or using an incremental release to keep inventory 
quantities current.
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Defining and Maintaining Routings
Routings are defined in terms of operations. You enter and maintain the sequence of 
operations and step quantities used in a routing. Define multiple versions for a 
routing that makes the same product to accommodate for several production lines 
with differing characteristics. Since routings and operations are modeled into the 
structure of a new recipe, several attributes are defined at the recipe level, including 
planned process loss, step quantity, capacity, and activity factor.

Since a single product can be associated with several routings on the manufacturing 
floor, it can have different costs depending on the specified routing. Product 
Development tracks the route that the ingredients follow, thereby tracking 
appropriate costs.

Creating a New Routing
Create and define new routings on the Routing Details window. A routing 
represents the sequence of operations or steps used during the manufacturing 
process. Specify each of the operations in sequential order, with their respective step 
quantities, and total routing quantities. You can display the following windows 
from the Routing Details window:

■ Operation Details Activities

■ Routing Step Dependencies

■ Routing Step Line

Maintaining Routings
Use the following windows to maintain routings:

■ Routings Summary By... to display a list of defined routings with their 
individual version numbers and descriptions. These can be viewed by Class, 
Status, or Owner. You can display the Routing Details window from the 
Routings Summary By... window.

■ Routing Header Summary to display important descriptive information on a 
specific routing. You can display the following windows from the Routing 
Header Summary window:

■ Routing Details

■ Theoretical Process Loss
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■ Routing Step Line Summary to determine the step number, operation, step 
quantity, and unit of measure for the step in a specific routing. You can display 
the Routing Step Line window from the Routing Step Line Summary window:

■ Routing Step Dependencies to create and modify the interrelationships between 
routing steps. Step dependencies are those relationships between steps that 
establish whether a specific step can or cannot start until another step is 
completed.

■ Theoretical Process Loss to enter the theoretical percent loss expected for a 
range of material processed during a specified routing.

■ Routing Step Line to edit individual routing step lines.

The following graphic depicts the previously described routing navigation flow:
Routings 5-7



Finding a Routing
Finding a Routing
The Find Routings window enables you to find a specific routing.

Prerequisites
❏ Enter and save routings.

◗◗ To find a routing:
1. Navigate to the Find Routings window.

2. Enter as many parameters as needed to complete the search:

■ Enter search parameters in the Standard region for: Name, Version, 
Description, Class, or Product.

■ Enter search parameters in the Advanced region to enter a specific: Item, 
Condition, or Value.

3. Click Find.

4. Review the results of the search.

5. Close the window.
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Displaying the Routings Summary
The Routing Summary window displays a list of all defined routings with their 
individual version numbers and descriptions. You can view these by Class, Status, 
or Owner. You can display the Routing Details window from this window to view 
specific steps and operations associated with each of the routings displayed.

You can use folders with this window. See: Oracle Applications User’s Guide.

Prerequisites
❏ Optionally, enter and save routing classes.

❏ Enter and save routings.

❏ Use the View By list to select how you want to view the summary of routings. 
Select one of the following:

■ Class to display the list by routing class.

■ Status to display the list by routing status.

■ Owner to display the list by routing owner.

◗◗ To display a list of all defined routings:
1. Navigate to the Routings Summary By... window.

2. The following fields are display only:

■ Routing displays the name of the routing.

■ Version displays the version number of the Routing.

■ Quantity displays the product Quantity associated with this Routing. This 
is the total Quantity from which individual step requirements are scaled.

■ UOM displays the unit of measure for the Quantity. This unit of measure 
defaults from the process Quantity unit of measure entered on the 
Operation Details Activities window.

■ Class displays the optional class entered for the Routing.

■ Valid From displays the date on which the Routing is effective.

■ Valid To displays the date on which the Routing is no longer effective.

■ Status displays the current status of the Routing.
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3. Click Details to display the Routing Details window.

4. Close the window.
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Displaying the Routing Header Summary
The Routing Header Summary window displays important descriptive information 
on a specific routing.

You can use folders with this window. See: Oracle Applications User’s Guide.

Prerequisites
❏ Optionally, enter and save routing classes.

❏ Enter and save routings.

◗◗ To display a summary of routing headers:
1. Navigate to the Routing Header Summary window.

2. Select the desired Routing.

3. The following fields are display only:

■ Status displays the approval status of the Routing.

■ Routing displays the code assigned to the Routing.

■ Version displays the version number of the Routing.

■ Description displays a brief explanation of the Routing.

■ Valid From displays the date on which the Routing is effective.

■ Valid To displays the date on which the Routing is no longer effective.

■ Class determine the optional class assigned to the Routing.

■ Class Description determine the optional class description assigned to the 
Routing.

■ Theoretical Loss displays the theoretical quantity of material lost in the 
Routing.

■ Planned Loss displays actual quantity of material lost in the Routing.

■ Quantity displays the amount of material assigned to the displayed 
Routing.

■ UOM displays the unit of measure for the Quantity of material.

■ Owner displays the initiator of the Routing.

4. Click Details to display the Routing Details window.
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5. Click Theoretical Process Loss to display the Theoretical Process Loss window.

6. Close the window.

Using the View Menu to Find a Routing
The Find selection on the View menu enables you to find a routing.

◗◗ To find a routing from the View menu:
1. Choose Find from the View menu. The Find Routings window displays.

2. Enter one or more of these search parameters:

■ Status of the Routing.

■ Routing Number code assigned to the Routing.

■ Routing Version number assigned to the Routing.

■ Description of the Routing.

■ Routing Class assigned for classification of the Routing.

■ Valid From date that the Routing is effective.

■ To date that the Routing is no longer effective.

■ Owner or initiator of the Routing.

■ Routing Quantity as the amount of material assigned to the Routing in the 
displayed unit of measure.

■ UOM as the unit of measure for the Routing Quantity.

■ Process Loss as the planned loss of material for the Routing. 

■ Marked for Deletion enables you to select Yes to find routings marked for 
purge or select No to find all routings not marked for purge.

3. Click Find.
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Entering Routing Details
The Routing Details window enables you to enter the details for a specific routing.

Understanding the Enforce Step Dependency Indicator
When Enforce Step Dependency is selected, several business rules are applied:

■ The Release Type field is set to Manual to indicate that the step must be released 
and completed manually.

■ You cannot change the step dependency and step release type at the step level.

■ All steps must be completed before you can complete a batch using this routing.

■ All steps must be closed before you can close a batch using this routing.

■ Business rules validate step start and completion dates and times for 
appropriate batch step rescheduling.

Refer to the "Understanding Batches" topic in Oracle Process Manufacturing Process 
Execution User’s Guide for a complete discussion of how this indicator affects batch 
steps.

eRecord and eSignature Approvals
There may be an eSignature event associated with this window. Refer to "Appendix 
D" for additional information on eRecord and eSignature approvals associated with 
this window.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Optionally, enter and save routing classes.

◗◗ To enter routing details:
1. Navigate to the Routing Details window.

2. Enter the code for the Routing. Required.

3. Enter a Routing Version of the Routing. Required.

4. After entering all relevant information and saving the Routing with the default 
Status of New, return to this window if you need to change Routing Status by 
selecting Change Status from the Actions menu. Depending on whether 
Workflow is enabled, a different set of statuses is available.
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Select a Status for the Routing you are entering from one of the following:

■ Approved for Laboratory Use to indicate that the Routing is approved for 
laboratory use.

■ Approved for General Use to indicate that the Routing is approved for use 
in production.

■ Obsolete/Archived to indicate that the Routing is no longer approved for 
use and is obsoleted, archived, or both.

If Workflow is enabled, when you select:

■ Approved for Laboratory Use, Status changes to Request Approval for 
Laboratory Use until all approvers have accepted the Routing, at which 
time its Status changes to Approved for Laboratory Use.

■ Approval for General Use, Status changes to Request Approval for 
General Use until all approvers have accepted the Routing, at which time 
its Status changes to Approved for General Use.

Refer to the Understanding the "Status Approval Workflow" topic for 
additional information.

5. Enter a Routing Description that briefly describes the Routing. Required.

6. Enter a Class for the Routing to identify how it is categorized. The Class 
Description assigned to the Class displays.

7. Enter the Valid From date for this Routing. The default date is the current 
system date. Required.

8. Enter a To date for the expiration of this Routing. If there is no expiration date 
for this Routing, leave the field blank.

9. Enter the process Quantity for this Routing. This is the total quantity of 
material for the Routing, and is used to scale individual step requirements. 
Required.

10. Enter the process Quantity UOM associated with this Routing. The process 
Quantity UOM must interconvert with the UOM defined for Theoretical 
Process Loss based on the primary product UOM conversion in the Routing. 
Required.

11. Enter the Planned Loss for this Routing. This value is expressed as a percent. 
For example, a loss of 1.304% would be entered as 1.304.
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12. The Theoretical Process Loss for this Routing displays. This value is entered on 
the Theoretical Process Loss window, and is based on the value assigned to the 
Class associated with this Routing.

13. Enter the Owner to indicate the individual who is responsible for initiating this 
Routing. Required.

14. Enter the Owner Organization to indicate the plant, laboratory, or other facility 
that is responsible for initiating this Routing. Required.

15. Enforce Step Dependency is:

■ Selected when the routing enforces step dependency.

■ Cleared when the routing does not enforce step dependency.

Routing Steps
16. Enter the Step number to associate with an Operation in this Routing. It is 

recommended that the first number in this sequence be 10, the second 20, and 
so forth. This enables you to add intermediate steps between 10 and 20 at a later 
time. Required.

17. Enter the code for the Operation performed in this Routing. Required.

18. Enter a Version number for the Routing. Required.

19. The Description of the Operation entered displays.

20. Enter the Operation Step Quantity as the quantity of material associated with 
this Step. The UOM for the Step Quantity displays.

21. Min Transfer Qty is for future use by the Oracle Advanced Planning and 
Scheduling application. It is intended to reduce overall lead times by defining 
the minimum amount of material that must be produced in a step at a specific 
production operation and resource before the next operation can begin. This 
reduces bottlenecks by letting processes transfer an interim quantity of 
completed material to the next step without the requirement to complete the 
entire step.

22. Select the Release Type to indicate how the step is released as:

■ Automatic if the step is automatically released or completed when 
subsequent steps are released or completed.

■ Manual if the step must be released and completed manually.

All steps are completed if the batch is completed, regardless of the step release 
type. Required.
Routings 5-15



Entering Routing Details
23. Save the window.

24. Optionally, click Step Dependencies to display the Routing Step 
Dependencies window.

25. Optionally, click Edit Operation to display the Operation Details Activities 
window.

26. Optionally, click Edit Step Line to display Routing Step Line window.

◗◗ To mark the routing for deletion:
1. Choose Mark for Purge from the Actions menu.

2. The record is marked for deletion.

3. Save the window.

◗◗ To edit the routing text:
1. Choose Edit Text from the Actions menu.

2. Make the appropriate edits to routing text.

3. Save the window.

◗◗ To display the Specifications window:
1. Choose Specifications from the Actions menu. The Specifications window 

displays.

2. Evaluate specifications.

3. Close the window.

◗◗ To display the Samples window:
1. Choose Samples from the Actions menu. The Samples window displays.

2. Evaluate the samples.

3. Close the window.

◗◗ To change the routing status:
1. Choose Change Status from the Actions menu.

2. Change the Current Status displayed by selecting a different Status from the 
Change Status To list.
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3. Click OK.

4. The Routing Details window displays the revised Status for the routing.

◗◗ To generate step dependencies:
1. Position the cursor in the routing header.

2. Choose Generate Step Dependencies from the Actions menu. A message 
displays to indicate that the dependencies have been generated.

3. Click OK.

4. Select the dependent Step.

5. Click Routing Step Dependencies. The Routing Step Dependencies window 
displays. Enter data as described in the "Entering Routing Step Dependencies" 
topic.

◗◗ To duplicate a record:
1. Query the Routing Details record you want to duplicate.

2. Choose New from the File menu.

3. Choose Duplicate Record Above from the Edit menu.

4. Enter a new Routing name and Version number.

5. Save the window.

◗◗ To display the eRecord Details window:
1. Choose eRecord Details from the Actions menu. The eRecord Generic Query 

displays if this option is implemented in your application.

2. Refer to "Appendix D" for information on eRecords.

3. Close the window.
Routings 5-17



Displaying the Routing Step Line Summary
Displaying the Routing Step Line Summary
The Routing Step Line Summary window enables you to determine the step 
number, operation, step quantity, and unit of measure for the step in a specific 
routing. You can go to the Routing Step Line window to edit individual lines.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Optionally, enter and save routing classes.

❏ Enter and save routings.

◗◗ To display the routing step summary:
1. Navigate to the Routing Step Line Summary window.

2. The following fields are display only:

■ Step Number displays the unique number for the step.

■ Operation displays the name of the operation associated with the Step 
Number.

■ Operation Version displays the version number of the Operation.

■ Operation Description displays a description of the Operation.

■ Step Quantity displays the quantity of material being processed by this 
step.

■ UOM displays the unit of measure associated with the Step Quantity.

■ Minimum Transfer Qty is for future use by the Oracle Advanced Planning 
and Scheduling application. It is intended to reduce overall lead times by 
defining the minimum amount of material that must be produced in a step 
at a specific production operation and resource before the next operation 
can begin. This reduces bottlenecks by letting processes transfer an interim 
quantity of completed material to the next step without the requirement to 
complete the entire step.

■ Step Release Type determines how the step is released, and displays:

– Automatic if the step is automatically released or completed when 
subsequent steps are released or completed.

– Manual if the step must be released and completed manually.
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All steps are completed if the batch is completed, regardless of the step 
release type.

3. Click Edit Line to display the Routing Step Line window to edit individual 
steps.

4. Close the window.
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Editing Routing Step Lines
The Routing Step Line window enables you to edit individual step lines.

Prerequisites
❏ Optionally, enter and save routing classes.

❏ Enter and save routings.

◗◗ To edit routing steps:
1. Navigate to the Routing Step Line window.

2. Enter the desired Step Number. This number must be unique.

3. Enter the desired Operation to be associated to the Step Number displayed. 
Required.

4. Enter the desired Operation Version. Required.

5. The Operation Description displays.

6. Enter the desired Step Quantity. Required. The UOM displays the unit of 
measure for Step Quantity.

7. Minimum Transfer Qty is for future use by the Oracle Advanced Planning and 
Scheduling application. It is intended to reduce overall lead times by defining 
the minimum amount of material that must be produced in a step at a specific 
production operation and resource before the next operation can begin. This 
reduces bottlenecks by letting processes transfer an interim quantity of 
completed material to the next step without the requirement to complete the 
entire step.

8. Select the Step Release Type to indicate how the routing step is released:

■ Automatic if the step is automatically released or completed when 
subsequent steps are released or completed.

■ Manual if the step must be released and completed manually.

All steps are completed if the batch is completed, regardless of the step release 
type. Required.

9. Save the window.
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Entering Routing Step Dependencies
The Routing Step Dependencies window enables you to create and modify the 
interrelationships between routing steps. Step dependencies are those relationships 
between routing steps that establish whether a specific step can or cannot start until 
another step is completed. Routing Step Dependencies reduce the routing 
development time by establishing a default sequence for operation steps during a 
production run. Step dependencies are implemented at the routing maintenance 
level to enable automatic step quantity calculation in recipes.

You are able to define new dependencies or delete the ones you do not want. For 
example, if step 10 is BAKING and step 20 is the COOLING step, then step 10 must 
be completed before step 20 can begin. By this definition, step 20 is dependent on 
the completion of step 10. Step dependencies are used to calculate planned start 
times however, they can be overwritten.

Any previous step must be validated against any routing currently being edited, 
and it must not be the same as the current step. Avoid defining circular references, 
for example Step 10 is less than Step 20 is less than Step 10.

Understanding Routing Step Dependency Selections
Step Dependencies are definable as:

■ Finish-to-start with no offset, to indicate that a process step begins immediately 
after the completion of its preceding step. For example, a consecutive addition 
of ingredients is required without interruption.

■ Finish-to-start with positive offset, to indicate that a process step begins a 
specified period of time after the completion of its preceding step. For example, 
time is required to rest material before the addition of another ingredient. 

■ Finish-to-start with negative offset, to indicate that a process step begins a 
specified period of time before the completion of its preceding step. For 
example, a production device needs to be activated before the addition of the 
next ingredient.

■ Start-to-start with no offset, to indicate that a process step begins at the same 
time as the step it depends on. For example, there is a need for simultaneous 
addition of ingredients without interruption.

■ Start-to-start with positive offset, to indicate that a process step begins a 
specified time after the beginning of its preceding step. This is similar to 
finish-to-start with negative offset, but by specifying that the dependency is 
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start-to-start, you can ensure the positive offset is maintained if the previous 
dependent step finishes early.

The offset is defined in the Standard Delay field as a positive or negative number. 
The application uses step dependencies when individual steps are rescheduled.

You can use folders with this window. See: Oracle Applications User’s Guide.

Prerequisites
❏ Enter and save routings.

❏ Select a routing step to enter step dependencies.

◗◗ To enter routing step dependencies:
1. Navigate to the Routing Step Dependencies window.

2. The following fields are display only:

■ Routing displays the routing in which you want to set up step 
dependencies.

■ Routing Version number displays the version of the Routing.

■ The Routing Description displays a brief explanation of the Routing.

■ Routing Step displays the step number you selected for step dependency 
setup.

■ Operation displays the operation associated with the Routing.

■ Operation Version displays the version number of the Operation.

■ Operation Description describes the Operation associated with the 
Routing.

Dependencies
3. Enter the Previous Step that the currently selected step is dependent on. The 

dependent step must immediately follow the Routing Step entered in this field. 
Required.

4. The Operation associated with the Routing Step displays.

5. The Version of the Operation associated with the Routing Step displays.

6. Select Dependency Type as:
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■ Start-to-start if the dependent step starts at the same time as the step on 
which it is dependent.

■ Finish-to-start if the dependent step starts after the previous step ends. For 
example, when Step 2 is dependent on Step 1 and there is no specified 
offset, Step 2 is scheduled to start when Step 1 finishes. If an offset of one 
hour is specified, Step 2 is scheduled to start one hour after Step 1 ends. You 
create overlapping steps by defining an Finish-to-start dependency with a 
negative offset so that Step 2 starts before step 1.

Required.

7. Enter the Standard Delay as the standard number of hours from the end of the 
preceding step to the start of the current step, or the start of the preceding step 
to the start of the current step, depending on the Dependency Type entered. 
This field is used to calculate step start times. If you enter a value equal to zero, 
the step following the current step begins immediately after the step ends or 
starts. You can enter a negative Standard Delay if the Dependency Type is 
Finish-to-start in order to create overlapping steps. Required.

8. Enter the Transfer Percent as the percentage of material that goes to the 
dependent step after all products and byproducts are yielded. This percentage 
is used to calculate the quantity of the dependent step if automatic step 
quantity calculations are on. For example:

■ If 40 percent of the material from the Previous Step comes into the current 
Batch Step as a result of 60 percent of the material going to another step, 
enter 40 for the Transfer Percent.

■ If 90 percent of the material from the Previous Step comes into the current 
Batch Step as the result of 10 percent being lost to evaporation or being 
retained by processing equipment, enter 90 for the Transfer Percent. 
Required.

9. Save the window.
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Displaying Theoretical Process Loss
Theoretical Process Loss can vary depending on the routing or the individual 
quantity being processed by a routing. This loss is defined at the routing level and is 
based on a minimum and maximum range of quantities.

The Theoretical Process Loss window enables you to enter the theoretical percent 
loss expected for a range of material processed during a specified routing. For 
example, if you mix a quantity of material up to 100 pounds, you could predict a 
loss of 1.50 percent theoretical process loss, or up to 1.5 pounds is lost. However, if 
you mixed a quantity between 100 and 500 pounds, you might predict a loss of 1.75 
percent theoretical process loss, or up to 8.75 pounds lost. The loss could be 
attributable to equipment, evaporation, or any other aspect of the routing that 
would not deliver the full quantity of material added.

Prerequisites
❏ Enter and save routings.

❏ Enter and save routing classes.

❏ Optionally, enter and save routing step dependencies.

◗◗ To display theoretical process loss:
1. Navigate to the Theoretical Process Loss window.

2. The following fields are display only:

■ Routing Class displays the optional class assigned to the Routing.

■ Description displays a brief description of the Routing Class.

Theoretical Process Loss
3. The following fields are display only:

■ Min Quantity displays the lower limit for which the displayed Theoretical 
Process Loss percent applies. Required.

■ Max Quantity displays the upper limit for which the displayed Theoretical 
Process Loss percent applies. Required.

■ UOM displays the unit of measure for the minimum and maximum 
quantities.

■ Process Loss displays the loss of process material for a range between the 
Min Quantity lower limit and Max Quantity upper limit.
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Editing Theoretical Process Loss
The Theoretical Process Loss Edit window lets you edit Theoretical Process Loss.

Prerequisites
❏ Enter and save routings.

❏ Enter and save routing classes.

❏ Optionally, enter and save routing step dependencies.

◗◗To edit theoretical process loss: 

1. Navigate to the Theoretical Process Loss window.

2. Query the desired routing Class.

3. Enter the desired Min Quantity to specify the lower limit for which the 
displayed Theoretical Process Loss percent applies.

4. Enter the desired Max Quantity to specify the upper limit for which the 
displayed Theoretical Process Loss percent applies.

5. Enter the Theoretical Process Loss as a percent. For example, enter 1.32 for a 
Theoretical Process Loss of 1.32 percent.

6. Save the window.
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Understanding the Routing Designer
The step dependency capability that is available on the Routing Details window lets 
you establish the sequences in which routing steps occur throughout a production 
run. By establishing step dependency sequences, routing step quantities in the 
recipe are calculated automatically after the material and step associations are 
defined.

The Routing Designer lets you define routing step dependencies using a visual 
network of operations, steps, and activities. All the functions that the Routing 
Designer performs are accessible using the Routing Details window. The Routing 
Designer provides an alternate, and more intuitive option that can reduce routing 
development time.

The Routing Designer is one component of the Recipe Designer. It displays routing 
steps in a hierarchical navigator structure. The Routing Designer can be used alone 
or in conjunction with the Recipe Designer.

The Routing Designer provides a view of routing steps in three navigator style 
display formats:

■ Interleaved style, which positions operations, activities, and resources in a 
left-to-right orientation for each routing with spatial adjustment for each 
component.

■ Organization chart style, which positions operations, activities, and resources in 
a top-to-bottom orientation for each routing with spatial adjustment for each 
component as in an organization chart.

■ Vertical style, which positions operations, activities, and resources in a 
left-to-right orientation for each routing with no spatial adjustment for each 
component.

The drag-and-drop operation lets you organize the step network to get a better view 
of the sequence in which steps are run.

Understanding Step Dependency Type Connections
The Connect button lets you connect routing steps to develop a routing step 
network. The shape and color of the line that connects two steps determine the 
relationship between the two steps.

Two step dependency types are:

■ Finish-to-start, represented by a black, single segment, line connection. The line 
originates at the end of an upstream step and points to the start of the 
downstream step. The finish-to-start connection indicates the serial property of 
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the connected steps, since one step must complete before the step following it 
can start.

■ Start-to-start, represented by a blue, multisegment, connection line. The line 
originates at the start of the upstream step and points to the start of the 
downstream step. The start-to-start connection indicates the parallel property of 
the connected steps, since both steps start simultaneously.
Routings 5-27



Using the Routing Designer
Using the Routing Designer
The Routing Designer has two component panes:

■ A navigator view of the routing. You can display or hide routing descriptions 
on the navigator. You can expand components on the navigator by clicking the 
+ sign, or you can collapse components on the navigator by clicking the - sign. 
Routing components include operations arranged in steps, activities, and 
resources.

■ A routing graph view of the routing step dependencies. Each routing displayed 
in the pane is composed of a routing icon, step number, and routing code.

The Routing Designer lets you view or update a routing depending on the 
privileges assigned to you.

Prerequisites
❏ Enter and save operations.

❏ Enter and save activities.

◗◗ To display a routing in the routing designer:
1. Navigate to the Routing Designer. The Find Routings dialog box displays.

2. Click the Standard or the Advanced tab.

Standard
3. Enter any of the following to narrow your search:

■ Routing is the name of the routing.

■ Version is the version of the routing.

■ Description is a brief description of the routing.

■ Class is the class assigned to the routing.

■ Valid From is the first date and time that the routing is valid.

■ Valid To is the last date and time that the routing is valid.

■ Process Quantity is the planned quantity of material to be processed by the 
resource. This value combined with the usage defines the usage rate.

■ Status is the status of the routing.
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Advanced
4. In an advanced search of routings select any of the following conditions for one 

or more Items entered:

■ Equal To finds targets equal to the specified Value entered.

■ Greater Than finds targets greater than the specified Value entered.

■ Less Than finds targets less than the specified Value entered.

■ Greater Than or Equal To finds targets greater than or equal to the specified 
Value entered.

■ Less Than or Equal To finds targets less than or equal to the specified Value 
entered.

■ Like finds targets similar to the information specified using the wildcard %.

For example, if you specify the Item as Routing, select the Condition Like, 
and enter FORM% you find each target Routing that contains entries with 
the letters FORM.

5. Click Find. The search results are displayed.

6. Click the desired routing to display it in the Routing Designer window.

◗◗ To display the Routing Designer from other windows:
1. Navigate to one of the following windows:

■ Routing Summary

■ Routing Header Summary

■ Routing Details

2. Query the appropriate routing.

3. Click Designer. The Routing Designer window displays.

Identifying Buttons on the Routing Designer
The following discussion and graphic identify and explain each of tools displayed 
on the Routing Designer tool palette:

■ 1 is the Vertical Style button. Click it to display the vertical navigator style. 
Operations, activities, and resources are positioned in a left-to-right orientation 
for each routing. There is no spatial adjustment for each component.
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■ 2 is the Interleaved Style button. Click it to display the interleaved navigator 
style. Operations, activities, and resources are positioned in a left-to-right 
orientation for each routing with spatial adjustment for each component.

■ 3 is the Org-Chart Style button. Click it to display the organization chart 
navigator style. Operations, activities, and resources are positioned in a 
top-to-bottom orientation for each routing with spatial adjustment for each 
component.

■ 4 is the Show/Hide Description button. Click it to display a description of the 
components shown in the the navigator. Click it again to hide the description.

■ 5 is the Save button. Click it to save the changes made on the Routing Designer. 
This option is not available if the Routing Designer is in the view mode.

■ 6 is the Refresh button. Click it to refresh the routing graph pane with data 
retrieved from the database.

■ 7 is the Exit button. Click it to exit from the Routing Designer workbench.

■ 8 is the Drag Mode button. Click it to move steps around the graph pane using 
the drag-and-drop operation. This option is not available if the Routing 
Designer is in view mode.

■ 9 is the Connect Mode button. Click it to build dependencies between steps 
using the drag-and-drop operation. This option is not available if the Routing 
Designer is in view mode.

■ 10 is the Help button. Click it to display online help for the current window.

The following is a graphic of the previously described tool palette buttons:

◗◗ To show or hide a routing description using the View menu:
1. Choose Show Description from the View menu to display routing information.

2. The routing code, routing version, and description display for each routing.
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3. Choose Show Description from the View menu again to hide routing 
information.

◗◗ To create a new dependency connecting two routing steps:
1. Click Connect to begin building dependencies between two steps. This option 

is not available if the Routing Designer is in view mode.

2. Click the source or starting step in the routing graph pane.

3. Drag the dependency line to the target step, and drop it.

4. The Routing Step Dependency Properties window displays. To override the 
default step dependency attributes, reenter them.

5. Click OK.

6. The application checks the desired connection:

■ If a circular reference is detected, then the application displays:

A Circular reference has been detected.

The step dependency is not created.

■ If a step dependency already exists, then the application displays:

Step dependency already exists.

The step dependency is not created.

7. Save your work.

◗◗ To remove a step dependency between two routing steps:
1. Right-click the line connecting two routing steps, then choose Delete.

2. The line connecting the two routing steps is removed.

3. Save your work.

Actions Menu Options
You can use options from the Actions menu for the following:

Edit Process Instructions
You can use this Actions menu option to create and maintain processing 
instructions for a specific step. This option is enabled if a node representing a step 
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in the navigator is selected. When this option is selected, the Edit Process 
Instructions window displays.

Edit Routing Header
You can use this option to view or edit routing header information. When you select 
this option, the Routing Properties window displays.

Edit Step Line
You can use this option to edit a specific step. This option is enabled if a node 
representing a step in the navigator is selected. When this option is selected, the 
Step Properties window displays.

Distribute Steps
When opening a routing created in the Routing Details window, the steps appear as 
one on top of another in the upper left hand corner of the graph. You can use this 
option to distribute steps and make them visible in the routing step dependency 
graph.

When selecting Distribute Steps, the following menu options are available:

■ Left To Right: Images representing steps in the graph are drawn to create an 
equal distance between them. Steps are positioned from the left to the right and 
there is a maximum of three steps per line.

■ Top To Bottom: Steps are positioned from the top to bottom. There is a 
maximum of seven steps per column.

Change Status
You can use this option to change the status of the current routing. If changes have 
been made to the routing, the system displays a warning message and prompts you 
to save the changes.

Mark For Purge
You can use this option to delete the current routing. This function is available if the 
routing is not marked for purge.

Undelete
You can use this option to undelete the current routing. This option is available if 
the routing is marked for purge.
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QC Specification
You can use this option to access the Specifications window in the Oracle Process 
Manufacturing Quality Management application.

Generate Step Dependencies
You can use this option to generate sequential step dependencies. You can specify 
the type of dependency and distribute steps through the Generate Step 
Dependencies window. Enter data as described in the "Entering Routing Step 
Dependencies" topic.

Preferences
You can use this option to define user preferences using profile options. You can 
update them using the Profiles window, or the Preferences window within the 
Routing Designer. 

Using the Routing Properties Window
The Routing Properties window displays information about the routing, including 
its status, version, description, and its valid dates of use. The planned loss and 
routing quantity are also displayed. Use this window to:

■ Edit routing header properties.

■ Create new routings.

■ Load an existing routing.

◗◗ To display the Routing Properties window:
1. There are two methods to display the Routing Properties window:

■ In the navigator, right-click the routing to display the pop-up menu, then 
choose Properties.

■ In the navigator, click the routing, then choose Properties from the Actions 
menu.

2. The following fields are display only:

■ Status displays the current status of the Routing.

■ Routing displays the name of the routing.

■ Version displays the version number of the routing.
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■ Description displays a brief description of the routing.

■ Class displays the class assigned to the routing.

■ Valid From displays the first date and time that the routing is valid.

■ Valid To displays the last date and time the routing is valid.

■ Description displays a description of the routing class.

■ Quantity displays the quantity of material associated to the routing with its 
UOM. 

■ Planned Loss displays the planned loss. It defaults to the theoretical 
process loss unless otherwise specified.

■ Theoretical Process Loss displays the theoretical process loss for the 
routing.

■ Owner displays the initiator of the routing.

■ Owner Organization displays the plant, laboratory, or other facility that is 
responsible for initiating the routing.

■ Enforce Step Dependency indicates whether the routing enforces step 
dependencies. 

3. Click OK to close the window.

Using the Routing Step Properties Window
The Routing Step Properties window displays a summary of the step and its 
dependencies, and lets you edit step information. The Step Summary tab lets you 
view the main attributes of a specific step. The Step Dependencies tab lets you 
display upstream and downstream steps and their individual attributes. 

◗◗ To display the Routing Step Properties window:
1. There are three methods to display the Routing Step Properties window:

■ In the navigator, right-click the routing step, then choose Properties.

■ In the navigator, click the routing step, then choose Properties from the 
View menu.

■ In the routing graph pane, double-click the routing step.
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Step Summary
2. The Step Properties window displays the following fields:

■ Step displays the number of the selected routing step. Required.

■ Operation displays the operation code for the selected routing step. This 
field is display only and cannot be updated.

■ Version displays the version of the operation for the selected routing 
step.This field is display only and cannot be updated.

■ Description displays a description of the operation for the selected routing 
step. This field is display only and cannot be updated.

■ Class displays the class code of the operation if an operation class is 
associated to the routing step.

■ Description displays a description of the class if an operation class is 
associated to the routing step. This field is display only and cannot be 
updated.

■ Quantity displays the quantity of the selected routing step in the routing 
and its UOM. Required.

■ Max Capacity displays the maximum capacity of the routing step.

■ Charges displays the number of charges in the routing step.

■ Release Type of the step defaults to Manual. Possible values are Manual or 
Automatic. Required.

Step Dependencies
3. Select one of the following from the list:

■ Incoming Steps to display incoming dependencies of routing steps that are 
upstream to the currently selected routing step.

■ Outgoing Steps to display outgoing dependencies of routing steps that are 
downstream to the currently selected routing step.

4. The following fields are display only and depend on the selection you make in 
step 3:

■ Step displays the routing step number of the upstream or downstream 
routing step.

■ Operation displays the operation code of the upstream or downstream 
routing step.
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■ Version displays the operation version of the upstream or downstream 
routing step.

■ Quantity displays the quantity of the upstream or downstream routing step 
and its UOM.

■ Transfer % displays one of the following:

– If Incoming Steps is selected, then it is the percentage of the routing step 
quantity that transfers from the routing step shown in the list to the selected 
routing step.

– If Outgoing Steps is selected, then it is the percentage of the routing step 
quantity that transfers from the selected routing step to the routing step 
shown in the list.

■ Transfer Quantity displays one of the following:

– If Outgoing Steps is selected, then it is the routing step quantity that 
transfers from the selected routing step to the routing step shown in the list.

– If Incoming Steps is selected, then it is the routing step quantity that 
transfers from the routing step shown in the list to the selected routing step.

5. Click OK to close the window.

Generating Step Dependencies
You can use this option from the Actions menu to generate sequential step 
dependencies. Enter data as described in the "Entering Routing Step Dependencies" 
topic.

Using the Activity Properties Window
The Activity Properties window displays the properties of the selected activity 
including a brief description, the activity factor, and the optional offset interval.

◗◗ To display the Activity Properties window:
1. There are two methods to display the Activity Properties window:

■ In the navigator, right-click the activity, then choose Properties.

■ In the navigator, click the activity, then choose Properties from the View 
menu.

The Activity Properties window displays.
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2. The following fields are display only:

■ Activity displays the activity code.

■ Description displays a description of the activity.

■ Factor displays the activity factor.

■ Offset Interval displays the activity offset interval.

3. Click OK to close the window.

Using the Resource Properties Window
The Resource Properties window has two tabs:

■ Resource Summary displays the main attributes of a specific resource.

■ Process Parameters displays the process parameters defined for the selected 
resource.

◗◗ To display the Resource Properties window:
1. There are two methods to display the Resource Properties window:

■ In the navigator, right-click the resource then choose Properties.

■ In the navigator, click the resource, then choose Properties from the View 
menu.

The Resource Properties window displays.

Resource Summary
2. The following fields are display only:

■ Resource displays the resource code.

■ Description displays a description of the resource.

■ Quantity displays the resource quantity and its UOM.

■ Usage displays the resource usage and its UOM.

■ Class displays the resource class.

■ Description displays the resource class description.

■ Plan Type displays:
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– Auxiliary for a resource that works with the primary resource to perform 
an activity.

– Primary for a rate determining resource that limits or determines 
throughput. It is also referred to as the bottleneck or critical resource.

– Secondary for a resource that would replace the primary resource when it is 
not available. This resource performs the same task as the primary resource, 
but can have a different usage.

■ Count displays the number of resource instances used.

■ Offset displays the value entered for Standard Delay.

■ Scale Type displays the scale type used.

Process Parameters
3. Process Parameter is the process parameter name. For example, Bath 

Temperature.

4. Target indicates the target value for the process parameter.

5. Minimum is the lowest acceptable value for a numeric range type of process 
parameter.

6. Maximum is the highest acceptable value for a numeric range type of process 
parameter.

7. Click OK to close the window.

Using the Routing Step Dependency Properties Window
The Routing Step Dependency Properties window displays the source and 
destination step dependency properties. It also displays the dependency type, 
standard delay, transfer percent, and transfer quantity. Step Dependency properties 
include a dependency type and an offset defined by the value entered for Standard 
Delay. The offset is defined in the Standard Delay field as a positive or negative 
number. The application uses step dependencies when individual steps are 
rescheduled. Dependency type and standard delay offsets are: 

■ Finish-to-start with no offset, to indicate that a process step begins immediately 
after the completion of its preceding step. For example, a consecutive addition 
of ingredients is required without interruption.
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■ Finish-to-start with positive offset, to indicate that a process step begins a 
specified period of time after the completion of its preceding step. For example, 
time is required to rest material before the addition of another ingredient. 

■ Finish-to-start with negative offset, to indicate that a process step begins a 
specified period of time before the completion of its preceding step. For 
example, you need to activate a production device before the addition of the 
next ingredient.

■ Start-to-start with no offset, to indicate that a process step begins at the same 
time as the step it depends on. For example, there is a need for simultaneous 
addition of ingredients without interruption.

■ Start-to-start with positive offset, to indicate that a process step begins a 
specified time after the beginning of its preceding step. This is similar to 
finish-to-start with negative offset, but by specifying that the dependency is 
start-to-start, you can ensure the positive offset is maintained if the previous 
dependent step finishes early.

◗◗  To display the Routing Step Dependency Properties window:
1. There are three methods to display the Routing Step Dependency Properties 

window:

■ In the right pane, click the starting routing step and hold down the left 
mouse button as you draw a connection line to the target routing step. 
Release the left mouse button. This prompts you to validate or override the 
default values displayed for the routing step dependency attributes.

■ In the right pane, double-click the line connecting two routing steps.

■ In the right pane, right-click the line connecting two routing steps, then 
choose Properties.

Source
2. The following fields are display only:

■ Step displays the routing step number of the source routing.

■ Operation displays the operation code of the source operation.

■ Version displays the version of the source operation.

■ Description displays a description of the source operation.

■ Quantity displays the source routing step quantity.
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■ UOM displays the unit of measure for the step quantity.

Destination
3. The following fields are display only:

■ Step displays the routing step number of the destination operation.

■ Operation displays the operation code of the destination operation.

■ Version displays the version of the destination operation.

■ Description displays a description of the destination operation.

■ Quantity displays the destination routing step quantity and its UOM.

Dependency Type
4. Select one of the following:

■ Finish-to-start for operations that begin immediately after the completion 
of the previous routing step, or with a specified standard delay. This is the 
default that you can override.

■ Start-to-start for operations that begin at the same time, or with a specified 
standard delay.

5. Standard Delay displays the positive or negative time offset between routing 
steps. It is the number of hours from the end of the source routing step to the 
start of the destination routing step. The default is zero. You can enter a value to 
override the default.

6. Transfer % displays the percentage of material that goes to the dependent 
routing step after all products and byproducts are yielded. This percentage is 
used to calculate the quantity of the dependent routing step if automatic 
routing step quantity calculations are on. You can enter a value to override the 
default.

7. Transfer Quantity displays the quantity transferred from the source routing 
step to the destination routing step and its UOM. It is calculated as:

Transfer Quantity = Routing Step Quantity * Transfer % 

8. Click OK to close the window.

◗◗ To display a full description of a routing step:
Position the cursor over a routing step in the graph to display a full description of 
the routing step.
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◗◗ To display the transfer percentage of a routing step:
Position the cursor over a routing step dependency line to display the transfer 
percentage of material.

Accessing Quality Control Windows
You can display the Specifications window in the Oracle Process Manufacturing 
Quality Management application as follows:

1. Select Routing in the navigator pane.

2. Choose QC Specifications from the Actions menu.

Refer to the Oracle Process Manufacturing Quality Management User’s Guide for more 
information on specifications.

Adding Operation Steps
The operation list is a component below the Routing navigator and displays 
operations from the operation master table. This list serves as the source for adding 
operations to the routing. This list is not available if the routing is in view mode.

◗◗ To add a new operation step:
1. If the operation list does not display, then click Show/Hide Operation Master. 

The operation list displays below the navigator.

2. Select an operation from the list and associate it to the routing in the navigator 
or in the Routing Dependency Graph pane.

When adding a step to the routing, the application validates the operation and 
displays the Operation Step Properties window. You can review and override 
the default values in this window.

3. Save your work.

Removing Operation Steps

◗◗ To remove a step in the routing:
1. Use one of these methods to remove a step in the routing:

■ Select the step in the navigator and choose Cut from the Edit menu.
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■ Select the step in the Routing Dependency graph pane, and choose Delete 
from the right-click menu.

When removing an operation step, all incoming and outgoing dependencies are 
also removed. Changes are displayed in the Routing Graph pane and in the 
Process Instruction Sheet pane simultaneously.

2. Save your work.

Editing User Preferences
The Preferences window contains three tabs:

■ The Routing tab lets you customize the behavior of the application when 
adding a new step to a routing and creating a dependency between two steps.

■ The Step Dependency Graph tab lets you customize the routing step 
dependency graph.

■ The Process Instructions tab lets you specify the language for displaying and 
maintaining process instructions.

◗◗ To edit preferences:
1. Select Preferences from the Actions menu.

2. Click each tab to enter user preference details.

3. Click OK to save.
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Recipes

This topic shows you how to define and maintain recipes. You are shown how to 
find a recipe. You are also shown how to display a summary of recipes and recipe 
headers. Procedures to enter recipe details, recipe organization details, and edit 
validity rules demonstrate the process flow for recipe development. You learn how 
to display and interpret recipe validity rules and how to display the recipe step and 
material association.

The following topics provide a basic understanding of recipes:

■ Understanding Recipes

■ Requirements

■ Solutions

■ Defining and Maintaining Recipes

■ Finding a Recipe

■ Displaying the Recipes Summary

■ Displaying the Recipe Header Summary

■ Understanding Step Quantity Calculations

■ Entering Recipe Details

■ Entering Recipe Organization Details

■ Displaying Recipe Organization Details-Process Parameters

■ Entering Multi-Record Recipe Validity Rules

■ Editing Recipe Validity Rules

■ Displaying Validity Rules By Product
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■ Displaying Validity Rules By Recipe

■ Displaying the Recipe Step/Material Association

■ Understanding the Recipe Designer

■ Using the Recipe Designer

■ Creating a Formula in the Recipe Designer

■ Using the Process Instruction Sheet

■ Expanding and Collapsing Nodes

■ Editing User Preferences
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Understanding Recipes
Recipes standardize the structure of all information that describes production of one 
or more products. Recipes have:

■ Formulas that define the relationship of material resources (products, 
ingredients, and byproducts).

■ Routings that define the relationships of nonmaterial resources (labor and 
equipment operations with activities and their associated resources). Routings 
are optional.

■ Processing instructions that encompass the work instructions needed to 
produce the products.

To provide the greatest flexibility to process manufacturers, formulas and routings 
are built independently. They are linked using a Recipe that has validity rules. 
Different formulas can use the same routing, or one formula can be associated to 
several different routings.

Recipes are depicted hierarchically in the following diagram that shows the:

■ Routing composed of a series of Operations organized in Steps.

■ Operations composed of Activities containing Resources.

■ Formula composed of Ingredient, Product, and possibly Byproduct.

■ Recipe linking the Routing and Formula together with Processing Instructions.
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Requirements
Following are some requirements that customers have for recipes in Product 
Development. The answers are explained in detail in the Solutions topic.

Does the application support effectivities already developed for 
in-house formulas?
Yes. Migrate Effectivities to Recipe Validity Rules with special scripts provided by 
Oracle.

Is there one place in the application that shows exactly how to make a 
product?
Yes. Use the Recipe Details window. After evaluating the information on the Recipe 
Details window, display Organization Details, Validity Rules, and the Recipe Step 
and Material Association needed to determine exactly how to make a product.

Does a Product Development recipe support Cost Management and 
Production Execution requirements?
Yes. By linking input and output of materials to individual operation steps and 
providing an automatic step quantity and charge calculation, the application 
supports the requirements for accurate cost rollup and flexible production 
execution.

Can an item be made differently depending on the manufacturing plant 
or the time of year?
Yes. Recipes enable rule based execution. By applying this logic to formula 
selecting, plant specific and seasonal formulations are possible.

Does the application support SP88 terms for batch manufacturing?
Yes. The application offers enhanced standards for Master Recipe definition.
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Solutions
Product Development provides solutions to help resolve issues at every stage of the 
product development process. The following represent some of the key 
performance solutions for recipes.

Migrate Effectivities with Scripts  Oracle provides a customized series of scripts that 
migrate existing formula information into the Product Development application.

Use the Recipe Details Window to Determine All Product Manufacturing Requirements  The 
Recipe Details window displays all product manufacturing requirements. In each 
step of building a new product, components are created that appear on the Recipe 
Details or the Organization Details windows.

Use Recipes as the Foundation for Cost Management and Production Execution  Where 
routings are used to specify process related requirements such as equipment, labor, 
and energy, the recipe defines the input and output of each operation step. This is 
achieved by linking formula materials and quantities to appropriate routing steps, 
and is a prerequisite to enabling automatic step calculation.

Enhance Product Consistency with Rule-Based Execution  If not managed appropriately, 
manufacturing variability can lead to product inconsistency and complexity. 
Rule-Based Execution enhances product consistency and manufacturing simplicity 
by letting planners, quality control specialists, and cost accountants specify the 
conditions under that recipe components must be applied. When a recipe is needed 
for production, planning, or costing purposes, the application selects the 
appropriate version to support the activity. This capability improves consistency by 
applying rule-based logic to formula selection for use in specific environments and 
under specific conditions based on status.

Product Development uses Validity Rules that are based on several key factors 
including date, production site, plant, customer, and required quantities. Some 
recipes are seasonal and based on ingredient availability. Other recipes are 
determined by whether they are small, medium, or large production runs. Different 
plants can use different versions of a target recipe, so the choice of recipe depends 
on the plant that is producing the batch. By using Validity Rules an organization can 
set the standard quantity and effective dates of a recipe to specify what, where, 
when, and how formulas, recipes, routings, and operations must be applied.

With rule-based execution, production gains a tighter control over the business and 
is able to select an optimized recipe. When several recipes have overlapping validity 
dates, business logic selects the optimum valid recipe. 
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Offer Enhanced Industry Standards for Recipe Definition  The concept of effective date is 
refined into a recipe structure that complies with industry standards for recipe 
definition. A Master Recipe combines a formula and a routing at a global level to 
streamline the overall approval process. The Master Recipe serves as the basis for 
subsequent planning, manufacturing, and costing, calculations.
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Defining and Maintaining Recipes
Recipes contain the minimum set of information that uniquely defines the 
manufacturing requirements for a specific product. Recipes provide a way to 
describe products and how those products are produced.

Creating a New Recipe
Create and define new recipes on the Recipe Details window. To create a new 
recipe, you have the option to specify product code and quantity, or formula 
number and version. If you enter product code and quantity, you get a list of all 
valid or effective formulas. Select the one you want to use to create the recipe. You 
also have the option to specify a routing in the recipe. You can override routing 
attributes such as Capacity, Activity Factor, Charges, and Resource Usage for each 
recipe you define. If a recipe is set up for Automatic Step Quantity Calculation, then 
you must ensure that formula material is properly associated to each appropriate 
routing step. You can display the following windows from the Recipe Details 
window:

■ Recipe Organization Details

■ Recipe Validity Rules

■ Recipe Step/Material Association

Maintaining Recipes
Use the following windows to maintain recipes:

■ Recipes Summary By... to display a list of defined recipes with their individual 
version numbers and descriptions. These can be viewed by Status or Owner. 
You can display the Recipe Details window from the Recipes Summary By 
window.

■ Recipe Header Summary to display important descriptive information 
regarding a particular recipe. You can display the following windows from the 
Recipe Header Summary window:

■ Recipe Validity Rules

■ Recipe Details

■ Recipe Organization Details to display and, if necessary, override information 
defined for specific operations and routings at the Organization level. You can 
display the Recipe Validity Rules window from the Recipe Organization Details 
window.
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■ Recipe Validity Rules is a multi-record window to enter or edit a complete list 
of Validity Rules for Organizations you can access.

■ Recipe Validity Rules also enables you to edit validity rules for a specific recipe.

■ Recipe Step/Material Association to display all items from the recipe’s formula 
and associate them with specific routing steps.

The following graphic depicts the previously described recipe navigation flow:
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Finding a Recipe
The Find Recipes window enables you to find a specific recipe. At least one search 
parameter needs to be entered.

Prerequisites
❏ Enter and save recipes.

◗◗ To find a recipe:
1. Navigate to the Find Recipes window.

2. Enter as many parameters as needed to complete the search:

■ Enter search parameters in the Standard region for: Recipe, Description, 
Formula, Routing, or Product with appropriate Version for Recipe, 
Formula, or Routing. You can also enter Organization, Customer, From 
Date, To Date, Status, and Recipe Use.

■ Enter search parameters in the Advanced region for a specific: Item, 
Condition, or Value.

3. Click Find.

4. Review the results of the search

5. Close the window.
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Displaying the Recipes Summary
The Recipes Summary window displays a list of all defined recipes with their 
individual version numbers and descriptions. You can display these by Status or 
Owner. Multilingual support is provided for the Recipe Description.

You can use folders with this window. See: Oracle Applications User’s Guide.

Prerequisites
❏ Enter and save recipes.

❏ Use the View By list to select how you want to view the summary of recipes. 
Select one of the following:

■ Status to display the list by recipe status.

■ Owner to display the list by recipe owner.

◗◗ To display a list of all defined recipes:
1. Navigate to the Recipes Summary By... window.

2. The following fields are display only:

■ Recipe is the recipe code.

■ Version is the version of the Recipe.

■ Description is a brief explanation of the Recipe.

■ Status displays the current status for the Recipe.

■ Product displays the code for the primary product produced by the Recipe.

■ Owner Organization displays the default organization for the Owner of the 
Recipe.

3. The following fields display for each selected recipe.

■ Formula is the formula for the currently selected Recipe.

■ Formula Version is the Version of the Formula for the currently selected 
Recipe.

■ Routing is the Routing for the currently selected Recipe.

■ Routing Version displays the Version of the Routing for the currently 
selected Recipe.

4. Click Details to display the Recipe Details window.
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Displaying the Recipe Header Summary
The Recipe Header Summary window enables you to display important descriptive 
information regarding a particular recipe.

You can use folders with this window. See: Oracle Applications User’s Guide.

Prerequisites
❏ Enter and save recipes.

◗◗ To display recipe header information:
1. Navigate to the Recipe Header Summary window.

Summary
2. The following fields are display only:

■ Status is the current status of the Recipe.

■ Recipe is the name of the Recipe.

■ Version is the version of the Recipe.

■ Description is a brief explanation of the Recipe.

■ Formula is the Formula number used in the Recipe.

■ Version is the version of the Formula with its Description.

■ Main Product is the end item in the Formula.

■ Total Output Qty is the total output of material in the Formula UOM.

■ Routing is the routing number.

■ Version is the Routing version with its Description.

3. Click Products to display the Formula Product Summary window.

4. Click Details to display the Recipe Details window.

Validity Rules
5. The following fields are display only:

■ Organization displays the plant or laboratory organization code.

■ Product displays the coproduct of the Formula.
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■ Recipe Use displays if the Recipe is used in Production, Planning, Costing, 
or Technical class and subclass determination.

■ Status displays the Status of the Validity Rules.

6. Click Details to display the Recipe Validity Rules window.

Customers
7. The following fields are display only:

■ Customer displays the customer number.

■ Name displays the customer name.
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Understanding Step Quantity Calculations
The quantity of material required in a specific step is dependent on the weight of 
material that passes into and out of that step. Input material consists of ingredients 
that are injected directly into steps or material that is transferred from preceding 
steps.

The following example shows how material can be input, transferred, and output 
from a series of production steps.

Step 1: Add 10 pounds of Ingredient 1 to 25 pounds of Ingredient 2. The result is 5 
pounds of Byproduct 1 and 30 pounds of Intermediate 1. Transfer of Intermediate 1 
is as follows:

■ 25% or 7.5 pounds to Product 1

■ 35% or 10.5 pounds to Step 2 

■ 40% or 12 pounds to Step 3

Step 2: Transfer of 10.5 pounds of Intermediate 2 is as follows:

■ 25% or 2.625 pounds to Step 3

■ 75% or 7.785 pounds to Product 1

Step 3: Add 12 pounds of Ingredient 3 to the mixture of Intermediate 1 and 
Intermediate 2. This yields 3 pounds of Byproduct 2 and 23.625 pounds of 
Intermediate 3.

The final yield of Product 1 consists of:

■ 7.500 pounds from Step 1

■ 7.785 pounds from Step 2

■ 23.625 pounds from Step 3

Total Product 1 produced is 39 pounds.

Total Byproduct produced is 8 pounds, and is comprised of:

■ 5 pounds of Byproduct 1

■ 3 pounds of Byproduct 2

In this example, there is yield is 100%. There is no process loss in the transfer of 
material.
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The following depicts the previously described example. LB is equal to pounds.
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Entering Recipe Details
The Recipe Details window enables you to enter the details for a specific recipe. A 
Plant or a Laboratory can be associated with all the materials and resources 
required to make a product at the recipe level. One or more customers can be 
associated to the recipe for informational purposes.

eRecord and eSignature Approvals
There may be an eSignature event associated with this window. Refer to "Appendix 
D" for additional information on eRecord and eSignature approvals associated with 
this window.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Optionally, enter and save operations.

❏ Optionally, enter and save routings.

❏ Enter and save formulas.

Understanding Step Quantity Calculations
When you select the Calculate Step Qty box on the Recipe Details window, the 
application checks to determine if there are proper step quantity material 
associations. You must use a routing. Step and material associations must be made. 
If any of these associations are defective, then you receive an error message. When 
you use the Automatic Step Quantity Calculation, it checks quantities in each step 
to verify that material is available to pass into and out of each step. The quantity of 
material for a particular step is dependent on the quantity of material that passes 
into or out of it. The input material can be either the ingredient that is injected 
directly into the step, or it can be the output of preceding steps. Output is 
represented typically by coproducts or byproducts.

◗◗ To enter recipe details:
1. Navigate to the Recipe Details window.

2. Enter the code for the Recipe to be entered. Required.

3. Enter a Version of the Recipe. Required.

4. Enter a Description for the Recipe. Required.
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5. After entering all relevant information and saving the Recipe with the default 
Status of New, return to this window if you need to change Recipe Status by 
selecting Change Status from the Actions menu. Depending on whether 
Workflow is enabled, a different set of statuses is available.

Select a Status for the Recipe you are entering from one of the following:

■ Approved for Laboratory Use to indicate that the Recipe is approved for 
laboratory use.

■ Approved for General Use to indicate that the Recipe is approved for use 
in production.

■ Obsolete/Archived to indicate that the Recipe is no longer approved for use 
and is obsoleted, archived, or both.

If Workflow is enabled, when you select:

■ Approved for Laboratory Use, then Status changes to Request Approval 
for Laboratory Use until all approvers have accepted the Recipe, then its 
Status changes to Approved for Laboratory Use.

■ Approval for General Use, then Status changes to Request Approval for 
General Use until all approvers have accepted the Recipe, then its Status 
changes to Approved for General Use.

Recipe status cannot be changed to an approved status if the formula and 
routing are not yet approved. For example, the formula and routing must be 
Approved for General Use before the recipe status can be changed to Approved 
for General Use. If you change the status of a recipe to Obsolete, Archived, 
On-hold, or Frozen, validity rules associated to that recipe change to that status.

You can change the status of recipes or validity rules to On-hold or Obsolete 
even if they are used in batches as long all these batches are closed or cancelled.

6. Enter the main Product for the Formula associated with this Recipe. If you enter 
a new Recipe, enter the Formula to fill this field automatically.

7. The Output Quantity displays the sum of all materials. UOM indicates the unit 
of measure for the Formula associated with this Recipe.

8. Enter the Formula number for the Recipe. Required. Once a recipe is saved, this 
field cannot be edited. You cannot use an inactive Formula in a recipe. The 
formula Version displays. Required.

9. Creation Organization displays the organization code for the initial Owner. 
This field is not updateable for an existing Recipe. Required.
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10. Enter a Routing number for the Recipe. A routing can be added to an existing 
Recipe. The Version for the Routing entered displays.

11. Theoretical Process Loss displays the hypothetical loss of process material 
associated to a routing as a percentage. If no routing is associated to a recipe, or 
if no routing class is associated to a given routing, and no Process Loss is 
defined for that routing, this field is blank.

12. Enter the Planned Process Loss as the loss of process material observed during 
production of a batch using the recipe. If no value is entered in this field, it 
defaults to the Theoretical Process Loss. You can change this value on a New or 
existing recipe.

13. Total Output Qty displays with its UOM.

14. Enter the Laboratory that has current ownership of the recipe. This is a Folder 
field.

15. Enter the Owner Organization. This field is the default organization for the 
Owner of the Recipe. In order for you to enter or edit information for the 
Recipe, you must have an association with this organization and permission to 
access and change this field. Required.

16. Enter the Owner of the Recipe. The Owner name must be a valid User name. 
This field defaults to the current User. Required.

17. The Calculate Step Qty check box indicates whether you want to enter step 
quantities manually or have the application calculate them for you.

■ Select the Calculate Step Qty check box to enable the application to 
calculate step quantities automatically. Quantities are based on the amount 
of materials that go into and out of each supported step. Step Quantity 
fields cannot be entered after you select the check box. You must associate 
all items marked as contributing to step quantity to specific Steps on the 
Recipe Step/Material Association window.

■ Clear the Calculate Step Qty check box to enter step quantities manually. 
Step quantities default from the default routing steps. You can change any 
of the quantities in the Step Quantity region. Upon making an entry in the 
Step Quantity field, the application checks to determine if preceding steps 
have been set up for the current step dependencies. If quantities are less 

Note: You must enter all information on this window before you 
select the Calculate Step Qty check box.
Recipes 6-17



Entering Recipe Details
than the sum of the Quantity transferred to this step, an appropriate error 
message displays.

Plant/Laboratory
18. The following fields are display only:

■ Organization displays the Organization code that the Process Loss is being 
defined for. This must be a plant or a laboratory. Required.

■ Organization Name displays a description of the plant or laboratory.

■ Type indicates whether this is a plant or a laboratory.

■ Process Loss displays the material that is lost through the process. This 
field is blank if you did not enter a Routing. This field allows you to 
override the default Process Loss.

Customer
19. Enter the Customer number. Required.

20. Name indicates the name of the Customer associated with the Customer 
number entered. 

Step Quantity
If a routing has not been entered, this region is not available. If you calculate step 
quantities in the Automatic Step Quantity Calculation, the Step Material 
Associations need to be entered.

21. Step indicates the step number associated with the listed Operation in the 
displayed Routing. Steps cannot be added or deleted here. However, if a step is 
deleted in the base routing used for this Recipe, and the Step field is 
overwritten, you must choose Delete from the Edit menu to delete the 
orphaned Step. Charges are calculated for each Step displayed. You can 
associate text with each Step.

22. Operation displays the operation associated with the Step. The operation 
Version and Description are displayed.

23. Step Quantity indicates the default quantity of material associated with the 
Step. The UOM for the Step Quantity displays. You can enter a new value in the 
Step Quantity field if you do not use the Automatic Step Quantity Calculation. 
If Automatic Step Quantity Calculation is used, this field is not enterable. 
Required if the Step is associated to material, and you are not using Automatic 
Step Quantity Calculation. Required.
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24. Charges displays the total calculated charges for the step. Charges are the 
number of times the Operation must be performed to complete the Step for the 
specified Step Quantity. For example, a mixer that holds 50 kg would require 
two charges to process 100 kg of material. Charges are calculated from the 
smallest minimum capacity for all resources in the Step.

25. Optionally, click Organization Details to display the Recipe Organization 
Details window.

26. Optionally, click Validity Rules to display the Recipe Validity Rules window.

27. Optionally, click Step/Material Association to display the Recipe Step/Material 
Association window.

28. Save the window.

◗◗ To mark a recipe for deletion:
1. Choose Mark for Purge from the Actions menu.

2. The record is marked for deletion.

3. Save the window.

◗◗ To copy a recipe:
1. Select the Recipe to copy.

2. Choose Copy from the Edit menu. Copying a recipe creates a new recipe. All 
header fields in the the new recipe are editable. You must change the recipe 
number or recipe version in the copied recipe before saving it. Duplicate recipe 
names are not allowed. The current Owner and Organization are assigned to 
the new recipe. Recipes that have been marked for deletion cannot be copied.

3. Click OK.

◗◗ To edit text:
1. Choose Edit Text from the Actions menu.

2. Enter appropriate text.

3. Save the window.

◗◗ To duplicate a record:
1. Query the Recipe Details record you want to duplicate.

2. Choose New from the File menu.
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3. Choose Duplicate Record Above from the Edit menu.

4. Enter a new Recipe name and Version number.

5. Save the window.

◗◗ To display the Formula Details window:
1. Choose Formula from the Actions menu. The Formula Details window 

displays.

2. Close the window.

◗◗ To display the Routing Details window:
1. Choose Routing from the Actions menu. The Routing Details window 

displays.

2. Close the window.

◗◗ To display the eRecord Details window:
1. Choose eRecord Details from the Actions menu. The eRecord Generic Query 

displays if this option is implemented in your application.

2. Refer to "Appendix D" for information on eRecords.

3. Close the window.

◗◗ To display the Specifications window:
1. Choose Specifications from the Actions menu. The Specifications window 

displays.

2. Evaluate specifications.

3. Close the window.

◗◗ To display the Samples window:
1. Choose Samples from the Actions menu. The Samples window displays.

2. Evaluate the samples.

3. Close the window.
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Using the View Menu to Find a Recipe
The Find selection on the View menu enables you to find a recipe. At least one 
search parameter needs to be entered.

◗◗ To find a recipe from the View menu:
1. Navigate to the Recipe Details window.

2. Choose Find from the View menu.

3. Enter search parameters for: Recipe, Version, Description, Status, Product, 
Description, Formula, Version, Routing, Version, Owner, Owner 
Organization, Laboratory, or Marked for Deletion.

4. Click Find.
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Entering Recipe Organization Details
The Recipe Organization Details window enables you to display and, if necessary, 
override information defined for specific operations and routings at the plant or 
laboratory level.

eRecord and eSignature Approvals
There may be an eSignature event associated to this window. Refer to "Appendix D" 
for additional information on eRecord and eSignature approvals and workflow 
processes associated with this window.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Enter and save recipes.

◗◗ To enter recipe organization details:
1. Navigate to the Recipe Organization Details window. The Find Recipe 

Organization Details window displays.

2. Enter the Organization that owns the recipe. Required.

3. Click Find.

4. The following fields are display only:

■ Organization indicates the code for the Plant or Laboratory that owns the 
recipe.

■ Type displays Plant if the Organization is a plant, or a Laboratory if the 
Organization is a laboratory.

■ Organization Name displays the description assigned to the Organization. 
This field defaults to the entry from the Recipe Details window. Required.

■ Planned Process Loss displays the loss of process material observed during 
production of a batch using the recipe as a percentage. You can enter and 
save a different Planned Process Loss value for the recipe used in the 
Organization displayed. This value defaults to the Theoretical Process Loss 
when no entry is made on the Recipe Details window.

■ Theoretical Process Loss displays the hypothetical loss of process material 
associated to a routing. If no routing is associated to the recipe, this field is 
blank.
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Validity Rules
5. Enter a Product for the formula used in the recipe. Required.

6. Recipe Use displays if the recipe is used in Production, Planning, Costing, or 
Technical when it is used to define technical classes and subclasses. Required.

7. Enter the From Date as the date the Validity Rule becomes effective. The date 
must be within the effective date for any routing associated to the recipe. 
Required.

8. Enter To Date as the date to stop using the Validity Rule. This is an optional 
field and must be left blank if no expiration date is defined for the Validity Rule.

9. Status displays the status of the Validity Rule entered on the Recipe Validity 
Rules window.

10. Enter the Std Qty as the usual quantity of product produced by the Validity 
Rule.

If the Automatic Step Quantity Calculation is not used, then the step quantities 
are based on the routing, and are scaled to this quantity. If the Automatic Step 
Quantity Calculation is used, then step quantities are based on the formula that 
is scaled to the this quantity. Required.

11. Enter the UOM as unit of measure for the standard quantity. Required.

12. Enter the Min Qty as the minimum quantity of material that is allowable by the 
Validity Rule. Required.

13. Enter the Max Qty as the maximum quantity of material that is allowable by the 
Validity Rule. Required.

14. Enter the Preference number for the Validity Rule. When more than one 
formula can be used to produce the same product, the Preference field is used to 
show the Validity Rule that must be used first, second, third, and so forth. 
Preference defaults to 1. Required.

15. Enter the Theoretical Process Loss based on the standard quantity produced by 
this validity rule.

16. Enter the Planned Process Loss for the product. This entry overrides the 
process loss defined at the routing or recipe level. Once you save the current 
window, you can override the Planned Process Loss field on the Validity Rules 
window by reentering it and saving your work.

Batches created for a different quantity using this validity rule calculate the 
actual process loss by dividing the planned process loss by the theoretical 
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process loss for the standard quantity to compute a factor. The theoretical 
process loss for the batch quantity is then multiplied by this factor to compute 
the actual process loss for the batch.

Activities
17. The following fields are display only:

■ Step indicates the step number associated with the listed Operation. Steps 
cannot be added or deleted here.

■ Operation displays the operation associated with the Step. The operation 
Version and Description are displayed.

■ Activity displays the Activity associated with the Operation. The Activity 
Description is displayed.

18. Enter Factor as the number of times the Activity is performed in the displayed 
Operation. This value can change when resources that are specific to the 
Organization are associated with ingredients. Required.

Capacity
19. The following fields are display only:

■ Step indicates the step number associated with the listed Operation. Steps 
cannot be added or deleted here.

■ Operation displays the operation associated with the Step. The operation 
Version is displayed.

■ Activity displays the activity associated with the Operation. Activities 
cannot be added or deleted here.

■ Resources displays the Resource associated to each displayed Activity.

20. The following fields display and can be edited:

■ Min Capacity displays the minimum throughput amount per capacity unit 
as defined on the Resources window.

■ Max Capacity displays the maximum throughput amount per capacity unit 
as defined on the Resources window.

21. UOM displays the unit of measure for both Min Capacity and Max Capacity.

22. Click Parameters to display the Recipe Organization Details-Process 
Parameters window.
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Throughput
23. The following fields are display only:

■ Step indicates the step number associated with the listed Operation. Steps 
cannot be added or deleted here.

■ Operation displays the operation associated with the Step. The operation 
Version is displayed.

■ Activity displays the activity associated with the Operation. Activities 
cannot be added or deleted here.

■ Resources displays the Resource associated to each displayed Activity.

24. Process Qty displays the total quantity of material for the Step with its UOM. 
You can enter and save a different Process Qty.

25. Usage displays the unit of the Resource used to perform the activity on the 
displayed Step. The usage UOM displays. You can enter and save a new usage 
quantity.

26. Click Parameters to display the Recipe Organization Details-Process 
Parameters window.

27. Save the window.

Using the Find Recipe Organization Details Window
The Find Recipe Organization Details window displays when you navigate to the 
Recipe Organization Details window.

◗◗ To find the recipe organization:
1. Enter the Organization that owns the recipe. Required.

2. The Name of the Organization displays.

3. Click Find.

◗◗ To display the eRecord Details window:
1. Choose eRecord Details from the Actions menu. The eRecord Generic Query 

displays if this option is implemented in your application.

2. Refer to "Appendix D" for information on eRecords.

3. Close the window.
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Displaying Recipe Organization Details-Process Parameters
The Recipe Organization Details-Process Parameters window displays 
organization-specific process parameters for recipes. Process parameters are a 
component of the process instructions necessary to run resources during the batch 
process. They are usually machines or instruments and are the standard for 
processing a task. They can be generic or specific. Each industry and company uses 
different machines and instruments, and there are different requirements for 
recording process parameters.

A process parameter details information such as temperature, pressure, or time that 
is pertinent to the product, but does not fall into the classification of input or 
output. You can use process parameters as set points, comparison values, or in 
conditional logic.

You can use folders with this window.

See: Oracle Applications User’s Guide and Oracle Flexfields User’s Guide.

Prerequisites
❏ Set up process parameters.

See: Oracle Process Manufacturing Capacity Planning User’s Guide

◗◗ To display the Recipe Organization Details-Process Parameters 
window:
1. Navigate to the Recipe Organization Details-Process Parameters window.

2. The following fields are display only:

■ Recipe displays the recipe with its Version and Description.

■ Organization displays the recipe organization and its Description.

■ Resources displays the resource attached to the activity and its 
Description.

Parameter Values
3. The following fields default from the process parameter set up in the planning 

application:

■ Seq is the sequence of the resource process parameter.

■ Parameter is the process parameter name. For example, Bath Temperature.

■ Target is the target value for the process parameter.
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■ Minimum is the lowest acceptable value for a numeric range type of 
process parameter.

■ Maximum is the highest acceptable value for a numeric range type of 
process parameter.

■ Units is the unit of measure for the process parameter.

4. Click OK to close the window.
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Entering Multi-Record Recipe Validity Rules
The Recipe Validity Rules Multi-Record window lets you enter or edit a complete 
list of Validity Rules for organizations you can access. Validity Rules provide a 
combination of a quantity of material and an effective date that is used by 
production, planning, costing, or technical in one or more specified organizations. 
Validity Rules that have been marked for deletion are not updateable. Validity Dates 
are ordered by Organization, Product, Recipe Use, and Start Date.

Refer to the "Editing Recipe Validity Rules" topic for a complete discussion of the 
how to override process loss entered at the routing level.

You can use folders and flexfields with this window. See: Oracle Applications User’s 
Guide and Oracle Applications Flexfields Guide, respectively.

Prerequisites
❏ Enter and save recipes.

◗◗ To view multi-record recipe validity rules:
1. Navigate to the Recipe Validity Rules window.

2. The following fields are display only:

■ Formula displays the formula used in the recipe with its Version and 
Description.

■ Routing displays the routing used in the recipe with the routing Version 
and Description.

3. Organization displays the organization that owns this Validity Rule to produce 
products. This can be your plant or laboratory. When left blank, this field 
enables the Validity Rule to be global. You can enter and save a new 
Organization.

4. Enter a Product for the Validity Rule. The Product Description field displays. 
Required.

5. Select Recipe Use as:

■ Production for use in production of products.

■ Planning for use in planning material consumption.
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■ Costing for use in establishing costs. 

■ Technical for use in establishing technical classes and subclasses.

Required.

6. Enter the Preference number for the Validity Rule. When more than one 
formula can be used to produce the same product, Preference is used to show 
the Validity Rule that must be used first, second, third, and so forth. Required.

7. Enter the From Date as the date the Validity Rule becomes effective. The date 
must be within the effective date for any routing associated to the recipe. 
Required.

8. Enter To Date as the date to stop using the Validity Rule. This is an optional 
field and must be left blank if no expiration date is defined for the Validity Rule.

9. Enter the Standard Quantity of Product made with this Formula. This quantity 
is only used for costing. It does not restrict quantities that can be produced by 
the Formula displayed. The standard quantity must be in the specified range 
defined by the minimum and maximum quantities. Required.

10. Enter the UOM for the Standard Quantity. Required.

11. Enter the Min Quantity as the minimum quantity of Product that can be made 
using the Formula. Required.

12. Enter the Max Quantity as the maximum quantity of Product that can be made 
using the Formula. Required.

13. Theoretical displays the theoretical process loss based on the Validity Rule 
Standard Quantity.

14. Enter the Planned process loss. This overrides planned process loss entered at 
the routing level.

15. Save the window.
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Editing Recipe Validity Rules
The Recipe Validity Rules window lets you edit validity rules for a specific recipe. 
Use this window to apply global or specific organization rules to batches, cost 
management, planning, or technical data when producing the same product. 
Validity Rules can be added, updated, or marked for deletion.

Overriding Process Loss Entered at the Routing Level
Process loss is based on the standard quantity entered at the validity rule level. 
Process loss that is entered at that level overrides the process loss entered at the 
routing level. Theoretical Process Loss, Planned Process Loss, Step Quantity, and 
Charges fields display at the validity rule level.

Theoretical Process Loss calculations are also based on the Validity Rule Standard 
Quantity. If Planned Process Loss is entered on a validity rule, then its value 
overrides process loss defined at any other level in the routing or the recipe. If a 
batch is created for a different quantity, then the same rule is applied to calculate the 
actual Process Loss. Planned Process Loss is compared to the Theoretical Process 
Loss for the Standard Quantity field on a validity rule. This loss is taken from the 
Process Loss field for the routing class in order to compute a factor. The Theoretical 
Process Loss for the batch quantity is multiplied by this factor to compute the actual 
Process Loss for the batch.

Following are the modifications for the Automatic Step Quantity Calculation, or 
ASQC:

■ If ASQC is not used, then the step quantities displayed initially are based on the 
routing, as scaled to the Validity Rule Standard Quantity. If step quantities are 
overridden at the recipe level, then the recipe step quantities are scaled to the 
Validity Rule Standard Quantity.

■ If ASQC is used, then the Step Quantities displayed are based on the formula 
scaled to the Validity Rule Standard Quantity. 

Charges displayed at the validity rule level are based on the step quantities 
indicated there. Process Execution, Cost Management, Financials, and Planning 
applications use process loss overrides at the validity rule level.

eRecord and eSignature Approvals
There may be an eSignature event associated to this window. Refer to "Appendix D" 
for additional information on eRecord and eSignature approvals and workflow 
processes associated with this window.

You can use folders and flexfields with this window.
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See: Oracle Applications User’s Guide and Oracle Applications Flexfields Guide.

Prerequisites
❏ Enter and save recipes.

◗◗ To edit recipe validity rules:
1. Navigate to the Recipe Validity Rules window.

2. The following fields are display only:

■ Formula displays the formula used in the recipe with its Version and 
Description.

■ Routing displays the routing used in the recipe with the routing Version 
and Description.

■ Status displays the Status of the Validity Rule. This field cannot be higher 
than its associated recipe. For example, a Validity Rule cannot be Approved 
for General Use until the recipe associated to it is Approved for General 
Use.

You can change the status of recipes or validity rules to On-hold or Obsolete 
even if they are used in batches as long all these batches are closed or 
cancelled.

3. Organization displays the organization that owns this Validity Rule, and the 
Organization Description. This must be your Plant or Laboratory. You can 
enter and save a new Organization.

Validity Rule
4. Select Recipe Use as:

■ Production for use in production of products.

■ Planning for use in planning material consumption.

■ Costing for use in establishing costs. 

■ Technical for use in establishing technical classes and subclasses.

Required.

5. Enter a Product in the Formula for the Validity Rule. The product Description 
field displays. Required.
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6. Enter the Preference number for the Validity Rule. When more than one 
formula can be used to produce the same product, the Preference field is used to 
show the Validity Rule that must be used first, second, third, and so forth. 
Preference defaults to 1. Required.

For example, one formula can be used to produce between 10 and 150 gallons of 
a product. Another formula can be used to produce between 100 and 1000 
gallons of the same product. Since either formula can be used to produce 100 to 
150 gallons of material, the Preference field shows the suggested order of use. 
Lower numbers indicate a higher Preference. The number 1 indicates the 
highest Preference.

7. Enter the Standard Quantity of product made with this Formula. This quantity 
is only used for product costing. It does not restrict quantities that can be 
produced with the Formula. Standard defaults to the quantity provided in the 
Formula displayed. Required.

8. UOM is the unit of measure for the standard quantity. You can enter and save a 
different unit of measure. Required.

9. Enter the Minimum quantity of product that can be made using the Formula. 
Minimum defaults to 1. Required.

10. Enter the Maximum quantity of product that can be made using the Formula. 
Required.

11. Theoretical displays the theoretical process loss based on the Validity Rule 
Standard Quantity.

12. Enter the Planned process loss. This overrides planned process loss entered at 
the routing level.

13. Enter the From date as the date the Validity Rule becomes effective. The date 
must be within the effective date for any routing associated to the recipe. 
Required.

14. Enter To date as the date to stop using the Validity Rule. This is an optional 
field and must be left blank if no expiration date is defined for the Validity Rule.

Step Quantity
15. The following fields are display only:

■ Step displays the step number associated with the operation displayed.

■ Operation indicates the operation associated to the step. The operation 
Version displays.
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■ Description indicates a description of the operation.

■ Step Quantity and its UOM indicates the quantity processed by the routing 
step and the unit of measure of the step quantity.

■ Charges indicates the total calculated charges for the step.

16. Save the window.
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Displaying Validity Rules By Product
The Validity Rules Summary by Product window allows you to specify under 
which circumstances a recipe can be used. This window displays only if there is 
more than one validity rule available. Validity rules provide a combination of 
material quantities and a range of effective dates used by production and planning 
in one or more specified organizations. This window only displays validity rules 
that have not expired.

Prerequisites
❏ Enter and save recipes.

❏ Enter and save validity rules.

◗◗ To select a validity rule by product:
1. Navigate to the Validity Rules Summary By Product window.

2. The Find Validity Rules By Product window displays.

3. Enter the desired product item in the Find field.

4. Click Find. The window displays all recipes found for the item.

5. The following fields are display only:

■ Recipe displays the recipe that is the basis of the validity rule.

■ Version displays the Recipe version.

■ Recipe Description displays a brief description of the Recipe.

■ Organization displays the organization for which the validity rule can be 
used. This field is blank if any organization can use the validity rule.

■ Formula displays the formula associated with the Recipe.

■ Formula Version displays the version of the Formula.

■ Formula Description displays a brief description of the Formula.

■ Routing displays the routing associated with the Recipe.

■ Routing Version displays the version of the Routing.

■ Routing Description displays a brief description of the Routing.

■ Product displays the product code for the primary product used in the 
Recipe.
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■ Product Description displays a description of the primary product.

■ Recipe Use displays the intended use for the recipe. Firm Planned Orders 
can use Production or Planning validity rules.

■ Preference displays the preference number for the Validity Rule. When 
more than one formula can be used to produce the same product, the 
Preference field is used to show the the order of preference for a validity 
rule. Lower numbers are preferred. For example, a preference of 2 is higher 
than a preference of 5.

■ Start Date displays the first date the validity rule can be used.

■ End Date displays the last date the validity rule can be used. When this 
field is blank, there is no specified end date. 

■ Standard Quantity displays the standard quantity of material used for 
costing the formula. It does not restrict quantities that can be produced by 
the formula.

■ UOM displays the unit of measure for the Quantity fields.

■ Min Quantity is the minimum quantity of product that can be made using 
the recipe.

■ Max Quantity is the maximum quantity of product that can be made using 
the recipe.

6. Select the validity rule you want to use.

7. Click OK.

◗◗ To edit a validity rule:
Click Edit to edit a validity rule.
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Displaying Validity Rules By Recipe
The Validity Rules Summary by Recipe window allows you to specify under which 
circumstances a recipe can be used. This window displays only if there is more than 
one validity rule available. Validity rules provide a combination of material 
quantities and a range of effective dates used by production and planning in one or 
more specified organizations.

This window only displays validity rules that have not expired.

Prerequisites
❏ Enter and save recipes.

❏ Enter and save validity rules.

◗◗ To select a validity rule by recipe:
1. Navigate to the Validity Rules Summary By Recipe window.

2. The Find Validity Rules By Recipe window displays.

3. Enter the desired recipe in the Find field.

4. Click Find. The window displays all recipes found for the item.

5. The following fields are display only:

■ Recipe displays the recipe that is the basis of the validity rule.

■ Version displays the Recipe version.

■ Recipe Description displays a brief description of the Recipe.

■ Organization displays the organization for which the validity rule can be 
used. This field is blank if any organization can use the validity rule.

■ Formula displays the formula associated with the Recipe.

■ Formula Version displays the version of the Formula.

■ Formula Description displays a brief description of the Formula.

■ Routing displays the routing associated with the Recipe.

■ Routing Version displays the version of the Routing.

■ Routing Description displays a brief description of the Routing.

■ Product displays the product code for the primary product used in the 
Recipe.
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■ Product Description displays a description of the primary product.

■ Recipe Use displays the intended use for the recipe. Firm Planned Orders 
can use Production or Planning validity rules.

■ Preference displays the preference number for the Validity Rule. When 
more than one formula can be used to produce the same product, the 
Preference field is used to show the the order of preference for a validity 
rule. Lower numbers are preferred. For example, a preference of 2 is higher 
than a preference of 5.

■ Start Date displays the first date the validity rule can be used.

■ End Date displays the last date the validity rule can be used. When this 
field is blank, there is no specified end date. 

■ Standard Quantity displays the standard quantity of material used for 
costing the formula. It does not restrict quantities that can be produced by 
the formula.

■ UOM displays the unit of measure for the Quantity fields.

■ Min Quantity is the minimum quantity of product that can be made using 
the recipe.

■ Max Quantity is the maximum quantity of product that can be made using 
the recipe.

6. Select the validity rule you want to use.

7. Click OK.

◗◗ To edit a validity rule:
Click Edit to edit a validity rule.
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Displaying the Recipe Step/Material Association
The Recipe Step/Material Association window displays all items from the recipe 
formula and lets you associate these items with specific routing steps.

You can use folders with this window. See: Oracle Applications User’s Guide.

Prerequisites
❏ Enter and save recipes.

❏ If the Automatic Step Quantity Calculation is used:

– A routing must be associated with the recipe.

– Each item marked as contributing to step quantity must be associated with 
a step, and have a conversion specified between the standard mass unit of 
measure and standard volume unit of measure.

– All operations must use a mass or volume unit of measure.

◗◗ To display recipe step/material associations:
1. Navigate to the Recipe Step/Material Association window.

2. The following fields are display only:

■ Formula displays the formula used in a recipe with the Version and 
Formula Description.

■ Routing displays the routing used in a recipe with the Version and Routing 
Description.

Associations
■ Step displays the step number associated with the listed Operation in the 

displayed Routing. You cannot add a Step to a routing on this window. You 
must do this on the Routing Details window. Required.

■ Operation displays the operation associated with the Step. The operation 
Version is displayed.

■ Step Qty displays the default quantity of material associated with the Step. 
The UOM for the Step Quantity displays.

Note: Data appearing on this window is entered and saved using the 
Recipe Details window.
6-38 Oracle Process Manufacturing Product Development User’s Guide



Displaying the Recipe Step/Material Association
■ Line displays the Line number for each product, byproduct, or ingredient 
listed. Required.

■ Item displays the code associated with each product, byproduct, or 
ingredient listed.

■ Type displays the type of Line associated in the Step as a product, 
byproduct, or ingredient.

■ Item Qty displays the Quantity of product, byproduct, or ingredient 
yielded by the listed Formula.

■ Line UOM displays the unit of measure for the Item Quantity.

3. Close the window.

◗◗ Editing the association of materials and steps:
1. Enter the Step from the LOV. Required.

2. The following fields are display only:

■ Operation displays the operation associated with the Step. The operation 
Version is displayed.

■ Step Qty displays the default quantity of material associated with the Step. 
The UOM for the Step Quantity displays.

3. Enter the Line from the LOV. Required.

4. The following fields are display only:

■ Item displays the code associated with each product, byproduct, or 
ingredient listed.

■ Type displays the type of Line associated in the Step as a product, 
byproduct, or ingredient.

■ Item Qty displays the Quantity of product, byproduct, or ingredient 
yielded by the listed Formula.

■ Line UOM displays the unit of measure for the Item Quantity.

5. Save the window.
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Understanding the Recipe Designer
The Recipe Designer provides all functions that are accessible using the Routing, 
Formula, and Recipe Details windows. The Recipe Designer is used to create, copy, 
and edit a complete recipe that includes formulas, routings, validity rules, and 
process instructions.

Recipe Designer Components
The Recipe Designer window has three major components:

1. A navigator located in the top left pane displays:

■ A Recipe tab which displays a broad view of the product including material 
and process requirements.

■ A Formula tab which displays a material oriented view of the product.

■ A Routing tab which displays a process oriented view of the product.

The following navigator style formats are available:

■ Interleaved style that positions recipe components in a left-to-right 
orientation for each recipe with spatial adjustment for each component.

■ Organization chart style that positions recipe components in a 
top-to-bottom orientation for each recipe with spatial adjustment for each 
component as in an organization chart.

■ Vertical style that positions recipe components in a left-to-right orientation 
for each recipe with no spatial adjustment for each component.

2. A display of formula items in the bottom left pane has tabs that let you select all 
items, or filter out only products, byproducts, or ingredients. For each type of 
item, you can display those that are associated to steps, or those that are not 
associated to steps. You can also display a combination of those that are 
associated to steps and those that are not associated to steps.

3. A right pane displays the following views selected from tabs located at the 
bottom of the pane:

■ Process Instruction Sheet view that combines routing information. This 
view includes process requirements and formula details, including input 
output requirements.

■ Step Dependency Graph view that depicts the step dependencies within the 
routing associated to the recipe. All of the steps in the routing display are 
represented as a graphic image. Below each image is a step number, 
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operation code, and operation version. When you position the cursor over a 
step, text displays the complete description of that step. When you position 
the cursor over a line dependency that links two routing steps, text displays 
the transfer percentage between the routing steps.

The graphics that appear as nodes on the navigator are also used to identify the 
Recipe Designer components. Button graphics are described in the "Using the 
Recipe Designer" topic.

Understanding the Tab Pane
The Tab pane contains a Recipe tab, Formula tab, and Routing tab. 

■ The Recipe tab displays a Formula Items view or Item Master view. The 
Formula Items view displays a list of items in the present formula, and you can 
associate formula items to steps. The Formula Items view has several tabs that 
let you display a list of items by product, byproduct, or ingredient. Within each 
tab, you can view all items, items that are associated to routing steps, or items 
that are not associated to routing steps. The Item Master view displays items 
from the item master table, and you can add new items to the formula while 
assigning them to steps. The Process Instruction Sheet tab displays steps and 
associated items. It also displays formula, routing, and recipe level process 
instructions.

■ The Formula tab lists all items in a formula. You can create and maintain 
material requirements of a recipe. You can also maintain standard item level 
processing instructions. The Process Instruction Sheet tab displays formula 
details and standard item process instructions.

■ The Routing tab lets you create and edit routings. You can also maintain 
standard routing step level processing instructions. The Process Instruction 
Sheet tab displays routing step details and standard routing step process 
instructions.

Associating an Item to a Routing Step
The specification of material input and output for each step in a recipe is required if 
production and consumption of materials are controlled at the step level. The 
Formula Item view under the Recipe tab lets you select one or more items and 
assign them to a routing step in the navigator or on the routing step dependency 
graph using the drag-and-drop operation. This function is available when the View 
Unassigned Items option is selected on the Formula Item list. You can also use the 
Item Master option. The Item Master view displays items from the item master 
table, and you can add new items to the formula.
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Redistributing a Formula
When you select the Formula tab, all items associated to a step display by 
expanding the related node in the navigator. Then, by using the drag-and-drop 
operation or a cut and paste operation, you can move items from one routing step to 
another. The Process Instruction Sheet tab on the right pane reflects all changes you 
make.

Using Automatic Step and Number of Charges Calculation
The routing step quantities and the number of charges are calculated and updated 
on the Process Instruction Sheet pane when you change an item and step 
association. The calculation is performed when you select the Calculate Step 
Quantities indicator on the toolbar.

Understanding the Process Instruction Sheet Pane
The Process Instruction Sheet pane provides process engineers and formulators 
with the ability to display, develop, and maintain material and routing step 
associations as well as the process instructions for a specific recipe. Standard 
process instructions can be maintained at the formula item level and the routing 
step level. It provides navigator views of routing steps in interleaved, organization 
chart, or vertical display styles. It also presents multiple views of items in the 
formula.

The Process Instruction Sheet lets you:

■ Assign formula items to routing steps using the drag-and-drop operation.

■ Perform automatic step quantity and number of charge calculations.

■ Redistribute formula items from one step to another step using the 
drag-and-drop operation.

■ Display process instructions defined at the formula item level and at the routing 
step level.

■ Create, maintain, and view process instructions at the routing step, and at the 
item and step association level.

■ Combine process requirement inputs and production execution outputs within 
a single set of process instructions.

■ View the properties of recipes, routings, routing steps, operations, activities, 
resources, and items at the product, ingredient, and byproduct levels.
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Editing Process Instruction Text
Access the Process Instruction Text Editor from the right-mouse menu or the Tools 
menu. Process instructions are created and maintained for a specific operation item 
or step association row, or for a particular step in the recipe. Standard process 
instructions that are defined in the formula at the item level, or in the routing at the 
step level cannot be edited at the recipe level. Process instructions are stored in the 
standard text table against the paragraph code defined in the GMD: Process 
Instruction Paragraph profile option.

Differentiating Standard from Specific Process Instructions
Standard process instructions that are common to all recipes are defined in the 
formula or routing. Text displays in the Recipe Process Instruction Sheet pane; 
however, you cannot edit this text in the pane.

Standard process instructions maintained at the step level in the routing display 
under the routing step line. Display or hide process instructions by expanding or 
collapsing the corresponding routing step line. Process instructions defined at the 
step level for this particular recipe are displayed. The process instructions defined 
at the recipe level display with a yellow background to distinguish between the 
standard instructions that are defined at the routing level and the specific 
instructions that are defined at the recipe level. 
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Using the Recipe Designer
The Recipe Designer contains the following components:

■ A navigator view of the recipe in the top left pane. Display or hide descriptions 
on the navigator. You can expand components on the navigator by clicking the 
+ sign, or you can collapse components on the navigator by clicking the - sign. 
The navigator has a Material View and a Resource View that selectively 
displays materials such as products, byproducts, and ingredients, or routings 
composed of operations arranged in steps, activities, and resources.

■ A Formula Item view of the recipe in the bottom left pane.

■ A Process Instruction Sheet or a Step Dependency Graph in the right pane, 
depending on the tab selected.

Depending on the status of the recipe, the Recipe Designer is in update or view 
mode. You have the same update or view privileges for the Recipe Designer as you 
have for the Recipe Details window.

Prerequisites
❏ Define a paragraph code for process instructions using the GMD: Process 

Instruction Paragraph profile option. By default, the Recipe Designer uses PI as 
the default paragraph code.

◗◗ To display the Recipe Designer from the Quality Management menu:
Choose Recipe Designer from the Quality Management menu to display the Recipe 
Designer.

◗◗ To display the Recipe Designer from Quality Management windows:
You can find an existing recipe or create a new recipe within the Recipe Designer. 
You can display the Recipe Designer as follows:

1. Navigate to one of the following windows:

■ Recipe Details

■ Recipe Summary By...

■ Recipe Header Summary

2. Query the appropriate recipe.

3. Click Designer. The Recipe Designer window displays.
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Identifying Buttons on the Recipe Designer
The following discussion and graphic identify and explain each of the tools 
displayed on the Recipe Designer tool palette:

■ 1 is the Vertical Style button. Click it to display the vertical navigator style. 
Recipe components are positioned in a left-to-right orientation. There is no 
spatial adjustment for each component.

■ 2 is the Interleaved Style button. Click it to display the interleaved navigator 
style. Recipe components are positioned in a left-to-right orientation with 
spatial adjustment for each component.

■ 3 is the Org-Chart Style button. Click it to display the organization chart 
navigator style. Recipe components are positioned in a top-to-bottom 
orientation with spatial adjustment for each component.

■ 4 is the Find button. Click it when the Edit Process Instructions window is 
displayed to display the Find Text Token window. Text tokens are codes or 
short descriptions that represent longer descriptions or messages. These tokens 
are set up on the Text Token window. Refer to the Oracle Applications System 
Administration User’s Guide for a complete discussion on the creation and use of 
Text Tokens.

■ 5 is the Show/Hide Description button. Click it to display a description of the 
components shown in the navigator. Select it again to hide the description.

■ 6 is the Save button. Click it to save the changes made on the Recipe Designer. 
This option is not available if the Recipe Designer is in View mode.

■ 7 is the Refresh button. Click it to refresh the panes with data retrieved from the 
database.

■ 8 is the Exit button. Click it to exit from the Recipe Designer workbench.

■ 9 is the Show/Hide Operation Master button. Click it to display the Routing 
Operation Pane. Select it again to hide the Routing Operation Pane.

■ 10 is the Show/Hide Formula Items button. Click it to display the Formula Item 
Pane. Select it again to hide the Formula Item Pane.

■ 11 is the Drag Mode button. Click it to move steps around the graph pane using 
the drag-and-drop operation. This option is not available if the Recipe Designer 
is in View mode, or if the Process Instruction Sheet tab is selected.

■ 12 is the Connect Mode button. Click it to build dependencies between steps 
using the drag-and-drop operation. This option is not available if the Recipe 
Designer is in view mode.
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■ 13 is the Help button. Click it to display online help for the current window.

■ 14 is the Calculate Step Quantities indicator. Click it to calculate step quantities. 
Clear the box to indicate that steps are not calculated.

The following is a graphic of the previously described toolbar buttons:

Setting Up the GMD: Process Instruction Paragraph Profile Option
Many windows in Oracle Process Manufacturing applications let you associate text 
with a record of the edited document. For example you can attach text to a specific 
ingredient line in a formula. In this application, paragraphs are structures that are 
used to store and categorize text. The standard application has the General Text 
paragraph as the one default paragraph stored for each database table.

In order to provide the Recipe Designer with a means to distinguish between 
Process Instructions and other text types, your system administrator needs to define 
a paragraph code for process instructions. Text displayed in the Process Instruction 
Sheet in the Recipe Designer is the text defined for the paragraph code specified by 
the GMD: Process Instruction Paragraph profile option.

See Also
Oracle Process Manufacturing Implementation Guide

Oracle Process Manufacturing System Administrator User’s Guide

Using the Recipe Tab
The Recipe tab includes the following options:

Formula Items
If Formula Items is selected, then the list below the navigator displays the list of 
items in the formula and lets you associate formula items to steps.
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Item Master
When Item Master is selected, then the list below the navigator displays items from 
the item master table and you can add new items to the formula while assigning 
them to steps.

The following options are available when the Recipe tab is selected, letting you:

Mark For Purge
Select this option to delete a recipe. If the recipe is not marked for purge, then this 
function is available.

Edit Process Instructions
Select this option to create and maintain processing instructions for a recipe step, or 
step-item association. This option is enabled if a node representing a step or an item 
is selected.

Edit Properties
Select this option to view or edit properties of the selected node. You can edit recipe 
header, recipe step, and recipe step material properties. 

Change Status
Select this option to change the recipe, formula, or routing status. If changes are 
made to the components, then the application displays a warning message 
prompting you to save the changes. If the save option is selected, then the standard 
Change Status window displays.

Organization Details
Select this option to view or edit organization specific attributes of the current 
recipe. If changes are made to the recipe, then the application displays a warning 
message prompting you to save the changes. If the save option is selected, then the 
standard Validity Rules window displays.

Validity Rules
Select this option to view or edit Validity Rules for the current recipe. If changes are 
made to the recipe, then the application displays a warning message prompting you 
to save the changes. If save is selected, then the standard Validity Rules window 
displays.
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Undelete
Select this option to undelete a recipe. If the recipe is marked for purge, then this 
option is available.

Using the Recipe Properties Window
The Recipe Properties window displays information about the selected recipe. You 
can edit some fields on this window to edit the recipe.

Prerequisites
❏ Enter and save operations.

❏ Enter and save routings.

❏ Enter and save formulas.

❏ Enter and save recipes.

◗◗ To display the Recipe Properties window:
1. Navigate to the Recipe Properties window:

■ In the navigator, right-click the Recipe node, then choose Properties.

■ In the navigator, click the recipe, then choose Properties from the Actions 
menu.

Recipe
2. The following fields are display only:

■ Status displays the recipe status.

■ Recipe displays the recipe and its Version.

3. Description displays the recipe description. You can edit this field.

4. Owner displays the recipe owner. You can edit this field.

5. Owner Organization displays the owner organization for the recipe. You can 
edit this field.

6. Creation Organization displays the organization that created the recipe.

Formula
7. The following fields are display only:
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■ Status displays the formula status.

■ Formula displays the formula used in the recipe and its Version.

■ Description displays a description of the formula.

■ Total Output Quantity displays the total material yielded by the formula.

■ Main Product displays the primary product for the formula associated with 
the recipe.

■ Main Product Qty displays the quantity and UOM of the first product the 
formula produces.

Routing
8. Status displays the status of the routing used in the recipe.

9. Routing displays the routing used in the formula and its Version. You can edit 
these fields.

10. Description displays the routing description.

11. Planned Loss displays the planned material loss for the routing.

12. Theoretical Process Loss displays the theoretical process loss associated with 
the routing.

13. Click OK to close the window. If you edited recipe properties, then your 
changes are validated and saved.

◗◗ To display or edit the list of customers:
1. Click the Recipe tab on the Recipe Properties window.

2. Click Customers. The Customers property sheet displays.

3. Click Add to add a customer. Enter the customer and customer Name.

4. Click Delete to delete a customer.

5. Click OK to save your work.

◗◗ To enter or edit process loss:
1. Click the Recipe tab on the Recipe Properties window.

2. Click Plant/Laboratory. The Process Loss property sheet displays.

■ Enter the Organization. The Name displays the name of the organization.
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■ Type indicates whether this organization is a plant or a laboratory.

■ Enter the Process Loss for the Organization entered.

■ Click OK to save your work.

3. Click Add to add process loss for a specific organization.

4. Click Organization Details to display the Recipe Organization Details 
window.

5. Click Validity Rules to display validity rules to display the Recipe Validity 
Rules window.

6. Click Delete to delete process loss for a selected organization.

Finding a Recipe in the Recipe Designer
The Find Recipes window displays when you select the Recipe Designer option 
from the navigator. It also displays when you select the Open option from the File 
menu.

Prerequisites
❏ Optionally, enter and save operations.

❏ Optionally, enter and save routings.

❏ Enter and save formulas.

◗◗ To find a recipe in the Recipe Designer:
1. Choose the Recipe Designer menu from the navigator. The Find Recipes 

window displays.

2. Enter the appropriate search criteria to find the desired recipe.

3. Click Find. The lower region of the window displays recipes matching the 
entered criteria.

4. Select the appropriate recipe. The Recipe Designer displays with the selected 
recipe.

Creating a Recipe in the Recipe Designer
You can click New on the Find Recipes window, or select the New file option to 
create a new recipe. The Recipe Designer displays in the create mode. You can then 
navigate to the Recipe Properties window to enter additional recipe details.
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Using the Recipe Properties window, you can specify a formula and a routing 
marked for purge or with a status of On-hold or Obsolete. However, they cannot be 
modified and the recipe cannot be created with these components. Use the Save As 
option to create a new formula and routing for the recipe. Refer to the "Copying a 
Recipe And Its Components" topic for additional information.

If the formula and routing specified in the Recipe Properties window do not exist, 
then the application assumes that you intend to create these components in the 
Recipe Designer.

Formula is a required component of a recipe. However, you can create a recipe 
without a routing.

Prerequisites
❏ Enter and save operations.

❏ Enter and save routings.

❏ Enter and save formulas.

◗◗ To create a recipe:
1. Select Recipe Designer from the navigator. The Find Recipes window displays.

2. Click New. The Recipe Designer displays with New as the root node.

Changing Recipe Status
The Change Status window displays when you select one of the following options 
from the Actions menu:

■ Change Recipe Status

■ Change Routing Status

■ Change Formula Status

◗◗ To change recipe status:
1. Click the desired Recipe.

2. Choose Change Status from the Actions menu.

3. Enter the desired status for the recipe.

4. Click OK.
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◗◗ To view and edit recipe header information:
1. Click the desired Recipe.

2. Choose Properties from the Actions menu. You can also right-click the Recipe 
node and select Properties from the right-click menu. The Recipe Properties 
window displays.

3. Enter or edit the recipe header Description. When creating a new recipe, this 
defaults to the formula description. Required.

4. Owner defaults to the current user. This is validated against the user master 
table, and if not found, displays an invalid user message. Required.

5. Enter the Owner Organization. This defaults to the current user organization 
and is validated against the user organization table. Required.

Copying a Recipe and Its Components
When developing a new product, consider identifying an existing recipe with 
similar characteristics. Use this recipe as a template, and modify it to meet the 
specific new product requirements. Save the modified recipe.

To improve new product development efficiency and speed time to market, the 
ability to locate and load existing recipes as templates is necessary for promoting 
reuse of existing product definitions. The recipe and its material and process 
components that include formulas and routings, can be modified to meet new 
product requirements and saved as new entities.

Choose Save As from the File menu and the Save As window displays. You can 
specify the name, version, and description of the new recipe, routing, and formula. 
Once saved, the new recipe, routing, and formula are current. Note that the primary 
purpose of this function is to copy the current recipe. This window can also be used 
to replace the formula or routing in the current recipe.

◗◗ To copy a recipe and its components:
1. Choose Save As from the File menu. The Save As window displays.

2. Select the copy indicators for the recipe, formula, and routing that you are 
copying.

3. Click OK.

When copying a recipe, formula, or routing, the status of the new record is set to 
New. If the recipe is not copied, but one of its component is, then the current recipe 
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status is also set to New, because one of its components is copied and has a status of 
New.

Using the Formula Tab
The Formula Tab in the Recipe Designer displays information about the formula 
items. The following fields display:

■ Item number

■ Item description

■ Item unit of measure

The Formula tab has three item properties windows:

■ Ingredient Properties

■ Product Properties

■ Byproduct Properties

Using Formula Menu Options
The following options are available when you select the Formula tab.

Edit Process Instructions
Choose this option to create and maintain processing instructions for a formula 
item. This option is enabled when an item node is selected in the navigator.

Edit Properties
Choose this option to view or edit properties of the selected node in the navigator. 
You can edit formula header and formula item properties.

QC Specifications
Choose this option to view or edit production specifications for the formula. If 
changes are made to the formula, then the application displays a warning message 
prompting you to save the changes. If the save option is selected, then the standard 
Production Specifications window displays.

Change Formula Status
Choose this option to change the status of the current formula. If changes are made 
to the recipe, then the application displays a warning message prompting you to 
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save changes. If the save option is selected, then the standard Change Status 
window displays.

Ingredient Technical Parameters
Choose this option to display the Technical Parameters window for the selected 
ingredient. If changes have been made to the formula, then the application displays 
a warning message prompting you to save the changes. If the save option is 
selected, then the standard Ingredient Technical Parameters window displays.

Product Technical Parameters
Choose this option to display the Technical Parameters window for the selected 
product. If changes are made to the formula, then the application displays a 
warning message prompting you to save the changes. If the save option is selected, 
then the standard Product Technical Parameters window displays.

List Experimental Items
Choose this option to display the List Experimental Items window for the formula. 
If changes have been made to the formula, then the application displays a warning 
message prompting you to save changes. If the save option is selected, then the 
standard List Experimental Items window displays.

Technical Data Selection
Choose this option to specify the formula number and version from where to get the 
intermediate's technical parameter values, or to specify the formula number and 
version to use for the explosion of this intermediate during the formula ingredient 
contribution analysis calculation.

Scale Formula
Choose this option to scale formulas up or down by input or output.

Calculate Theoretical Yield
Choose this option to calculate theoretical yield.

Assign Access
Choose this option to assign formula security access.

eRecord Details
Choose this option to view electronic signature details.
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Creating a Formula in the Recipe Designer
When creating a new recipe, you can build a new formula within the Recipe 
Designer. If the formula entered in the Recipe Properties window exists, then you 
can edit the formula in the Recipe Designer and use Save As in the File menu to 
generate a new formula. You can also use an existing formula to serve as a template 
for the new formula.

If the formula entered in the Recipe Properties window does not exist, then there 
are several ways to create a formula in the designer.

■ Select the Formula tab to access the Formula navigator. The Item Master list 
displays. You can build the formula by associating items using the drag and 
drop operation.

■ Select the Recipe tab and choose the Item Master option to display the list of 
items. Choose the Step Dependency Graph tab. You can build the formula by 
associating items to the steps in the routing step dependency graph using the 
drag and drop operation.

■ Select the Recipe tab to access the Recipe navigator. Select the Item Master view. 
You can build the formula by associating items to the steps in the Recipe 
navigator using the drag and drop operation.

New Item Window
The Item Properties window displays when adding an item to the formula using 
one of the methods described above, provided the Display New Item Window user 
preference option is selected. Refer to the "Editing User Preferences" topic for 
additional information. You can enter basic item attributes in this window.

Click Edit Line to access the Ingredient, Product, or By Product Properties 
windows, depending on the type of item selected.

This section includes the following topics:

■ Changing Formula Status

■ Editing the Formula Header

■ Editing Formulas in the Recipe Designer

■ Using the Routing Tab
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Changing Formula Status
The Change Status window displays when you select one of the following options 
from the Actions menu:

■ Change Recipe Status

■ Change Routing Status

■ Change Formula Status

◗◗ To change formula status:
1. Navigate to the Recipe Designer.

2. Click the Formula tab in the navigator.

3. Choose Change Status from the Actions menu.

4. Enter a new status.

5. Click OK.

Editing the Formula Header
You can edit formula details in the Formula Properties window.

◗◗ To edit the formula header:
1. Navigate to the Recipe Designer.

1. Select the formula node in the navigator.

2. Click Properties from the Actions menu, or right-click and choose Properties 
from the menu.

3. Enter formula header data and click OK to save, or Cancel to close the window 
without saving.

Editing Formulas in the Recipe Designer
Click the Formula tab to edit formula specific data. The Formula navigator displays 
and the following functions are available:

■ Create and edit processing instructions at the formula item level

■ Add and remove items

■ Edit item properties
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■ Edit formula header properties

Creating and Editing Formula Item Process Instructions
Process instructions defined at the formula item level establish the standard 
procedure to follow when processing a particular material. Instructions are usually 
process independent, but are not required to be. Process related instructions can be 
defined at the routing step level, the recipe step level, or the routing item level. 
Formula item process instructions display in the Formula Process Instruction Sheet 
tab, and also in the Recipe Process Instruction Sheet tab.

Access the current Process Instruction editor by selecting an item in the Formula 
navigator and selecting Edit Process Instructions from the Tools menu.

◗◗ To view formula process instructions:
1. Navigate to the Recipe Designer.

2. Click the Formula tab in the navigator.

3. Choose the Process Instruction Sheet tab in the right pane of the Recipe 
Designer.

The Process Instruction Sheet tab displays item details in a hierarchical grid. If 
processing instructions are defined for an item, then you can expand the 
corresponding item to view the text.

All changes made to the formula in the designer are immediately displayed in the 
Formula Process Instruction Sheet.

Adding items to a formula
The item master list is a component below the recipe and Formula navigator. It 
displays items from the item master table and serves as the source for adding items 
to the formula. The item master list is not available if the formula is in view mode. 
You can sort the list by item, description, UOM, and category by clicking the 
appropriate column heading in the item list.

◗◗ To add an item to the formula:
1. Navigate to the Recipe Designer.

2. Display the Item Master list by clicking Show/Hide Formula Items on the 
toolbar, or check the Show Item List indicator from the View menu.

3. Choose Item Master in the lower region.
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4. If the Item Code indicator is selected, then enter an item code, or part of an 
item code in the Find field. If the Category indicator is selected, then enter a 
Category Code, or part of a category code in the Find field.

5. Choose the desired item in the list and associate it to the formula in the recipe, 
formula, or to a step in the routing dependency graph pane using the 
drag-and-drop operation.

6. Depending on user preferences, the New Item window displays, prompting 
you to enter item attributes.

Removing an Item from a Formula
If the item being removed is a product, then the application checks for validity rules 
associated to the product. If at least one valid validity rule exists, then an error 
message displays and the product cannot be deleted.

◗◗ To remove an item from a formula:
1. Navigate to the Recipe Designer.

2. Click the Formula tab in the navigator.

3. Expand the recipe to display the item to cut. Following are two methods for 
removing items:

■ In the navigator, right-click the item node, then choose Cut.

■ In the navigator, click the item node, then choose Cut from the Edit menu.

4. Save your work.

◗◗ To display assigned and unassigned item components:
1. Navigate to the Recipe Designer.

2. Click the Recipe tab in the navigator.

3. Click Formula Items. A pane showing all items in the formula displays below 
the navigator.

4. Select one of the following to display assigned, unassigned, or both assigned 
and unassigned items:

■ View Assigned to display only those items that are assigned to a routing 
step.

■ View Unassigned to display only those items that are not yet assigned to a 
routing step.
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■ View Assigned/Unassigned to display all items that are assigned or not yet 
unassigned to a routing step.

◗◗ To activate or disable automatic step calculation:
1. Navigate to the Recipe Designer.

2. Select the Calculate Step Quantities indicator on the toolbar. The following 
message displays:

Do you want to delete the current calculated step quantities? Y/N

■ Click Yes to delete recipe step quantities from the database and Process 
Instruction Sheet. The sheet is updated with the default step quantities in 
the routing.

■ Click No to retain the current calculated step quantities.

3. Clear the Calculate Step Quantities indicator to disable automatic step 
calculation.

◗◗ To define material input and output for a step:
1. Navigate to the Recipe Designer.

2. Click the Recipe tab in the navigator.

3. If the Formula Item pane is not displayed, then click Show/Hide Formula 
Items. A pane showing all items in the formula displays.

4. Select View Unassigned Items. The list of all items that are not assigned to a 
particular step displays.

5. Associate one or more items to a particular step by dragging the items in the 
Formula Item pane and dropping them onto a particular step either in the Step 
Dependency Graph or the navigator.

6. If the Calculate Step Quantities indicator is selected, then the step quantities 
and the number of charges are calculated, and the Process Instruction Sheet 
pane displays the revisions.

◗◗ To redistribute formula items:
1. Navigate to the Recipe Designer.

2. Click the Recipe tab in the navigator.

3. Use one of the following techniques to redistribute an item:
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■ Drag the item in the navigator, and drop it onto a target routing step in the 
navigator, or in the Step Dependency graph.

■ Click the item to redistribute. From the Edit menu, choose Cut. Then, select 
the target routing step in the navigator, or in the Step Dependency Graph. 
From the Edit menu, choose Paste.

4. Optionally, select the Calculate Step Quantities indicator to calculate and 
display the step quantities and the number of charges on the Process Instruction 
Sheet pane.

5. Save your work.

Editing Ingredient Header
The Ingredient Properties window is accessible from the Formula tab. You can also 
display ingredient properties from the New Item window that displays when 
adding a new ingredient to the formula.

◗◗ To edit ingredient properties
1. Navigate to the Recipe Designer.

2. Select the Ingredient node in the navigator.

3. Choose Properties from the Actions menu to display the Ingredient Properties 
window, or right-click an ingredient node in the recipe Formula navigator, and 
choose Properties from the right-click menu.

4. Edit the Ingredient Properties fields and click OK to save, or Cancel to close the 
window without saving.

Editing Product Properties
The Product Properties window is accessible from the Recipe navigator or from the 
Formula navigator. You can also display product properties from the New Item 
window that displays when adding a new product to the formula.

◗◗ To edit product properties:
1. Navigate to the Recipe Designer.

2. Select the Product node in the navigator.

3. Choose Properties from the Actions menu to display the Product Properties 
window, or right-click an ingredient node in the Recipe navigator or in the 
Formula navigator, and choose Properties from the right-click menu.
6-60 Oracle Process Manufacturing Product Development User’s Guide



Creating a Formula in the Recipe Designer
4. Edit the Product Properties fields and click OK to save, or Cancel to close the 
window without saving.

Editing By Product Properties
The By Product Properties window is accessible from the Recipe navigator or from 
the Formula navigator. You can also display byproduct properties from the New 
Item window that displays when adding a new byproduct to the formula.

◗◗ To edit byproduct properties
1. Navigate to the Recipe Designer.

2. Select the By Product node in the navigator.

3. Choose Properties from the Actions menu to display the By Product Properties 
window, or right-click an ingredient node in the Recipe navigator or in the 
Formula navigator, and choose Properties from the right-click menu.

4. Edit the By Product Properties fields and click OK to save, or Cancel to close 
the window without saving.

Entering Formulas for Item Technical Data
You can specify the formula to use in the item technical data calculation 
spreadsheet, and in formula analysis.

◗◗ To enter item technical data
1. Navigate to the Recipe Designer.

2. Click the Formula tab and select the appropriate intermediate ingredient in the 
Formula navigator.

3. Select the Technical Data Selection option from the Actions menu. Prior to 
displaying this window, the application verifies that the selected ingredient is 
an intermediate.

4. Click the Ingredient Contribution tab.

5. Enter the Technical Formula. This is the formula used by the laboratory 
spreadsheet to derive technical values.

6. Enter the formula Version.

7. Click the Technical tab.
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8. Enter the Contribution Formula. This is the formula used by formula analysis 
to derive indirect ingredient contribution.

9. Enter the formula Version.

10. Click OK to save your work.

Using the Routing Tab
In the Recipe Designer, select the Routing tab to view routing components.

Creating a Routing in the Recipe Designer
While creating a new recipe within the Recipe Designer, you can build a new 
routing. An existing routing can also be used as a template for a new routing.

You must select the Routing tab to edit and create routings. The Routing navigator 
displays and the following functions are available:

■ Create and edit processing instructions at the routing step level.

■ Add and remove steps.

■ Edit step properties.

■ Edit routing header properties.

◗◗ To create or edit routing properties:
1. Navigate to the Recipe Designer.

2. Select the Routing node in the navigator.

3. Choose Properties from the Tools menu to display the Routing Properties 
window.

4. Enter routing header information and click OK to save.

Adding Operation Steps
The Operation List displays all operations in the operations. It serves as the source 
for adding new operations to a routing. This list is not available when the routing is 
in view mode.

◗◗ To add a new operation step:
1. If the operation list is not displayed, then click Show/Hide Operation Master. 

The operation list displays.
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2. Select an operation from the list and associate it to the routing in the navigator 
or in the Routing Dependency Graph pane. When adding a step to the routing, 
the application validates the operation and displays the Operation Step 
Properties window. You can review or override the default values in this 
window.

3. Save your work.
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Using the Process Instruction Sheet
The Process Instruction Sheet pane is a view only user interface that displays on the 
right side of the Recipe Designer. It is a hierarchical grid that combines the details of 
the three main components of the recipe: routing steps, the formula items associated 
to the steps, and the process instructions. The Process Instruction Sheet updates 
automatically, and instantaneously reflects any changes that you make.

Standard process instructions are defined at the routing step level and at the 
formula item level. These instructions are generic and apply to any recipes that use 
the routing and the formula. These standard instructions are shown in the Process 
Instruction Sheet, but cannot be amended in the recipe.

The standard process instructions maintained at item level in the formula display 
under the item line. You can show or hide process instructions by expanding or 
collapsing the corresponding item line. The process instructions defined at the step 
and item association level for the selected recipe are displayed. The process 
instructions defined at the recipe level appear with a yellow background to 
distinguish between standard instructions defined at the formula level, and the 
specific instructions defined at the recipe level.

In order to define process instructions that are specific to a particular recipe, use the 
Edit Process Instruction window.

Process instructions are defined at two separate levels within a recipe:

■ At the routing step level with instructions that need to be considered at a 
specific stage in the process.

■ At the routing step and item level with instructions that are specific to the 
processing of a specific item at a particular stage in the process.

◗◗ To create or edit process instructions:
1. There are two methods to display the Edit Process Instructions window:

■ In the navigator, right-click the appropriate item line for a product, 
ingredient, byproduct, or routing step, then choose Edit Process 
Instructions.

■ In the navigator, click the appropriate item line for a product, ingredient, 
byproduct, or routing step, then choose Edit Process Instructions from the 
Tools menu.

2. Enter or edit text.

3. Click OK.
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4. Save your work.

◗◗ To add text tokens to process instructions:
1. There are two methods to display the Edit Process Instructions window:

■ In the navigator, right-click the appropriate item line for a product, 
ingredient, byproduct, or routing step, then choose Edit Process 
Instructions.

■ In the navigator, click the appropriate item line for a product, ingredient, 
byproduct, or routing step, then choose Edit Process Instructions from the 
Tools menu.

2. Click Find. Select the appropriate text tokens.

3. Click OK. The full text for the text token displays in the Process Instructions 
window.

4. Save your work.
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Expanding and Collapsing Nodes
You can expand all nodes to view the entire recipe structure in the navigator. This 
feature is also available in the Routing and Formula navigators. The following 
options can be selected from the Tools menu to expand or collapse a selected node 
or the entire navigator with just one click. You can also right-click a node in the 
navigator and select one of the following options from the right-click menu:

■ Expand the selected node. Choose this option to expand the selected node and 
subnodes.

■ Collapse the selected node. Choose this option to collapse the selected node and 
subnodes.

■ Expand All. Choose this option to expand the entire navigator.

■ Collapse All. Choose this option to collapse the entire navigator.
6-66 Oracle Process Manufacturing Product Development User’s Guide



Editing User Preferences
Editing User Preferences
The Preferences window provides the ability to maintain preferences related to the 
formula. Formula preferences are used to customize the behavior of the application 
when the following actions are performed:

1. Add a new item to the formula

2. Search an item in the Item Master list

User preferences are defined using profile options. They can be updated through 
the standard Profiles window, or through the Preferences window in the Recipe 
Designer.

◗◗ To edit preferences:
1. Navigate to the Recipe Designer.

2. Select Preferences from the Actions menu. The Preferences window displays.

Formula
3. Select the Display New Item Window to display the New Item window when 

adding a new item. This prompts you to review and override the default item 
attributes. Clear this box to review and edit default values later using the Item 
Properties window.

4. Enter a Category Set to display on the Item Master List, otherwise leave this 
field blank.

Routing
5. Select one of the following:

■ Display Step Properties Window to display the Step Properties window 
when you add a new step.

■ Generate Step Number Automatically to generate a step number 
automatically when you add a new step.

6. Select one of the following:

■ Display Step Properties Window to display the Step Properties window 
when you create a new step dependency.

■ Generate Default Attributes to generate the default step attributes when 
creating a step dependency. Select the Dependency Type as Finish-to-start 
or Start-to-start.
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Step Dependency Graph
7. Select Display Step Quantity to display the quantity of each step. Clear this 

box to hide step quantities.

8. Select Display Transfer Percentage to display the transfer percentages between 
steps. Clear this box to hide transfer percentages between steps.

Process Instructions
9. Language displays the default language. You can edit this field. Description 

displays a description of the Language code.

10. Click OK.
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Tools

This topic presents multipurpose tools that help you manage recipes, formulas, 
routings, and operations. It includes a basic understanding of each tool. Several 
customer requirements are stated for Product Development tools and some typical 
solutions are provided. A discussion of tools shows you how Product Development 
enhances your ability to manage routine and advanced search and replace 
operations.

The following topics provide a basic understanding of tools:

■ Understanding Search and Replace

■ Requirements

■ Solutions

■ Performing a Search and Replace
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Understanding Search and Replace
The Product Development Search and Replace window lets you to search for and 
replace records in:

■ Operations

■ Routings

■ Formulas

■ Recipes

The Find list enables you to select the target for the search, such as an operation or a 
routing. You can only search for one target at a time. The Basic and Advanced 
search regions let you specify conditions to narrow the search. Once you have 
selected a target, and initiated a search, clear the window before searching for a new 
target.

Using the Basic Search Region
The Basic search region enables you to specify any combination of Name, Version, 
Description, Owner, or Status. Enter specific search data, or use the wildcard % for 
search string matching.

For example, if you search for:

Owner JDOE

Name A%

The results contain all entries where the Owner is JDOE and that start with the 
letter A.

Using the Advanced Search Region
The Advanced search region enables you to specify conditions to narrow the search 
for one or more Item field entries. You can specify different conditions for each 
search target.

Specifying the Item Field in an Advanced Search
■ For Operations you can specify search conditions for:

■ Effective End Date

■ Effective Start Date

■ Inactive
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■ Operation

■ Operation Class

■ Operation Version

■ Owner

■ Resource

■ Status

■ For Routings you can specify search conditions for:

■ Effective End Date

■ Effective Start Date

■ Inactive

■ Operation

■ Owner

■ Routing

■ Routing Class

■ Routing Version

■ Status

■ For Formulas you can specify search conditions for:

■ Byproduct

■ Inactive

■ Formula

■ Formula Class

■ Formula Version

■ Ingredient

■ Owner

■ Product

■ Status

■ For Recipes you can specify search conditions for:

■ Formula
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■ Owner

■ Owner Organization

■ Recipe

■ Routing

■ Status

■ Version

Specifying the Condition Field in an Advanced Search
In an advanced search of operations, routings, formulas, or recipes, select any of the 
following conditions for one or more Items entered:

■ Equal To finds targets equal to the specified Value entered.

■ Greater Than finds targets greater than the specified Value entered.

■ Less Than finds targets less than the specified Value entered.

■ Greater Than or Equal To finds targets greater than or equal to the specified 
Value entered.

■ Less Than or Equal To finds targets less than or equal to the specified Value 
entered.

■ In finds targets that contain the information specified in single quotation marks.

For example, if you specify the Item as Owner, select the Condition In, and 
enter ’JDOE’ as the Value, you find all targets whose owners are JDOE. You can 
enter one or several Values for the search. You must separate each entry with a 
comma. 

For example, if you specify the Item as Product, select the Condition In, and 
enter ’FORMULA 101’,’ROUTING 100’ you find each target product that 
contains the entries specified within single quotation marks.

■ Not In finds targets that do not contain the information specified in single 
quotation marks.

For example, if you specify the Item as Owner, select the Condition Not In, and 
enter ’JDOE’ as the Value, you find all targets whose owners are not JDOE. You 
can enter one or several Values for the search. You must separate each entry 
with a comma. 
7-4 Oracle Process Manufacturing Product Development User’s Guide



Understanding Search and Replace
For example, if you specify the Item as Product, select the Condition Not In, 
and enter ’FORMULA 101’,’ROUTING 100’ you find each target product that 
does not contain entries specified within single quotation marks.

■ Like finds targets similar to the the information specified using the wildcard %.

For example, if you specify the Item as Product, select the Condition Like, and 
enter FORM% you find each target Product that contains entries with the letters 
FORM.

Mass Search and Replace Security
Your System Administrator sets up the security level for Mass Search and Replace. 
This is done in the System Administrator responsibility using the Applications 
Functions window. When functions are registered for the appropriate responsibility 
that can use Mass Search and Replace two parameters are passed with the following 
settings:

■ Enable_status=No disables the ability to make a change of status using Mass 
Search and Replace. If you cannot change status and you feel you should be 
able to, please contact your System Administrator.

■ Enable_status=Yes is the default and enables the responsibility to make a 
change of status using Mass Search and Replace.

■ Enable_replace=No disables the replace capability. If you cannot use the replace 
capability, and you feel you should be able to, please contact your System 
Administrator.

■ Enable_replace=Yes is the default and enables the responsibility to use the 
replace capability.
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Requirements
Following are some requirements that customers have for tools in Product 
Development.

Can the application perform a mass search and replace for ingredients 
in formulas?
Yes. By using the Product Development Search and Replace tool, the application 
searches for and replaces specified records in recipes, formulas, routings, and 
operations.

Does mass search and replace support change management control by 
allowing status and version updates?
Yes. As part of change management control, mass search and replace enables rapid 
component substitution while supporting status and version control updates for 
each formula, recipe, routing, or operation affected by the substitution.
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Solutions
Product Development provides solutions to help resolve issues at every stage of the 
product development process. The following represent some of the key 
management solutions for tools.

Product Development Search and Replace Provides Efficient Substitutions in Formulas, 
Routings, Operations, and Recipes  The Product Development Search and Replace 
window enables the identification and replacement of key components in formulas, 
routings, operations, and recipes for single or multiple organizations. The basic 
features of the search and replace tool permit the query for fundamental 
components such as the name, version, description, owner, and status. Advanced 
search and replace features facilitate the search and replacement of components 
using conditions and specific values in formulas, routings, operations, and recipes.

Mass Search and Replace Supports Change Management Control  Formula ingredient 
substitution is a critical business need for process industries to meet stringent 
product specifications during batch production. The tool enables rapid 
identification and replacement of approved ingredient substitutions.

Ingredients are replaced for various business reasons such as obsolescence, 
customizations, pricing, or regulatory compliance. Mass Search and Replace takes 
into account the affected formula and status in order to recalculate step quantities, 
technical parameters, and formula contribution by class and subclass. As part of 
change management control, this tool assists in the management of status and 
version for each changed component.
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Performing a Search and Replace
The Product Development Search and Replace window lets you search for and 
replace components in recipes, formulas, operations, and routings.

You cannot replace components in recipes, formulas, operations, or routings that 
have a status of Obsolete/Archived. If you attempt to replace any components in 
these entities, then you get an error message indicating that you can only change 
the status. You can search for recipes, formulas, operations, or routings that are 
obsoleted or archived. The Update indicator is cleared for these entities. If you 
attempt to select the Update indicator, then you get an error message that indicates 
you can only update the status.

Prerequisites
❏ Determine if your responsibility has the authority to use the Search and Replace 

function.

❏ Read the Understanding Search and Replace topic.

◗◗ To search for and replace components:
1. Navigate to the Product Development Search and Replace window.

2. Select Operations, Routings, Formulas, or Recipes from the Find list to specify 
the type of records you need to search and replace.

3. The Basic and Advanced regions let you specify the search criteria.

Enter one or more of the search parameters. It is not necessary to enter them all. 
You can use string search matching by entering % as wildcard.

Basic
4. Enter the Name of the record type you need to search and replace. 

5. Enter the Version number of the record type you need to search and replace.

6. Enter the Description of the record type you need to search and replace.

7. Select a Status of the record type you need to search and replace.

8. You have the option to:

■ Click Find to search for all records that match the Basic search criteria. If 
you do this, proceed to step 11.

■ Click the Advanced region to enter additional search criteria. If you do this, 
proceed to step 9.
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Advanced
9. Enter an Item, Condition, and Value to specify a condition for the search. For 

example, to search for all formulas with a version of 1, select Formula Version 
as the Item, Equal To as the Condition, and enter a Value of 1.

10. Click Find to search for all records that match Basic and Advanced search 
criteria.

11. The Results of the search display. If no results are found, you not able to use 
GoTo or Replace. To review the details for each record found perform one of 
the following:

■ Double-click the drill down indicator next to the appropriate Name.

■ Select the appropriate Name and click Go To.

Return to the Product Development Search and Replace window to continue.

Replace
12. Click the Replace region.

13. Select the component to be replaced from the Replace list. Enter the Old 
component Name and, if required, the Version.

14. Enter the New component Name to replace in selected Results. If required, 
enter a new Version. If the component being replaced is a formula, enter an 
appropriate Scale Factor. You can replace ingredients using a scale factor 
greater than zero. However, you cannot replace ingredients using a negative 
scale factor.

15. Select the Update check box next to each Name that you want to replace with 
the entry made in the New Name field. To update the entire list, select Select 
All from the Actions menu. To clear all selections, select Deselect All from the 
Actions menu.

16. Press Replace to perform the specified changes. The message "Are you sure you 
want to replace this?" is displayed:

■ Enter Y to indicate that you want to replace the selected records with the 
New Name field. 

Note:  You cannot use the Replace capability unless you have 
proper authorization. Contact your System Administrator if you 
have questions regarding this authorization.
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■ Enter N to indicate that you do not want to replace the selected records 
with the New Name field.

If automatic version control is not active, the message "Create new version?" 
displays.

■ Enter Y to indicate that you want to create a new version.

■ Enter N to indicate that you do not want to create a new version.

If no records are found that meet the replace criteria, the message "No records 
were found that meet the replace criteria." is displayed.

17. Note the Request ID number displayed.

18. Choose View from the menu, and choose Requests to view the status of your 
request in the concurrent program manager. 

19. When your Request ID has completed normally, select View Log to determine 
if there were any problems. The log displays all successful and failed updates. 
The log specifies if there were no records found for the replacement operation.
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A

Product Development Navigator Paths

Although your System Administrator may have customized your Navigator, typical 
navigation paths are described in the following tables. In some cases, there is more 
than one way to navigate to a window. These tables provide the most typical 
default path.

Window Path

Activities Process Engineer:Setup:Activities

Activity Properties Process Engineer:Routing Designer 
Navigator:right-click the activity:choose 
Properties

Process Engineer:Routing Designer 
Navigator:click the activity:choose 
Properties from the View menu

Alternate Resources Process Engineer:Setup:Alternate 
Resources

By-Product Properties Formulator:Recipe Designer:Find 
Recipes:Recipe or Formula tab:right-click 
the byproduct node:choose Properties

Recipe Designer Material View 
navigator:right-click the byproduct 
node:choose Properties

Recipe Designer Material View 
navigator:click the byproduct node:choose 
Properties from the View menu

Calculate Theoretical Yield Recipe Designer:Find Recipes:select the 
Formula tab:choose Calculate Theoretical 
Yield from the Actions menu
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Customers Formulator:Recipe Designer:Find 
Recipes:choose Customers from the 
Actions menu

Display Calculation Errors Formulator:Spreadsheet:
Actions:Calculation Errors

Find Analysis Formulator:Formula 
Analysis:Analysis:Formula Ingredient 
Contribution Analysis:View:Find...

Find Formulas (from the Product 
Development Workbench)

Formulator:Formulator Workbench:click 
the Formula tab:View:Find...

Find Formulas (from the View Menu) Formulator:Formulas:Formula 
Details:View:Find...

Find Operations (from the Product 
Development Workbench)

Process Engineer:Engineering 
Workbench:click the Operation 
tab:View:Find...

Find Operations (from the View Menu) Process Engineer:Operations:Operation 
Details Activities:View:Find...

Find Recipe Organization Details Formulator:Recipes:Recipe Details:click 
Organization Details

Find Recipes (from the Product Development 
Workbench)

Formulator:Formulator Workbench:click 
the Recipe tab:View:Find...

Find Recipes (from the Recipe Designer) Formulator:Recipe Designer

Formulator:Recipe Designer:Find 
Recipes:File:Open

Find Recipes (from the View Menu) Process Engineer:Recipes:Recipe 
Details:View:Find...

Find Routings (from the Product 
Development Workbench)

Process Engineer:Engineering 
Workbench:click the Routing 
tab:View:Find...

Find Routings (from the Routing Designer) Process Engineer:Routing Designer 
Navigator

Process Engineer:Routing Designer 
Navigator:File:Open

Find Routings (from the View Menu) Process Engineer:Routings:Routing 
Details:View:Find...

Find Spreadsheets Formulator:Spreadsheet:View:Find...

Window Path
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Find Status Codes Formulator:Setup:Status 
Codes:View:Find...

Formula Analysis Parameters Formulator:Formula Analysis:Parameters

Formula By-Product Line Edit Formulator:Formulator Workbench:click 
the Formula tab:expand Formulas:expand 
a formula:select By-Products:Formula 
By-Product Summary:select a Line:click 
Edit Line

(also available from Formula By-Product 
Line Summary, Formula By-Product Lines, 
and Formula Details)

Formula By-Product Line Summary Formulator:Formulator Workbench:click 
the Formula tab:expand Formulas:expand 
a formula node:expand By-Products:select 
a byproduct node

Formula By-Product Lines Formulator:Formulator Workbench:click 
the Formula tab:expand Formulas:select a 
formula:Formula Header Summary:click 
By-Products

(also available from Formula By-Product 
Summary and Formula Details)

Formula By-Product Summary Formulator:Formulator Workbench:click 
the Formula tab:expand Formulas:expand 
a formula:select By-Products

Formula Classes Formulator:Setup:Formula Class

Formula Details Formulator:Formulas

(also available from Formulas Summary 
By... and Formula Header Summary)

Formula Header Summary Formulator:Formulator Workbench:click 
the Formula tab:expand Formulas:select a 
formula node label

Formula Ingredient Contribution Analysis Formulator:Formula Analysis:Analysis

Window Path
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Formula Ingredient Line Edit Formulator:Formulator Workbench:click 
the Formula tab:expand Formulas:expand 
a formula node:select Ingredients:Formula 
Ingredient Summary:select a Line:click 
Edit Line

(also available from Formula Ingredient 
Line Summary, Formula Ingredient Lines, 
and Formula Details)

Formula Ingredient Line Summary Formulator:Formulator Workbench:click 
the Formula tab:expand Formulas:expand 
a formula node:expand Ingredients:select 
an ingredient node

Formula Ingredient Lines Formulator:Formulator Workbench:click 
the Formula tab:expand Formulas:select a 
formula:Formula Header Summary:click 
Ingredients

(also available from Formula Ingredient 
Summary and Formula Details)

Formula Ingredient Summary Formulator:Formulator Workbench:click 
the Formula tab:expand Formulas:expand 
a formula node:select Ingredients

Formula Inquiry Selection Formulator:Formula Inquiry

Formula Inquiry Summary View Formulator:Formula Inquiry:Formula 
Inquiry Selection

Formula Product Line Edit Formulator:Formulator Workbench:click 
the Formula tab:expand Formulas:expand 
a formula node:select Products:Formula 
Product Summary:select a Line:click Edit 
Line

(also available from Formula Product Line 
Summary, Formula Product Lines, and 
Formula Details)

Formula Product Line Summary Formulator:Formulator Workbench:click 
the Formula tab:expand Formulas:expand 
a formula node:expand Products:select a 
product node

Window Path
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Formula Product Lines Formulator:Formulator Workbench:click 
the Formula tab:expand Formulas:select a 
formula node:Formula Header 
Summary:click Products

(also available from Formula Product 
Summary)

Formula Product Summary Formulator:Formulator 
Workbench:expand Formulas:expand a 
formula node:select Products

Formula Properties Formulator:Recipe Designer:Find 
Recipes:choose the Formula tab:select a 
formula node:Actions:Properties

Formula Summary By... Formulator:Formulator Workbench:click 
the Formula tab:choose View By:select 
Class, Status, Owner, Laboratory, Product, 
or Plant:expand Formulas By...:select an 
unexpanded node

Indented Bill of Materials Report Formulator:Indented Formulas

Ingredient Properties Formulator:Recipe Designer:Find 
Recipes:Recipe or Formula tab:right-click 
the ingredient node:choose Properties

Recipe Designer Material View 
navigator:right-click the ingredient 
node:choose Properties

Recipe Designer Material View 
navigator:click the ingredient:choose 
Properties from the View menu

Item Technical Data Formulator:Technical Data:Item Technical 
Data

Item Technical Data Selection Formulator:Recipe Designer:Find 
Recipes:choose Formula tab:select 
intermediate ingredient:choose Technical 
Data Selection from the Actions menu

Formulator:Formulas:Formula 
Details:choose Technical Data Selection 
from the Actions menu

Items Formulator:Inventory Items

Window Path
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New Item Formulator:Recipe Designer:Find 
Recipes:click the Recipe tab:associate items 
to the formula in the navigator (window 
displays only when the Display New Item 
Window user preference is selected)

Operation Activity Process Engineer:Operations:Operation 
Details Activities:select an activity:click 
Resources

Operation Activity Line Process Engineer:Engineering 
Workbench:click the Operation tab:chose 
View By Operations:expand 
Operations:select an operation 
node:Operation Header Summary:click 
Details:Operation Details Activities:select 
an activity

(also available from Operation Activity 
Line Summary)

Operation Activity Line Summary Process Engineer:Engineering 
Workbench:click the Operation tab:choose 
View By Operation:expand Operations, 
expand an operation node:select an 
activity

Operation Classes Process Engineer:Setup:Operation Classes

Operation Details Activities Process Engineer:Operations

(also available from Operation Summary 
By..., Operation Header Summary, and 
Routing Details) 

Operation Details Activity-Resource Process Engineer:Operations:Operation 
Details Activities:query an operation:select 
an Activity:click Resources

Operation Header Summary Process Engineer:Engineering 
Workbench:click the Operation tab:choose 
View By Operation:expand 
Operations:select an operation node label

Window Path
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Operation Resource Line Process Engineer:Engineering 
Workbench:click the Operation tab:choose 
View By Operation:expand 
Operations:select an operation:Operation 
Header Summary:click Details

(also available from Operation Details 
Activity-Resource)

Operation Resource Line Summary Process Engineer:Engineering 
Workbench:click the Operation tab:choose 
View By Operation:expand 
Operations:expand an operation 
node:expand an activity node:select a 
resource

Operation-Resource Process Parameters Process Engineer:Operations:select the 
desired Activity:click Resources:click 
Parameters

Operations Summary By... Process Engineer:Engineering 
Workbench:click the Operation tab:choose 
View By Class or Status:expand 
Operations By...:select unexpanded 
operation node

Preferences Formulator:Recipe Designer:Find 
Recipes:choose Prefs Menu from the 
Actions menu

Product Development Search and Replace Formulator:Mass Search And Replace

Product Development Workbench Process Engineer:Engineering Workbench

Product Properties Formulator:Recipe Designer:Find 
Recipes:Recipe or Formula tab:right-click 
the product node:choose Properties

Recipe Designer Formulator:Recipe Designer

Process Engineer:Recipe Designer

Formulator:Recipes:query the desired 
recipe:click Designer

(also available from Recipe Summary and 
Recipe Header Summary)

Window Path
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Recipe Details Process Engineer:Recipes

Formulator:Recipes

(also available from Recipe Header 
Summary and Recipes Summary By...)

Recipe Header Summary Formulator:Formulator Workbench:click 
the Recipe tab:choose View By 
Recipe:expand Recipes:select a recipe node 
label

Recipe Organization Details Formulator:Recipe Orgn Details:Find 
Recipe Organization Details:enter search 
parameters:click Find

(also available from Recipe Details)

Recipe Properties Recipe Designer:right-click the recipe 
node:choose Properties

Recipe Designer:click the recipe:choose 
Properties from the View menu

Recipe Step/Material Association Formulator:Formulator Workbench:click 
the Recipe tab:choose View By 
Recipe:select a recipe:Recipe Header 
Summary:click Details:Recipe Details:click 
Step/Material Association

Recipe Validity Rules Formulator:Recipes:query a recipe on the 
Recipe Details window:click Validity Rules

Formulator:Formulator Workbench:click 
the Recipe tab:choose View By 
Recipe:expand Recipes:select a recipe 
node:Recipe Header Summary:click 
Validity Rules tab:select desired validity 
rule:click Details

(also available from Recipe Header 
Summary)

Recipes Summary By... Formulator:Formulator Workbench:click 
the Recipe tab:choose View By Status or 
Owner:expand Recipes By...:select 
unexpanded node

Window Path
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Resource Properties Process Engineer:Routing Designer 
Navigator:right-click resource:choose 
Properties

Process Engineer:Routing Designer 
Navigator:click the resource:choose 
Properties from the View menu

Resource Information Process Engineer:Setup:Plant Resources

Resources Process Engineer:Setup:Generic Resources

Retrieve Spreadsheet Formulator:Spreadsheet:choose Retrieve 
Spreadsheet from Actions menu

Routing Classes Process Engineer:Setup:Routing Classes

Routing Designer Process Engineer:Routing Designer

Process Engineer:Routings:query the 
desired routing:click Designer

(also available from Routing Summary and 
Routing Header Summary)

Routing Details Process Engineer:Routings

(also available from Routings Summary 
By... and Routing Header Summary)

Routing Header Summary Process Engineer:Engineering 
Workbench:click the Routing tab:choose 
View By Routing:expand Routings:select a 
routing node label

Routing Properties Process Engineer:Routing Designer 
Navigator:right-click the routing:choose 
Properties

Process Engineer:Routing Designer 
Navigator:click the routing:choose 
Properties from the View menu.

Routing Step Dependencies Process Engineer:Routings:Routing 
Details:query a routing:select a Step:click 
Step Dependencies

Window Path
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Routing Step Dependency Properties Routing Designer:displays automatically 
after drawing connection between two 
steps

Routing Designer:double-click the line 
connecting two steps

Routing Designer right pane:right-click the 
line connecting two steps:choose 
Properties

Routing Step Line Process Engineer:Routings:Routing 
Details:query a routing:select a Step

(also available from Routing Step Line 
Summary)

Routing Step Line Summary Process Engineer:Engineering 
Workbench:click the Routing tab:select 
View By Routing:expand Routings:expand 
a routing node:select an operation node

Routing Step Properties Process Engineer:Routing Designer 
Navigator:right-click the routing 
step:choose Properties

Process Engineer:Routing Designer 
Navigator:click the routing step:choose 
Properties from the View menu

Routing Designer routing graph 
pane:double-click the routing step

Routings Summary By... Formulator:Formulator Workbench:click 
the Routing tab:choose View By Class, 
Status, or Owner:expand Routings 
By...:select an unexpanded node

Save As (Recipe) Formulator:Recipe Designer:Find 
Recipes:File:Save As

Process Engineer:Recipe Designer:Find 
Recipes:File:Save As

Save As (Routing) Process Engineer:Routing 
Designer:File:Save As

Save Spreadsheet Formulator:Spreadsheet:select Retrieve 
Spreadsheet from Actions menu:make 
appropriate changes:choose Save 
Spreadsheet from Actions menu

Window Path
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Scale Formula Formulator:Recipe Designer:Find 
Recipes:select the Formula tab:choose Scale 
from the Actions menu

Spreadsheet Formulator:Spreadsheet

Status Codes Formulator:Setup:Status Codes

Status Details Formulator:Setup:Status Codes:click 
Details

Technical Parameter Sequences Formulator:Technical Data:Technical 
Parameter Sequences

Technical Parameters Formulator:Technical Data:Technical 
Parameters

Formulator:Formulas:Formula 
Details:query the formula:select 
Ingredients region:select Line containing 
technical parameters:select Ingredient 
Technical Parameters from Actions menu

Theoretical Process Loss Process Engineer:Product Development 
Workbench:click the Routing tab:expand 
Routings:click a Routing:Routing Header 
Summary:click Theoretical Process Loss

Validity Rule Summary By Product Formulator:Validity Rules - Product

Validity Rule Summary By Recipe Formulator:Validity Rules - Recipe

Window Path
Product Development Navigator Paths A-11



A-12 Oracle Process Manufacturing Product Development User’s Guide



Product Development Profile Op
B

Product Development Profile Options

During your implementation, you set a value for selected profile options to specify 
how your Product Development application controls access to and processes data. 
Product Development uses the listed profile options.

■ GMD: Automatic Generation Of Step Dependency Attributes

■ GMD: Automatic Step Number Generation

■ GMD: Byproduct Active

■ GMD: Default Consumption/Yield Type

■ GMD: Default Dependency Type

■ GMD: Default Step Release Type

■ GMD: Default Lab Organization

■ GMD: Density

■ GMD: Designer Category Set

■ GMD: Designer Display New Item Window

■ GMD: Display Step Qty In Routing Graph

■ GMD: Display Transfer Pct In Routing Graph

■ GMD: Display Transfer Qty In Routing Graph

■ GMD: Effective Maximum Date

■ GMD: Effective Minimum Date

■ GMD: Enforce Step Dependency

■ GMD: Exact Specification Match
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■ GMD: Formula Version Control

■ GMD: Operation Version Control

■ GMD: Process Instruction Paragraph

■ GMD: Recipe Version Control

■ GMD: Routing Version Control

■ GMD: Scrap Factor Type

■ GMD: Technical Parameter Category Set

■ GMD: UOM Mass Type

■ GMD: UOM Volume Type

■ GMD: User Name for ALL

■ GMD: Workflow Timeout (in Days)

■ GMD: Yield Type

You can set up these profile options when you set up other applications prior to 
your Product Development implementation. Refer to the other product user's 
guides for more details on how these products use these profile options.

Your System Administrator sets user profile options at one or more of the following 
levels: Site, Application, Responsibility, and User. Use the Personal Profile Options 
window to view or set your profile options at the user level. You can consult the 
Oracle Process Manufacturing Implementation Guide for a complete description of the 
profile options listed. Consult your Oracle Applications System Administrator's Guide 
for a list of profile options common to all Oracle Applications.
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Product Development Status C
C

Product Development Status Codes

This appendix outlines how status codes change when workflow is and is not 
running.

Workflow Running and Approval Required for the Current Data
A status of New changes to a status of:

■ Pending Approval for Laboratory Use when the Requester selects Approve for 
Laboratory Use.

■ Pending Approval for General Use when the Requester selects Approve for 
General Use.

■ Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Pending Approval for Laboratory Use changes to a status of:

■ Approved for Laboratory Use when the Approver approves the request.

■ Revise for Laboratory Use when the Approver rejects the request.

A status of Revise for Laboratory Use changes to a status of:

■ Pending Approval for Laboratory Use when the Requester selects Approve for 
Laboratory Use.

A status of Approved for Laboratory Use changes to a status of:

■ Pending Approval for General Use when the Requester selects Approve for 
General Use.

■ On Hold when the Requester selects On Hold.

■ Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Pending Approval for General Use changes to a status of:
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■ Approved for General Use when the Approver approves the request. 

■ Revise for General Use when the Approver rejects the request.

A status of Revise for General Use changes to a status of:

■ Pending Approval for General Use when the Requester selects Approve for 
General Use.

A status of Approved for General Use changes to a status of:

■ On Hold when the Requester selects On Hold.

■ Frozen when the Requester selects Frozen.

■ Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of On Hold changes to a status of:

■ Pending Approval for Laboratory Use when the Requester selects Approve for 
Laboratory Use.

■ Revise for Laboratory Use when the Requester selects Revise for Laboratory 
Use.

■ Revise for General Use when the Requester selects Revise for General Use.

■ Pending Approval for General Use when the Requester selects Approve for 
General Use.

■ Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Frozen changes to a status of:

■ On Hold when the Requester selects On Hold.

■ Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Obsolete or Archived changes to a status of:

■ Revise for Laboratory Use when the Requester selects Revise for Laboratory 
Use.

■ Revise for General Use when the Requester selects Revise for General Use.

Workflow Not Running
A status of New changes to a status of:

■ Approve for Laboratory Use when the Requester selects Approve for 
Laboratory Use.
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■ Approve for General Use when the Requester selects Approve for General Use.

■ Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Approved for Laboratory Use changes to a status of:

■ Approve for General Use when the Requester selects Approve for General Use.

■ On Hold when the Requester selects On Hold.

■ Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Approved for General Use changes to a status of:

■ On Hold when the Requester selects On Hold.

■ Frozen when the Requester selects Frozen.

■ Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of On Hold changes to a status of:

■ Approve for Laboratory Use when the Requester selects Approve for 
Laboratory Use.

■ Approve for General Use when the Requester selects Approve for General Use.

■ Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Frozen changes to a status of:

■ On Hold when the Requester selects On Hold.

■ Obsolete or Archived when the Requester selects Obsolete or Archived.

A status of Obsolete or Archived changes to a status of:

■ Approve for Laboratory Use when the Requester selects Approve for 
Laboratory Use.

■ Approve for General Use when the Requester selects Approve for General Use.
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Product Development E
D

Product Development ERES

OPM Product Development supports the acquisition of electronic signatures on 
electronic records. Electronic documentation replaces paper with a seamless 
interface of business activities that improves manufacturing throughput and 
enhances the overall quality of operations in the enterprise. The following provides 
information for online and deferred events that are eRecord and eSignature (ERES) 
enabled in the OPM Product Development application. A brief discussion of each 
event is provided. Refer to the Oracle E-Records Implementation Guide for details 
on setting up the events and approvals.

The following details the seed data necessary for the OPM Product Development 
events. Refer to the Oracle E-Records Implementation Guide for details on setting up 
the events and approvals.
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Events
Events
The following table lists the events that are eRecord/eSignature enabled for OPM 
Product Development:

Operation Approval
When the status of an operation is changed, the eSignatures can be captured at 
multiple points in the process. When the status change is requested, required 
signatures can be captured online, while the event is happening in the window. Any 
users responsible for additional required signatures receive workflow notifications 
informing them that their eSignature must be entered before the status of the 
operation is changed to the requested status.

The Change Status window in Product Development starts the signature capturing 
process whenever an operation status change is requested. This replaces the existing 
operation approval workflow.

Routing Approval
When the status of a routing is changed the eSignatures can be captured at multiple 
points in the process. When the status change is requested, required signatures can 
be captured online, while the event is happening in the window. Any users 
responsible for additional required signatures receive workflow notifications 
informing them that their eSignature must be entered before the status of the 
routing is changed to the requested status.

Formula Approval
When the status of a formula is changed the eSignatures can be captured at multiple 
points in the process. When the status change is requested, required signatures can 
be captured online, while the event is happening in the window. Any users 
responsible for additional required signatures receive workflow notifications 

Event Online or Deferred

Operation Approval Deferred

Routing Approval Deferred

Formula Approval Deferred

Recipe Approval Deferred

Validity Rule Approval Deferred
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Events
informing them that their eSignature must be entered before the status of the 
formula is changed to the requested status. 

Recipe Approval
When the status of a recipe is changed the eSignatures can be captured at multiple 
points in the process. When the status change is requested, required signatures can 
be captured online, while the event is happening in the window. Any users 
responsible for additional required signatures receive workflow notifications 
informing them that their eSignature must be entered before the status of the recipe 
is changed to the requested status.

Validity Rule Approval
When the status of a validity rule is changed the eSignatures can be captured at 
multiple points in the process. When the status change is requested, required 
signatures can be captured online, while the event is happening in the window. Any 
users responsible for additional required signatures receive workflow notifications 
informing them that their eSignature must be entered before the status of the 
validity rule is changed to the requested status.

Finding Additional ERES Information
You can find the following information in the Oracle E-Records Implementation Guide:

■ Events

■ Event Key

■ Subscriptions

From the XML Gateway, using the existing Event and Event Key, you can derive the 
XML Map, Subscription Data, and Metadata.
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Statuses Available for ERES
Statuses Available for ERES
You can set up the capturing of eSignature and eRecord for the following seeded 
statuses and any other customized statuses:

■ Approved for Laboratory Use

■ Approved for General Use

■ On Hold

■ Frozen

■ Obsolete/Archived
D-4 Oracle Process Manufacturing Product Development User’s Guide



Glossary

Activity

Action performed during the manufacturing process, such as mixing or heating.

Activity Factor

The number of times an activity is performed. For example, a quality test must be 
performed at the beginning, middle, and end of a mixing time period. Rather than 
defining the activity and associated resources three times, use a factor or multiplier 
to indicate several iterations of the same activity. In example of performing a test at 
the beginning, middle, and end of a mixing time period, you would define a factor 
of 3. Factors are applied to resource usage when planning and calculating resource 
costs. Factors can be set to zero to exclude a particular activity. This is also a means 
to select the equipment (resources) that are used for this production run within this 
specific plant.

Boolean

A logical combinatorial system that represents the symbolic relationships between 
entities. Typical logical operators are: AND, OR, and NOT. In Boolean searching, 
the AND operator between two words indicates a search for both words. For 
example "pear AND apple" searches for information containing both words.

Byproduct

An item produced by a formula in addition to the product. Byproducts differ from 
products in that you do not plan your production to make byproducts. Byproducts 
can have monetary value, but generally have less monetary value than products. In 
some instances there can be a cost associated with disposing of a byproduct.
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Category

Code used to group items with similar characteristics, such as plastics, paints, inks, 
or foods.

Category Set

Grouping scheme consisting of categories. Typical category sets include purchasing, 
materials, costing, and planning.

Charges

Often in a process manufacturing plant the capacity of a step is determined by the 
equipment used. For example, a mixing tank that has a maximum capacity of 1000 
gallons overflows if more is added. A charge is defined as one full load that can be 
accommodated in a single pass through equipment. The maximum capacity 
determines the total number of charges that are required to process the ingredients 
required for a batch. In the previous example, a batch size of 5000 gallons requires 
five charges at 1000 gallons each.

Component Class

A way of classifying item costs. Examples of component classes are labor or 
overhead.

Coproduct

One of several products produced by a formula. The term coproduct is sometimes 
used when a formula produces more than one product. OPM does not distinguish 
between products and coproducts. Compare with byproduct.

Cost Analysis Code

A code that generally specifies whether an activity is value-added.

Density

The quantity of a material per unit volume. In general, density is mass divided by 
volume.

Exponentiation

The act or process of raising a quantity to a power.

Formula

A statement of ingredient requirements. A formula can also include processing 
instructions and ingredient sequencing directions. The formula can also specify the 
quantities of each item.
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Gravimetric

Of or relating to measurement by weight.

Ingredient

An item that is used in a formula to produce a product.

Operation

A combination of one or more activities and the resources used to perform those 
activities. For example, the combination of mixing (activity) and the mixer 
(resource) defines the mixing operation.

Process Parameter

A processing instruction. Processing parameters are used to provide operators with 
information needed for managing equipment that is used during the preparation of 
a product or to drive a production decision, such as the type of filter to use, or the 
quantity of product required to fill a container. There is no direct linkage between a 
process parameter and the equipment it describes.

Product

An item that is produced by a formula. See also coproduct.

Project

In the context of product development, this represents an endeavor undertaken to 
develop a new product or to perform changes to an existing product. A project 
gathers information about the project manager, participants and objectives to be 
met such as start dates, end dates, unit cost, and quality specifications.

Recipe

An entity that contains the minimum set of information that uniquely defines the 
manufacturing requirements for a specific product. Recipes provide a way to 
describe products and how those products are produced.

Resource

Any noninventory item used in production, like a mixer or oven.

Routing

A sequenced set of operations that need to be performed in order to complete a 
production batch.
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Routing Process Loss

The capability to account for material lost during the production process at the 
routing level. This loss can vary depending on the routing and quantity being 
processed by the routing. A loss factor is defined at the routing level based on a 
range of quantities.

Scaling

The proportional increase or decrease of product, byproduct, and ingredient 
quantities in a formula or batch.

Specific Gravity

The ratio of the density of a substance to the density of some other substance, 
usually pure water, taken as a standard when both densities are obtained by 
weighing in air at standard temperature and pressure.

Specification

Identify the target or ideal result of a quality control assay test performed on an 
item or lot. Assay codes and item attributes are combined to devise test 
specifications for specific items and lots.

Technical Class

An item category that is used to identify and group ingredients. It is used to 
analyze ingredients within a formula by contribution of the class. This can assist in 
both development and maintenance of a formula, wherein the overall contribution 
of specific technical characteristics of ingredients is significant.

Technical Subclass

An item category that is used to identify and group ingredients within a technical 
class. The technical subclass refines the analysis of ingredients within a formula a 
level beyond the technical class. For example, if a technical class is RESIN, a 
technical subclass could be EPOXY.

Theoretical Process Loss

The capability to account for the material lost during the production process at the 
routing level. This loss can vary depending on the routing or the individual 
quantity being processed by the routing. This loss is defined at the routing level and 
is based on a minimum and maximum range of quantities.
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Theoretical Yield Calculation

A calculation that calculates product quantities yielded by a formula given a 
specified yield percentage.

Validity Rule

Formerly effectivity. The combination of a quantity of material and an effective date 
that is used by production, planning, costing, or MSDS in one or more specified 
organizations.

Version

A number identifying a variant of a formula, operation, routing, or recipe.
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Index

A
activities, 1-8, 1-16, 2-11
Activities window, 2-11
Activity Code, 2-11
activity factor, 4-3, 4-4, 4-14
activity node, 1-13
Activity Properties window, 5-36
Analysis Code, 2-11
analysis, tasks, 1-5
API, 1-16, 3-6
Applications Programming Interfaces, 3-6
approval

formulas, D-2
operations, D-2
recipes, D-3
routings, D-2
validity rules, D-3

approver, setting up, 1-16
ASQC, 6-7, 6-38
assay

global, 2-17
attributes, routing, 6-7
audit trail, 1-27
Automatic Step Quantity Calculation, 6-7, 6-38
average material throughput, 5-4

B
batch, 4-4

production, 4-2
steps in, 4-2

business process workflow, 1-16
business rules, 1-16

By Product Properties window, 6-61
byproduct node, 1-13

C
calculating step quantities, 6-7
calculation errors

in spreadsheet, 3-17
capacity

step, 4-4
capacity, maximum, 4-3
Change Status window, 1-18, D-2
changeovers, allowance for, 5-5
charge, 4-3, 4-4, 4-19
circular reference, 5-31
class node, 1-13
class, viewing by, 1-11
classes, technical, 3-86, 3-95
components

interface, 1-10
menu and toolbar, 1-10

Computer Aided Formulation, 3-4
conditions, specifying in search and replace, 7-4
conversion

mass to volume, 2-16
units of measure setup, 2-3
volume to mass, 2-16

Copy Recipe, 6-52
copying objects, 1-12
cost analysis codes, 1-7, 2-4, 2-11
cost calendar, 1-7, 2-4
Cost Management application, 2-4
costing prerequisites, 2-4
create formulas, 3-3, 6-55
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Create Recipe, 6-50

D
Data Organizer, 1-10, 1-11
data type, 2-17

Boolean, 2-18
character, 2-17
cost, 2-18
equivalent weight, 2-19
expression, 2-18
numeric, 2-18
product expression, 2-19
quantity per unit, 2-19
specific gravity, 2-18
validation list, 2-18
volume%, 2-18
weight%, 2-18

decision trees, 1-16
default routing, 5-4
density, requirement for spreadsheet, 2-16
density, role in unit of measure conversions, 2-16
detail view, 1-10
display, hierarchical, 1-10
drag-and-drop function, 5-26

E
electronic mail, 1-16
equivalent weight, 2-17
errors

unit of measure conversion, 3-9
evaporation, allowance for, 5-5
events

formulas, D-2
operations, D-2
recipes, D-3
routings, D-2
validity rules, D-3

expressions, 2-13
fixed, 2-14
in technical parameters, 2-13

F
Financials data, 2-4
Find Analysis window, 3-94
Find Formulas window, 3-36
Find list, in search and replace, 7-2
Find Operations window, 4-9
Find Recipes window, 6-9, 6-50
Find Routings window, 5-8
fixed expressions, 2-14
formula, 1-11

classes, 2-8
creating, 3-32
definition, 3-3
grouping, 2-8
ingredient substitution, 7-7
packaging, 3-4
properties, 2-8
setup, 3-3

Formula Analysis Parameters window, 3-86
formula approval, D-2
Formula By-Product Line Edit window, 3-66
Formula By-Product Line Summary window, 3-62
Formula By-Product Lines window, 3-64
Formula By-Product Summary window, 3-54
formula classes, 1-7, 3-37, 3-39, 3-41
Formula Classes window, 2-8
Formula Details window, 2-8, 3-41
Formula Header Summary window, 3-39
Formula Ingredient Contribution Analysis 

window, 3-88
Formula Ingredient Line Edit window, 3-71
Formula Ingredient Lines window, 3-69
Formula Ingredient Summary window, 3-56
Formula Inquiry Selection window, 3-78
Formula Inquiry Summary window, 3-81
Formula Management, 1-4
formula node, 1-13
formula phantoms, 3-21
Formula Product Line Edit window, 3-61
Formula Product Line Summary window, 3-58, 

3-67
Formula Product Lines window, 3-59
Formula Product Summary window, 3-52
Formula Properties window, 6-56
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formula rollup, 2-14
formula status, 6-56
Formula Summary window, 3-37
formula tab, 1-13, 6-40, 6-41, 6-53
formula version, 3-41
formula weight, 2-16
Formulator, 1-5, 1-7, 2-6
Formulator Responsibility, 1-29

G
General Text paragraph, 6-46
global assays, 2-17
GMD

Byproduct Active, 2-2
Default Consumption/Yield Type, 2-2
Default Lab Organization, 2-2
Default Step Release Type, 2-2
Density, 2-2, 2-16
Display Specifications, 2-2
Effective Maximum Date, 2-2
Effective Minimum Date, 2-2
Exact Specification Match, 2-2
Formula Version Control, 1-27, 2-2
Operation Version Control, 1-27, 2-2
Process Instruction Paragraph, 2-2, 2-3, 6-43, 

6-44, 6-46
QC Grade, 2-2
Recipe Version Control, 1-27, 2-2
Routing Version Control, 1-27
Scrap Factor Type, 2-2, 2-3
UOM Mass Type, 2-3
UOM Volume Type, 2-3
User Name for ALL, 2-3
Workflow Timeout (in Days), 2-3
Yield Type, 2-3, 3-24

GME
Copy Formula Text profile option, 3-20

H
hierarchical display, 1-10
hierarchy, technical parameters, 2-13

I
icon, 1-10
Indented Bill of Materials Report, 3-73
Indented Formulas Report box, 3-73
ingredient node, 1-13
Ingredient Properties window, 6-60
ingredient usage, 1-4
ingredient usage, at step level, 5-5
ingredients, scaling, 3-23
interface components, 1-10
intermediates, 3-21
Inventory Control application, 2-4
Inventory Control, prerequisites, 2-4
ISO 9000, 3-8
item lot and sublot conversions, 1-7
item master, 6-57
Item Technical Data window, 3-9
Item/Lot Sublot Conversions window, 2-4
items, setup, 1-7

L
laboratories, 1-8
laboratory approval, related to status, 1-16
Laboratory Management, 1-4
laboratory types, setup, 2-12
language support, 6-10
life cycle, product, 1-4
loss, in standard costing, 5-4
loss, planned, 6-22
Lot/Sublot Std Conversion window, 2-16

M
Mass Search and Replace security, 1-7
material requirements, 6-41
Material Safety Data Sheet, 1-14
material throughput, average, 5-4
material viscosity, allowance for, 5-5
mathematical operators, in expressions, 2-16
maximum capacity, 4-3
menu, 1-10
migration scripts, 3-4
MLS, 6-10
MSDS, 1-14
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multibatch management, 3-21
multilingual support, 3-4, 6-10

N
navigator pane, 6-41
navigator style, 5-26
navigator tree, 1-10
navigator view, 6-44
node

activity, 1-13
byproduct, 1-13
class, 1-13
formula, 1-13
ingredient, 1-13
operation, 1-13
owner, 1-13
product, 1-13
recipe, 1-13
resource, 1-13
routing, 1-13
status, 1-13

nodes, 1-13
Notification Summary window, 1-16
notification, in workflow, 1-16

O
operation, 1-11
Operation Activity Line Summary window, 4-22
Operation Activity window, 4-19
operation approval, D-2
operation classes, 1-8, 2-9, 4-10, 4-12, 4-14
Operation Classes window, 2-9
Operation Details Activities window, 4-14
Operation Header Summary window, 4-12
Operation List, 6-62
operation node, 1-13
Operation Resource Line Summary window, 4-24
Operation Resource Line window, 4-28
operation tab, 1-13
operations, 1-8
Operations Summary By... window, 4-10
operations, grouping, 2-9
OPM System Administration

prerequisites, 2-2
Oracle Applications, 1-16
Organizations window, 2-12
owner, 1-11
owner node, 1-13

P
packaging formula, 3-4
Personal folder, 1-11
Personal Shortcuts, 1-14

copying objects to, 1-12
pasting objects to, 1-12

phantom type
automatic generation, 3-21
manual generation, 3-21

phantoms, 3-21
planned process loss, 6-22
plant resources, 1-8
plant type, 2-12
preference, for validity rule usage, 6-23, 6-29, 6-32
Preferences window, 5-42
prerequisite setup, 1-2
prerequisites

costing, 2-4
OPM System Administration, 2-2

prerequisites, setup, 1-7
Process Engineer, 1-6, 1-7, 2-6, 5-4
Process Engineer Workbench, 2-6
Process Instruction Sheet, 6-40, 6-42, 6-46, 6-64
process instructions, 6-41
process loss

planned, 6-22
theoretical, 6-22

process requirements, 6-41
process speeds and feeds, 5-5
Product Development Security Manager, 1-7
Product Development Security Profile 

Manager, 1-7
product node, 1-13
Product Properties window, 6-60
product requirements, 1-5
production batch, 4-2
production loss factor, 5-5
profile option
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GMD
Process Instruction Paragraph, 2-2

profile options, 1-7, 2-2
GMD

Byproduct Active, 2-2
Default Consumption/Yield Type, 2-2
Default Lab Organization, 2-2
Default Step Release Type, 2-2
Density, 2-2
Display Specifications, 2-2
Effective Maximum Date, 2-2
Effective Minimum Date, 2-2
Exact Specification Match, 2-2
Formula Version Control, 1-27, 2-2
Operation Version Control, 1-27, 2-2
Process Instruction Paragraph, 2-2
QC Grade, 2-2
Recipe Version Control, 1-27, 2-2
Routing Version Control, 1-27, 2-2
Scrap Factor Type, 2-2, 2-3
UOM Mass Type, 2-3
UOM Volume Type, 2-3
User Name for ALL, 2-3
Workflow Timeout (in Days), 2-3
Yield Type, 2-3

profile options, required setup, 2-2
profile values, version control, 1-27
Public folder, 1-11
Public Shortcuts, 1-14

Q
quantity per unit, 2-15

R
recipe, 1-11
recipe approval, D-3
Recipe Designer, 5-26, 6-44

change status, 6-51
components, 6-40
copy recipe, 6-52
creating a formula, 6-55
creating a recipe, 6-50
edit formulas, 6-56

finding a recipe, 6-50
item technical data, 6-61
navigator, 6-40
operation steps, 6-62
process instruction sheet, 6-42
recipe tab, 6-46
routing, 6-62
step number charges, 6-42
understanding functions, 6-40
views, 6-40

Recipe Details window, 6-7, 6-15, 6-44
Recipe Header Summary window, 6-7, 6-11, 6-44
recipe node, 1-13
Recipe Organization Details window, 6-7, 6-22
Recipe Properties window, 6-48
Recipe Step/Material Association window, 6-8, 

6-38
Recipe Summary By... window, 6-7, 6-44
recipe tab, 1-13, 6-40
Recipe Validity Rules Lines window, 6-8, 6-30, 6-31
Recipe Validity Rules Multi-Record window, 6-28
Recipe Validity Rules window, 6-8, 6-28
recipes, 1-8
Recipes Summary By... window, 6-10
Recipes Summary window, 6-10
regulatory compliance, 1-4
replace

formulas, 7-2
operations, 7-2
recipes, 7-2
routings, 7-2

requirements, Automatic Step Quantity 
Calculation, 6-38

requirements, product, 1-5
resource costs, and activity factor, 4-4
resource node, 1-13
Resource Properties window, 5-37
resource requirements, 4-2
resources, 1-8
Responsibilities, 1-7, 2-6
responsibility, workbench, 2-6
right mouse click menu, 1-12
routing, 1-11
routing approval, D-2
routing classes, 1-8, 2-10, 5-9, 5-11, 5-13, 5-18, 5-20
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creating, 2-10
setting up, 2-10

Routing Classes window, 2-10
Routing Designer, 5-28
Routing Designer window, 5-29
Routing Details window, 5-13, 5-26, 5-29
Routing Header Summary window, 5-11, 5-29
routing node, 1-13
Routing Properties window, 5-33
routing step

automatic calculation, 6-7
overriding, 6-7

routing step dependencies, 5-21
Routing Step Dependencies window, 5-21
Routing Step Dependency Properties 

window, 5-31, 5-39
Routing Step Line Summary window, 5-18
Routing Step Line window, 5-20
Routing Step Properties window, 5-34
Routing Summary window, 5-9, 5-29
routing tab, 1-13, 6-40, 6-41, 6-62
routings, 1-8
rules, business, 1-16

S
Save Recipe, 6-52
scaling factor, 3-23
search and replace

advanced search region, 7-2
basic search region, 7-2

Search and Replace window, 7-2
security

Mass Search and Replace, 1-7
seed data, 1-17
setting up

formulas, 3-3
setup

laboratory organizations, 2-12
prerequisites, 1-7
profile options, 2-2
technical classes, 3-86, 3-95
technical parameter sequences, 2-20
technical subclasses, 3-86, 3-95
units of measure, 2-3

units of measure classes, 2-3
units of measure conversion, 2-3

setup, prerequisite, 1-2
spreadsheet

calculation errors, 3-18
general description, 3-12
updating the laboratory formula, 3-18

spreadsheet calculations, 2-16
Spreadsheet window, 3-12
Standard Operating Procedures, linking to 

process, 3-5
status

recipe, 6-51
Status Approval Workflow, 1-7, 1-16, 3-4

disabling, 1-21
enabling, 1-18

Status Approval Workflow, understanding, 1-18
status codes, 1-18
status node, 1-13
Status, view by, 1-11
step capacity, 4-4
step dependency, 5-26
Step Dependency properties, 5-38
step quantities, automatic calculation of, 5-4
step quantity, automatic calculation, 6-7
steps, 4-2
System Administration, 1-7, 2-12
System Administration application, 1-17
system security profile, 1-3

T
tab

formula, 1-13
operation, 1-13
recipe, 1-13
routing, 1-13

tabs, 1-13
task analysis, 1-5
technical characteristics, 3-5
technical classes, 3-78, 3-86, 3-95
Technical Data Selection window, 3-95
technical parameter sequences, 1-8
Technical Parameter Sequences window, 2-20
technical parameter type
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cost, 2-15
equivalent weight, 2-15
specific gravity, 2-15
volume Percent, 2-15
weight percent, 2-15

technical parameters, 1-8, 3-5
data entry, 3-9
density, 2-20, 3-9
explanation, 2-13
expressions, 2-13
formula rollups, 2-14
sequence, 2-20

Technical Parameters window, 2-16
technical parameters, hierarchy, 2-13
test batches, 1-4
text

adding to a formula, 3-20
text associations, 6-46
theoretical process loss, 2-10, 6-22
Theoretical Process Loss Edit window, 5-25
Theoretical Process Loss window, 5-24
theoretical process loss, as a cost, 5-4
toolbar, 1-10
tools, designer, 5-29
translation and MLS, 6-10
translations, 3-4
tree

data organizer, 1-11
triggers, 1-17

U
unit of measure conversion error, 3-9
UOM conversions, 1-7
User Preferences, 5-42

V
validity rule, 5-4, 5-5
validity rule approval, D-3
Validity Rules Summary by Product, 6-34
Validity Rules Summary by Recipe, 6-36
version control, 1-27, 3-6
Version Control, setup, 1-7
version, formula, 3-41

View by
class, 1-11
owner, 1-11
status, 1-11

W
wildcard, use in search and replace, 7-2, 7-5, 7-8
window

Activity Properties, 5-36
By Product Properties, 6-61
Find Recipes, 6-50
Formula Properties, 6-56
Item Properties, 6-55
Operation

Activity Line Summary, 4-7
Resource Line Summary, 4-8

Operation Activity Line, 4-7
Operation Details

Activities, 4-5, 4-7
Operation Resource Line, 4-8
Operations Header Summary, 4-5
Operations Summary By..., 4-5, 4-10
Preferences, 5-42
Recipe Designer, 6-40, 6-44
Recipe Properties, 6-48
Resource Properties, 5-37
Routing Designer, 5-29
Routing Details, 5-6, 5-10, 5-13
Routing Header Summary, 5-6, 5-11
Routing Properties, 5-33
Routing Step Dependencies, 5-7, 5-22
Routing Step Dependency Properties, 5-31
Routing Step Line Summary, 5-7, 5-18
Routing Step Properties, 5-34
Routings Summary, 5-9
Routings Summary By..., 5-6
Step Dependency Properties, 5-39
Theoretical Process Loss, 5-7, 5-24

window, Ingredient Properties, 6-60
window, Product Properties, 6-60
work breakdown structure, 1-5, 1-7
work method design, and Activities, 2-11
workbench, 1-4, 1-14, 1-28

Formulator, 2-6
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Process Engineer, 5-4
workbench responsibility, 2-6
workflow

basics, 1-16
business processes, 1-16
electronic notifications, 1-16
setup, 1-17
steps, 1-16

Workflow Activity Approval Configuration 
Framework window, 1-17

Workflow Activity Configuration window, 1-17
Workflow Process Activation window, 1-17
Workflow Process Configuration Framework 

window, 1-17
Workflow Process Configuration window, 1-17
workflow, and seed data, 1-17
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